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FOREWARD

Equation typesetting has traditionally been a difficult task.  Besides the 
unorthodox symbols and arrangements, there almost always needs to be 
some ad-hoc fine-tuning, deviating at times from whatever typesetting 
rules may seem to apply.  Until recently, computers have been heavily 
oriented toward linear text.  Equation structures, which evolved on two 
dimensional surfaces that were marked with human hands with perfect 
freedom, did not carry over well.

Expressionist grew out of a need for an intuitive equation 
typesetting method. Besides displaying the expression being edited, it 
allows easy editing of that expression in an obvious way, as modern word 
processors allow easy, intuitive modification of documents.

This user’s manual consists mainly of tutorial and reference sections, 
referred to as the Guided Tour and the Encyclopedia, respectively.

If you are like most people, you may want to put down the manual and 
start using the software right away.  Fortunately, you do not need to read 
the entire manual to use Expressionist if you are familiar with 
Windows and some general applications.  Just follow the instructions in 
the Getting Started section and start using the program.

To learn Expressionist, start with the Quick Tour, take the Guided 
Tour, work through the tutorials, and by the time you hit the Cookbook 
you’ll be proficient enough with the program to create equations with a 
minimum of assistance from the documentation.

If you wish to become a power user of Expressionist and master all 
of its useful features, you can look up items of interest in the 
Encyclopedia, which is an alphabetized reference section.
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Supplied 
Diskettes

Expressionist is supplied with a 3.5-inch floppy diskette.  If you 
require a 5.25-inch diskette, contact Prescience to arrange shipment.

Disk Backup Before you use the Expressionist disk you should make a backup 
copy in case of errors or accidents which damage or destroy the files on 
the disk.  Your DOS or Windows manuals explain how to copy a disk.  
After you have made a backup copy, put the original Expressionist 
diskette in a safe place and do not use it; use only the backup copies.

Prescience did not copy-protect the Expressionist diskette because 
we know that copy-protection is annoying and interferes with your use 
of the software.  Please do not make copies of Expressionist and 
distribute them among your friends and co-workers.  Besides being 
illegal, this practice of software piracy hinders Prescience’s ability to 
provide you with customer service, technical support, updates, and new 
products.

Serial Number Please take note of the serial number label on the Expressionist 
Disk.  This number is needed to install the program and is used when 
upgrading.  Do not give your serial number to others.

System 
Requirements

Expressionist for Windows runs on IBM PC compatibles with an 
80286 or later central processing unit running Microsoft Windows 3.0 or 
later in standard or enhanced mode.  The machine must be equipped with 
a hard disk, which should have at least 1.2 megabytes of free space for 
Expressionist and its related files.  A 3.5" floppy disk drive is 
required for installation.  At least two megabytes of RAM memory are 
required to run Expressionist.

Expressionist also requires DOS 3.1 or later. (To check your 
system version, enter VER at the > DOS prompt.)

We recommend a 386SX or higher system with four megabytes of 
memory and a VGA color monitor.
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INSTALLING 
EXPRESSIONIST FOR 
WINDOWS AND DOS

Insert the Expressionist disk in the floppy disk drive.

Starting from the 
DOS Prompt

If your computer is currently running Windows, skip to the section 
“Starting from Windows”.  If your computer is at the > DOS prompt, 
type the floppy drive letter, followed by a colon.

C:\>a:

Press œ.  The prompt changes to the floppy drive.  Type win install.

A:\>win install

Press œ again to start up Microsoft Windows and the Expressionist 
installation program.  This takes a few moments.

Skip ahead to the next section entitled,“Using the Install Program.”

Starting from 
Windows

With your computer currently running Windows, close any open 
applications.  From the Windows Program Manager’s File menu, choose 
Run to open the Run dialog.  In the Command Line box, type 
“a:install” or “b:install”, depending on which drive you are using.

Click the OK button to start the Expressionist installation program.  
This takes a few moments.

If you encounter a problem or become lost or confused during this 
installation, just accept all the default options along the way (e.g., click 
OK or the highlighted buttons) and everything will turn out fine.
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Using the 
Install Program

The Install program starts up and shows the following dialog.

The installer will create a new directory, EXPR, at the path specified in 

the dialog.  (If you want a different name or a different directory, type a 
new pathname in the box.)

You must choose between two installation methods:  Full Install or 
Custom Install.  

Full Install Full Installation is the method we recommend for most users.  When you 
choose Full Install, it will copy all necessary files to your hard disk.

Custom Install Custom Installation is for those people who want to save some disk space 
by not installing all of the files on the disk.  The minimum installation is 
the Application and Preferences Files component.  (This is all you need 
to use Expressionist under Windows 3.1.)  When you choose 
Custom Install, it will copy only the file(s) of your choice to your hard 
disk.

Exit Install If you have second thoughts about installing Expressionist, choose 
Exit Install to leave the Install program and return to the Windows 
Program Manager without.  No files are installed if you do this.

Copying Files When you continue with the full or custom installation, the Install 
program decompresses and copies various files to the specified directory.  
(If Expressionist has been installed previously, the installer will 
ask you whether it is OK to replace the old files.)

Creating a Group After the files are copied to your hard disk, the Install program asks 
whether you want to create an Expressionist group.
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You may type another 
name for the group.

Unless you are re-installing Expressionist and already have an 

Expressionist group, click Yes.

Reading the 
News

Next, the installer gives you some late-breaking information regarding 
Expressionist.  After you have read it, click Continue.  (You can 
open this README.TXT file with a word processor to read it again 
later.)

Exiting the 
Installer

After finishing, the installer tells you that it has successfully installed the 
files. You can then click OK to return to the Windows Program Manager 
where the Expressionist group is open for you.
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Setting Up the 
Application

Before you can use Expressionist, you must set a few options 
concerning the default font characteristics and printer setup, and register 
your name.  

Double-click on the  Expressionist icon to run the 
Expressionist application.

Personalize 
Expressionist

A dialog appears for personalizing your copy of Expressionist.

Use the last six digits 
of the serial number 
on your Expressionist 
disk label.

Enter your first and last names, organization, or address, and 

Expressionist serial number in the places provided.

Set Default Font The next dialog tells you what do with the dialog which will follow it.

 dE
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Click OK.

You may want another 
font, but stay with 
these settings 
because the following 
tutorials will expect 
these settings.

This dialog is for setting up the default font, size, and style options that 
Expressionist will use.  Just click OK to accept Times New Roman 
12 with italic non-functions and vertical squeeze, since the upcoming 
tutorials use these settings.  (However, if you do not have the Times New 
Roman font, choose a similar font family.)

Set Printer 
Resolution

The next dialog tells you what do with the dialog which will follow it.

Click the Printer Default button then click OK.. 

Click OK.
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Do not worry about 
getting perfect 
settings.

If you think your default font or printer settings may not be optimal for 
your system or needs, you can always change them from within 
Expressionist later.  (This is explained later in this manual.)

When the next dialog appears, click OK and Expressionist will quit and 
return to the Windows Program Manager.

This completes your initial setup of Expressionist.  It is not necessary to 
do these steps again, unless you re-install the program.

Registration 
Card

Be sure to complete and return your registration card.  It entitles you to 
free technical support and a subscription to The Math Axis newsletter.
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GETTING STARTED WITH 
EXPRESSIONIST FOR THE 

MACINTOSH

Disk Backup Before you use the Expressionist disks, you should make backup 
copies in case of errors or accidents which destroy the files on the disks.  
After you have made copies, put the original Expressionist 
diskettes in a safe place and do not use them, use only the back up copies.

Serial Number Please take note of the serial number label on Expressionist. 

Disk #1. This number is needed to install the program and is used when 
upgrading. 

System 
Requirements

You can use Expressionist on an Apple Macintosh Plus or 
later model Macintosh.  (An older Macintosh upgraded to the equivalent 
of a Plus is satisfactory.)  The minimum memory requirement is one 
megabyte (1 MB).  The Macintosh must be equipped with a hard disk, 
which should have at least 1 Mb of free space for Expressionist and 
its related files.  

The Macintosh must be running System version 4.1 or a later System.

Application vs. 
DA

Expressionist is supplied in two versions:  an application and a 
desk accessory (DA).  The application has more features and capabilities 
but it is larger than the desk accessory.  Which one you choose to use 
depends on your Macintosh system configuration.  If you are using 
System 7 or System 6 with MultiFinder and plenty of memory, you 
should use the application.  If you are using System 6 without 
MultiFinder, or an earlier Finder-only system version, you should use the 
desk accessory.

If your only reason for using the DA is to have Expressionist available 
under the Apple menu, youshould know that the application is available 
under the Apple menu of MultiFinder or under the application menu of 
System 7.  You can even make an alias of the application under System 
7 and place the alias in the Apple Menu Items folder.
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INSTALLING 
EXPRESSIONIST

With your Macintosh at the Finder, insert your backup copy of Disk 
#1. The following will appear on your desktop:

Installing the 
Application and 
Preferences

      

Shift-click on each icon to select both icons in the Expressionist disk 
window.  Drag the icons to your hard disk to copy the Expressionist 
application and the Prescience folder.  You can move the application to 
a location of your choice.  For instance, you can put it in a folder with 
other applications or put it in its own folder.

If your hard disk's System Folder does not include a folder named 
Preferences, make one.  Move the Prescience folder into the 
Preferences, folder (within the System Folder.)  

Drag the floppy disk icon to the trash to eject the disk

Setting Up 
Expressionist

Open the Expressionist application from the Finder by double-
clicking on the Expressionist icon:
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When you first launch the application, you must enter your name, 
organization name (or personal address) and the last six digits of your 
serial number found on the label on the back of disk #1.

                   

You will then be given a series of dialogue boxes asking you about fonts 
and printer preferences.  Simply click OK if you want to accept the 
standard defaults.  Otherwise, make the changes you want in the dialogue 
boxes and then click OK.

After the final dialog appears, Expressionist will quit and return to 
the Finder.  

This completes your initial set up of Expressionist.  It is not 
necessary to do these steps again unless you re-install the program.  

If you do not plan to:

1) use the Expressionist desk accessory 

2) use Expressionist with Microsoft Word 5 under System 7 

3) use Expressionist with a TeX program, 

Installation is complete.  If you do plan to do (1), (2) or (3), please

continue.

Insert your backup copy of Disk #2.  The following will appear on your 
desktop.  

         

If you plan to use Expressionist with Microsoft Word 5   
under System 7, drag the EGO for Word file to your hard disk.  Move 
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this file to the Word Commands folder, which should be in the same 
folder as your Word application.

Use the EGO for Word file if you want Expressionist to open 
every time you double click on an Expressionist equation in Word.  
If you would prefer double clicking to not initiate an EGO transfer, and 
you would like to retain the ability to edit graphics with the Picture 
command, you can install the EGO for Word (Picture Savvy) 
file instead of the normal EGO for Word file following the above 
instructions.  DO NOT install both EGO for Word and EGO for 
Word (Picture Savvy).

If you install EGO for Word (Picture Savvy) you will have the 
command Edit Graphic Object under the View menu the next 
time you open Word.

The following instructions only apply if you intend to use 
Expressionist with a TeX typesetting system.

From the Expressionist Disk #2, open the for TeX users 
only folder.  Copy the file FMACROS.TEX to your TeX inputs folder 
in your TeX application

Drag the Expressionist DA suitcase file icon into the System 
Folder. This will automatically move it to the Apple Menu Items 
folder.
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For System 6 or 
earlier:

1)  Double click on the Expressionist DA suitcase file icon, which 
launches the Font/DA Mover utility application.  The    Mover 
launches and opens the DA suitcase.

2)  Click the Open button and use the file selector dialog to open the 
System file inside the System Folder on Greek Letters

Picture Format

your hard disk.

3)  Click the desk accessory named Expressionist and notice that 
the >>Copy>> button becomes active and points to the list of desk 
accessories present in your system file.  Click the >>Copy>> button to 
copy the Expressionist DA to your System.

4)  When the copy is complete, click the Quit button.

Starting and 
Quitting 
Expressionist

To open the Expressionist application from the Finder, double-
click on the Expressionist icon:

To quit the application, choose the Quit item from the File menu.

To open the Expressionist DA, pull down the  menu and choose 
the Expressionist item from the menu.

To quit the DA, click on the close box in the window's upper-left      
corner.

Other 
Comments

For optimal results, use Expressionist with an outline font system, 
either TrueType or Adobe Type Manager (ATM).  Do not use 
bitmapped screen fonts.  

Screen fonts are what is displayed on the Macintosh screen.  Outline 
fonts are used to create text on printers.  Expressionist uses the 
screen fonts to calculate the proportions of equations.  Therefore, it is 
essential that the screen fonts match those in your PostScript printer as 
closely as possible.  You will not have these problems if you are not 
using PostScript.

If you are using TrueType fonts, the Macintosh will create acceptable 
screen fonts based on the TrueType outlines.  However, the bitmap 
screen fonts supplied with the System Software will override the 
TrueType screen font renderings, which may result in unprofessional 
fonts and bad proportions.  For best results with TrueType, remove all 
bitmap fonts used in equations.
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In order for you to use Greek letters and other symbols in your equations, 
you must have the Symbol font installed in your System.  The Symbol 
font is supplied with all System versions released by Apple Computer.

This command on the Options➧Copying submenu allows you to 
change the characteristics of pictures copied from Expressionist.  
The initial dialog gives you a little control over the picture format.  If you 
are using more than one printer, it is usually best to set this up for the best 
printer you have.  For instance, if you print proofs at your desk with a 
non-Postscript ink-jet printer, but you later print on a PostScript laser 
printer, you should simply set your settings for the PostScript printer.  
Things will print on the lower resolution printer, although perhaps not 
optimally.  

From the Options menu's Copying submenu choose Picture Format...  
In the dialog, click on the radio button for Non-PostScript printer or the 
radio button for Post-Script printer, enter your printer's resolution then 
click OK.  If you are not sure about your printer, just click the Printer 
Default button and then OK.

Expressionist has another dialog which gives you much more 
control over the picture format.  From the Option’s menu's Copying 
submenu choose Picture Format..., then click the Customize button.  
Choose the options that are best for your printer in this dialogue box.
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QUICK TOUR

This section shows you how to make a simple equation and copy it to 
your word processor.  If you make a mistake, choose Undo from the 
Edit menu.

Open Expressionist.

Type A =, which inserts the characters (separated by a space) into the 

expression window.

The dot is there to show you there is a space character between the a and 

equal sign.  The space was inserted automatically because 
Expressionist figured you needed one there.

The cursor blinks, waiting for you to insert more of the equation.  From 
the palette window above the expression window, click the π button, 
which inserts the pi character into the expression.
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From the   pop-up palette, choose the  button, which inserts a 

subscript/superscript composite, a template for you to type in sub- and/
or superscript characters.

Type R to replace the selected question mark.  Use the mouse to select 

the question mark in the superscript position by clicking and dragging 
over it.

Type 2 to complete the equation.  Click the  palette button to select 

everything. 

Click the  palette button (or choose Copy from the Edit menu), 

which places a copy of the equation in the clipboard.  The contents of the 
clipboard can later be pasted into other applications as a picture.

Open your word processor and enter your text:

With the cursor positioned appropriately, choose Paste from the Edit 
menu to paste it into your document.
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GUIDED TOUR

This chapter is a guided tour of Expressionist.  In it you will learn the 
basics of how Expressionist works.

When this tutorial tells you to type something in, it will be very specific, 
telling you the exact keystrokes to type, in words.  So, if the tutorial says 
“Type A B”, you should push the A key, and then the B key, but without 
using the Shift key.  If it says “˙”, that means the space bar.  If it says “†”  
or “Ÿ”, it means the Tab or Escape keys on the keyboard.

If it says “ßA”, that means to hold down the Shift key while pressing the 
A key.  If it says “ÇA”, that means to hold down Control while pressing 
the A key. Likewise, “ÅA” means to hold down the Alt key while typing 
A.  Sometimes, it will even say “ÅÇA”, meaning to hold down both of 
them, or even “ÅÇßA”.  Do not use the Shift key to type upper case 
letters unless you are expressly told to do so.

As you go along, be careful to make sure that your screen looks like the 
pictures shown here in the manual.  Pay attention to the arrow pointer if 
it is in the picture; it shows where you should be clicking.

If you make a mistake, you can usually fix it by choosing Undo from the 
Edit menu, or by typing ̊ Z (with Windows, ÇZ or Åø), or by clicking on 

the   palette button.

Under Windows, press ¡ to use Expressionist’s online help system.  For 
context-sensitive help, press ß¡ and click on the Expressionist item you 
want to learn about.

If it is not already running, double-click on the  Expressionist icon to 
run the application.  When Expressionist is first started up, it looks like 
the following diagram.

 dE
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 (If you already have Expressionist open, choose New from the File 
menu.)

If you get an error 
message about 
preferences, re-read 
the installation 
instructions.

The window at the top is the palette window.  The window below it, 
named “Untitled 1” (“Untitl1.exp” under Windows), is an expression 
window, in which you create your equation.

The palette of editing tools at the top of the screen is an independent 
window, and it can be moved around the screen.  It always appears in 
front of other windows while Expressionist is active.  Click the palette 
window’s close box or un-check Palette on the Windows menu to make 
the palette window go away.

With the palette window gone, resize the expression window (Untitled 1) 
and move it about the screen.  Check Palette on the Windows menu to 
get the palette window back.

You do not have to 
type spaces.

Notice that Expressionist works much like a word processor.  Type 
X=Y+Z.  The expression window should have this:

The guide box encloses a “string” of characters.  You will eventually 
create equations with several strings of characters in them.

Selecting Now, try clicking your mouse anywhere in the string between two 
characters.  You can put the caret (blinking cursor) anywhere you want, 
just like in a word processor.
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Try dragging to select:  click the mouse down on the left side of the x, 
and hold the mouse down as you drag to the right, just past the y:

To select just a single character click near its middle with a tiny bit of a 

dragging motion.  Practice selecting individual characters quickly by 
sweeping the mouse just a bit.  With a little practice, you can select a 
single character with just a click in its middle.

With the y  selected, type S I N.  The selection, y, is replaced with the s, 
which is then followed by “in”.  The cursor is blinking after the “n”.  
Press ß¯ three times, which makes the following selection:

Press ¯ to move the cursor to the left of the s: 

Experiment with the arrow keys to see how the cursor moves.  Use the 
Shift key to make a selection with the arrow keys.  When you are through 
experimenting, click the mouse pointer outside the guide box, but inside 
the expression window.  This de-selects the current selection, leaving 
you with no selection.
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If you begin typing with no selection (as above), the characters you type 
appear at the end of the expression, as if the cursor were at the end.  For 
example, type ø C O S:

Another shortcut allows you to quickly select entire words.  Double-click 
the x to select it.  Double-click “sin”.  Double-click “cos”:

Hold down the Shift key and double-click “sin”, which gives you a 
multiple selection:

Press ̆ , which gives you multiple blinking cursors, then press ƒ (ø) twice:

Drag to select the s  and type Y to replace it:

Characters Now we will explore the palette.

The “iv” indicates 
applied styles, which 
are explained later.

The large button at the top labeled “Times 12 iv” or “Times New Roman 
12 iv” is called the FontSizeStyle box (also known as the FSS box).  It  
shows the current font, size, and style of selected characters.  When you 
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change the font, size, and style of a selection, this box changes to reflect 
the new font characteristics.  For example, the Helvetica font in 12 
points, italicized, with vertical squeeze, would show “Helvetica 12 iv” in 
the FontSizeStyle box.

Font buttons The D, T, and  buttons below the FontSizeStyle box change the font of 
whatever character(s) you have selected.  Select the whole equation then 
click on the  button to change the selection to Symbol, a Greek font:

Notice the x changed to , the Greek letter xi.  The Roman letter y 

changed to the Greek letter psi,  and c became  chi, .  Take a look at 
the FontSizeStyle box; it says “Symbol  12 iv”.  Symbol font is a very 
different font used for mathematics.  It is similar to a mathematical 
typeball for a typewriter; when you type regular letters, it gives you 
Greek letters.

Click on the D button, which is the default font command.  It changes the 
selection to the default font settings.  In this case, the default is the Times 
family in twelve points, with all style variations off except for italics and 
vertical squeeze (hence the “iv” on the FSS box).  You can see our 
selection is back to in the Times font, which we started with in the first 
place.  (All new expressions start in the default font.)

The T button changes the selection to the Times font family, but does not 

affect size and style variations like the D font command.

Style buttons The buttons two rows below the FontSizeStyle box are for changing the 
style of selected characters.  With the whole string still selected, click on 
the B then click outside the expression to de-select it.

B makes everything bold.  Not only that, but notice that the 

FontSizeStyle box shows “Times 12 biv” or “Times New Roman 12 
biv”.  The “b” stands for Boldface.

The bold style is intended to be applied to variables which are vector 
quantities.  (When you write them by hand, you might put an arrow over 
them or use a circumflex or underline, but the “correct” thing to do for 
typesetting is to use bold.  It could be that this custom started because the 
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arrows above characters were so difficult to typeset.  Expressionist, of 
course, lets you do it both ways.  See “vector” in the Encyclopedia 
section if you are curious.)

Next, select the entire expression and click the P button to make the 
selection plain.  The bold and italic styles are removed from the 
characters.  (Actually, P removes all style variations from the selection, 
except for vertical squeeze.)  

Next, try the right-most italic I button:

Now your equation is italicized.  The FontSizeStyle box has changed and 
now says “Times 12 iv”.  The “i” stands for italic and the “v” stands for 
vertical squeeze.

The italic style is intended to be applied to scalar variables.  Many people 
do not bother to italicize their variables, but we made it the default 
because italics are necessary for professional-looking documents.  
(However, on the screen and some printers, italics do not always look 
good.  Thus, you might want to avoid italicizing until the end, making it 
the last thing you do to your equation.  This manual explains later how to 
make the default font not use italics.)  Both TrueType and Adobe Type 
Manager fonts have good looking italics.

Notice that the = and + were not italicized by Expressionist, and neither 
were sin and cos earlier.  Function names, punctuation, digits, and other 
special symbols in equations are normally plain and should not be 
italicized or made boldface.  Expressionist helps you with this by not 
italicizing these characters and names when you use the I button for 
italicizing.  (The I button is a font command which applies a specific font 
description.  This particular command applies the italic style only to 
alphabetic (a-z) characters which are not function names.  You may 
change the I button font command to apply different font variations.  This 
is explained in the Encyclopedia section; see “Font Command”.)

With the expression selected, click on the P to make it plain:

Note that the “i” went away in the FSS box.

Sizing buttons Next, we explore the + and – buttons.  These buttons enlarge and shrink 
the selected character(s).  With the whole equation selected, click on the 
+ button (called “Enlarge”):
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Notice that the characters in the expression are a bit larger.  The 

FontSizeStyle box tells us that this is 14 point, instead of the 12 point we 
were using before.  Although the equation is in 14 points, it appears as 
28 points on the screen because Expressionist’s Magnify mode doubles 
the size for easier editing.  If you are using the Times New Roman 
TrueType font or Times ATM font it will look fine, but if you are using 
a screen font, it may look chunky and ugly on the screen.  This is another 
good reason to use TrueType and/or ATM with Expressionist—they 
provide smooth large font sizes.

The + button does not increase the size merely one point at a time; it 
enlarges in steps.  Usually, you will want to increase the size by two steps 
at a time.  This is easy—just click twice in a row whenever you use it.  If 
you click four times, you will get exactly double the original size.

Next, try out the –, called “Shrink.”  As you might imagine, it makes 
characters smaller.  Select the whole equation and click – until the size 
returns to 12 points.  If you overdo it and go below 12, you can always 
click on Enlarge again.

Enlarge and Shrink can adjust each character individually without 

forcing different characters in the expression or selection to be the same 
size.  For example, select only the y and Shrink it twice to reduce it to 9 
points:

Then select y + c.  Click on Shrink twice again, to shrink the two of them:

Notice that Expressionist did not just blindly change everything to 6 

points; it shrunk everything down two steps.  The y dropped down from 
9 to 6 points.  To see for yourself that the c has not been converted to 6 
points, select it and look at the FontSizeStyle box, which says “Times 9” 
or “Times New Roman 9”.
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Select y + c and take another look at the FSS box.  Since the selection 
includes characters of differing font sizes, the FSS box does not show a 
size.

With the whole expression selected, click the D button to change back to 
the default 12 points.

The size that you begin with when creating new equations should be the 
same as the text in your word processor.  The text in most books and 
journals is typeset in 9 to 12 points.  (Subscripts, superscripts and other 
symbols of different size are measured from your starting size.)  For 
lower-resolution printing, you should use 12 points for readability.  
Expressionist lets you set the default font, including size and style 
characteristics, but we will continue to use the default Times or Times 
New Roman 12 italic for most examples in this manual.

Enlarge and Shrink will become more useful later when you edit more 
complicated equations with subscripts, limits, etc.

Composite 
Structures

Up until now  we have seen how Expressionist works like a regular word 
processor.  But that’s not why you got an equation editor—you want to 
do equations more complicated than x = y + z.  You can do this with 
“composites,” templates for more complicated structures.  Expressionist 
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organizes its composites on pop-up palettes with buttons with icons 
representing the resulting composites.

Pop-up palettes of composites on the main palette

Get back to our simple equation and select y + c:

Fraction
Choose the  palette button from the  pop-up palette:fraction

Notice that this has caused the selection to become the numerator (top 
part) of a vertical fraction.  The bottom part is a question mark. (because 
you have not told Expressionist what you want on the bottom yet).  So, 
type D + E:

There is another composite you can use to make subscripts and 

superscripts.  To see how to use it, first get rid of the fraction by selecting 

IntegralsRoots, etc.
MarksFences Fractions

Subscripts/Superscripts
Trees

Frames
Overstrike
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the fraction, deleting it with the ƒ (or ø) key, and re-typing .  (There 
is an easier way to do this, but Unmark is covered later in the manual.)

Superscript
Now, select the letter c and choose the  button from the  pop-up 
palette for the superscript:

The composite is attached to the selection, with a “?” in the superscript 
location.  Type “2” in the superscript:

Notice that the 2 is slightly smaller than the other characters.  It is smaller 
by three Shrink steps, which works out to about 60% of the original size.  
As you might imagine, you could attach superscripts or subscripts to 
your superscripts or subscripts and they would be two steps smaller yet.

Subscript You can make subscripts using a neighboring button.  Select the y and 

choose the  subscript button from the  pop-up palette:

and you can type in a 2 for that, too:

Notice that the superscript has a tiny little guide box in the subscript 
position, and the subscript also has a tiny box in the superscript position.  
That is because the subscript and the superscript composites are actually 

  y+ c



38

Using Expressionist’s Features

the same thing, called a “subscript/superscript composite.”  A subscript 
composite has the superscript deleted, and a superscript has an empty 
subscript box.  These empty guide boxes are not as tall as other strings 
because they do not have any characters in them.  (A string is only as tall 
as its tallest constituent.)  You can make a superscript above your 
subscript by carefully clicking inside that tiny box so you have a blinking 
caret, and then typing N:

Viewing Modes Expressionist provides three different viewing modes to help you edit 
equations.  Each affects how the equations are displayed on the screen 
but do not affect how your equation looks when printed.

Guide mode The rectangles that you see outlining strings are not really part of your 
equation.  They are just there to help you see what is going on.  They only 
show themselves when Guide mode is on, which is the default.  You can 
turn it off by clicking on the  palette button.

You can turn Guide mode back on by clicking the button again.  Notice 
that the equation looks like it gets a bit smaller when Guide mode is off.  
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Expressionist makes room for the guide boxes when it draws the 
equation in Guide mode.  It is as if each string is wearing an invisible 
fluffy down parka—everything gets slightly bigger and disproportionate.  
Guide mode does not affect equations copied, saved, or printed.

Guide mode makes the designs of your equation more obvious.  For 
example, you have seen how the guide boxes aid you in placing the 
cursor in an empty superscript.  The Overstrike composite, which 
consists of two components printed on top of each other, is separated in 
Guide mode so you can edit the two elements easily.

The guides are three-dimensional beveled boxes on a grey background 
with black characters.   (This is if you are using a Windows display driver 
which displays more than sixteen simultaneous colors; if not, then the 
guides are dotted-line boxes with black characters on white background).

For aesthetic clarity, the screen shots in this manual show dotted-line 
Guide boxes with black characters on white background.

                                              

your screen may show this…       but this manual shows it as this
  

If you add different colors to your equations (described later in this 
manual), Guide mode does not show the colors.  You must turn off Guide 
mode to display the equation in its true colors.

Turning on Guide mode turns off Ruler mode, described below.

Ruler mode Beside the Guide mode palette button is the Ruler mode button.  Clicking 
this button turns off Guide mode (they are mutually exclusive and thus 
can not both be on at the same time).  With Ruler mode on, rulers appear 
above the strings in your equations.  A ruler lets you change justification 
(left, right, or center), set tab stops (left, right, center, equal sign, or 
decimal point), and move the right margin.

Ruler mode is explained in more detail later in this manual.

Magnify mode The button just below the Guide mode button with the magnifying glass 
icon toggles Magnify mode on and off.  Normally, Magnify mode is on 
and what you see is twice as big as the actual size.  By clicking on the 
magnifying glass, you can turn Magnify mode off and on again:
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Magnify off Magnify on

It is easier to work with equations in Magnify mode, because the actual 
font sizes used may be as small as six points, and smaller font sizes are 
difficult to see and work with.

Just like the other viewing mode buttons, when Magnify mode is on, the 
button appears to be depressed.

Guide mode does not affect equations copied, saved, or printed.

Special 
Symbols

Many times equations have Greek letters or mathematical symbols in 
them.  Although you can type them in from the keyboard, it is easier to 
just click on the desired symbol from the palette.

The main palette has a row of Greek letters and special symbols:  π, θ, ϕ, 
α, β, γ, ∂, ∞, ′, and .  There are more lower case Greek letters available 
on the α pop-up palette and upper case Greek letters available on the ∆ 
(Delta) pop-up palette.  Other pop-ups contain palettes of operators, 
arrows, set operators, and the other symbols.

If your palette does 
not show these Greek 
letters and symbols, 
your system doesn’t 
have the Symbol font 
installed.

Pop-up palettes of special symbols

Now you have got a much better selection of Greek letters and symbols.  
The characters on the palette and most of the sub-palettes are from the 
Symbol font.  If you click on one of these symbols, then select the symbol 
inserted into your expression window, you will see that the 
FontSizeStyle box tells you it is in the Symbol font.

You can type Greek letters from the keyboard.  Hold the Alt key and 
Control key as you type some alphabetic characters.  Notice that the 
inserted characters are the Symbol font Greek letters corresponding to 
the keys you press.  For example, typing åF (ÅçF) gives you lower case 
phi, φ, and typing åßF (ÅçßF) gives you upper case phi, Φ.

See the Encyclopedia section’s entry for Keystroke Definitions for more 
information, including instructions on how to print a list of currently 
assigned keystroke definitions.

Upper Greeks
Arrows Lower Greeks

Geometry
Set Theory

Logic
Operators
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Cutting and 
Pasting

This section discusses cutting and pasting in Expressionist.  This will 
come in handy if you have equations with the same sub-expressions 
repeated over and over again.  If you use cut and paste in your word 
processor already, you will probably use it even more in Expressionist.

First, create this expression on the expression window:

Next, select the fraction by dragging from the top to the bottom,

and choose Cut from the Edit menu to cut the fraction to the clipboard.

Now, choose Paste from the Edit menu to paste your fraction back in 

the expression.

As in a word processor, you can continue to use the contents of the 
clipboard.  Type +, then Paste again:
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You can enclose composites inside other composites by pasting.  Select 
the e in the bottom of the first fraction:

 Do another Paste:

There is no limit to how deep you can nest composites inside others.  
Select the e on the very bottom and Paste again:

Turn off Guide mode and Magnify mode to see what the whole equation 

looks like:
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Under Windows, çX, 
çC, and çV

The Edit menu items are just one way to do clipboard commands.  You 
may use the keyboard shortcuts for Cut, Copy, and Paste (˚X, ˚C, and 
˚V, respectively) for characters, expressions, and whole equations.  The 
Expressionist palette provides another method to access the clipboard.  
The four buttons starting at the lower left are Undo, Cut, Copy, and Paste.
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INTRODUCTION

This chapter has example equations and shows how to type them into 
Expressionist.  At the beginning of each tutorial, there is a final, 
completed equation that you can use as a guide.  Also, each example 
shows samples of what the screen should look like, step-by-step so that 
you can easily follow the examples.  At every step, make sure that your 
screen looks like the picture shown.  If you find that you have made a 
simple mistake, you can usually fix it by clicking on the Undo button.  
Help is always available from the Help menu.

These tutorials assume that you have not changed any preference options 
from their default settings.  If you have made changes, some of the 
directions may be inappropriate.  You can re-install the original 
preferences file from the Expressionist disk to return options to their 
default settings.
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PRESSURE

This simple example shows some basic techniques for writing equations.

Start by typing P = P:

Use œ if your 
keyboard has no esc 
key.

Select the second p by dragging over it or clicking on its middle.  To 

attach a subscript choose the  button from the  pop-up palette.  

The subscript is selected, so type 0 (zero).  Press Ÿ to move the cursor 
out of the subscript guide box:

     

This is the pop-up 
palette of lower-case 
Greek letters.

Type +.  To make the Greek letter rho (not to be confused with p) choose 
the ρ symbol from the palette’s α pop-up palette button of lower case 
Greek letters:

Then type G H:

   p= p0 + ρ gh

cursor
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MATRIX

In this example, we use a Matrix composite, and use cutting and pasting 
in conjunction with the various selection tools to make our work easier.

Start by typing ßA =.  Then choose  from the  pop-up palette to 

make a 3 × 3 matrix:

Enter the contents of the first cell (which is already selected):  Choose 

, type 1, click , choose  from the  pop-up palette, and 

type 3:

Now,  select the entire first matrix element and click  to copy it to 

the clipboard.  Click  to Select Out, which selects the whole matrix,

  

A =

1
3

1
2

1
6

1
3

0 2
6

1
3

– 1
2

1
6



Tutorial Equations

50

…then click  to Select In, which selects all individual matrix cells.
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Click  to paste the reciprocal square root into each cell.  (Note that 
if we had selected the whole matrix and pasted, it would have replaced 
the entire matrix with a single   instead of inserting into each element 

the way we want.)

Click and drag to select the entire third column as shown:

 1
3
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Select In .  Select First .  Select Next .  Select First  

again.  Type 6 to replace the selected 3’s.

Click and drag to select the center matrix cell, then type 0 (zero).

Select the two 3’s in the middle column by clicking and dragging over 
the first 3 then doing the same to the second 3 while pressing the Shift 
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key.  Shift-drag over the numerator in the middle cell of the last         
column.  The multiple selection is:

Type 2.  Place the cursor at the beginning of the bottom-middle cell, and 
type - for a minus sign.

Select the whole matrix (by dragging or doing Select Out  twice), 

then choose  from the  pop-up palette to enclose it in               
parentheses:
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The letter A is a tensor quantity (higher than a vector), so it should be 
changed to Arial, a sans serif font.  Select the A by dragging or clicking 
on its middle, then click the FontSizeStyle box, 

, change the font family to Arial, change the 

Italic style pop-up menu to off, and click OK.  The equation is complete.
  TimesNewRoman 12 iv

  

A =

1
3

1
2

1
6

1
3

0 2
6

1
3

– 1
2

1
6
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QUANTUM MECHANICS

In this example, we use some keyboard shortcuts and a macro, and also 
try the Insert Something command.

                
The operators and 
macros pop-up        
buttons.

Start by typing X.  To insert the ≡ symbol, click and hold on the × pop-
up button.  When the palette of operators pops up, move the pointer to 
the ≡ symbol and release the mouse button.  To make the limit, choose 
the  macro icon from the  pop-up.  (Be sure to choose the limit 

macro with the right arrow, not the left arrow.) macro pop-up

Choosing a macro, inserts it into the expression.

With the above selection, type N, then click and drag over the right ? to 
select it and click the infinity sign ∞ on the palette.

   
x≡ limn→ ∞ xn = y–

b1 | y a1

1 + b1 | a1
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Select the ? to the right.  Type X and press ̊ L (çL), which grabs the x  and 
attaches a subscript to it.  Type N into the subscript.  Press Ÿ to move the 
cursor out and to the right, then type =:

Now, type Y -.  Press ˚F (çF), or choose :

Type ß\ (backslash) 
for  the vertical bar.

Type B ˚L 1 Ÿ ˙ | ˙ A ˚L 1 (use çL instead of ˚L with Windows).  Select 

the whole numerator (either drag or use Select Out  a few times), 
copy it to the clipboard, select the denominator, and paste.

Select the whole denominator and choose  from the fences pop-up 
palette to surround it in angle brackets.  Move the cursor to the beginning 
(left) of the denominator string and type 1 + ˙.
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In the numerator, position the cursor as shown below.

Type Y ˙.  Click and drag to make the following selection, paying 
particular attention to the spaces.

Surround this in the angle brackets like you did in the denominator a few 
steps previously.

This is what it looks like if we print it out:

It looks good, except that the vertical bars are somewhat small.  Select 
each bar (that is, so you have a multiple selection) and choose Insert 
Something… from the Edit menu.  In the ensuing dialog, select the ω 
Symbol font command from the scroll list.

cursor

   
x≡ limn → ∞xn = y–

b1 | y a1

1 + b1 | a1
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Below this list is a list of all characters in the Symbol font.  Click on the 
vertical bar as shown below,

…then click the This Character button.  The Symbol bar is inserted into 
your equation, replacing the selected original wimpy bars.

That is more like it!

   
x≡ limn→ ∞ xn = y–

b1 | y a1

1 + b1 | a1
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ANTENNA

This example shows how to use a matrix to make rows and columns line 
up, and the Change command.  It also shows how to enter an equation 
entirely from the keyboard.

First create the leftmost fraction:  Press ˚- to make a vertical fraction and 
type D ßP.  Press † to move the selection to the bottom.  Type D.  To 
make the Ω, type åßW on a Macintosh or ÅçßW under Windows.

Press Ÿ to get out of the fraction, and type =.  Type ˚- (çF under 
Windows) to get another fraction.  Type in the numerator:  ßI ̊ H 2 (ßI çH 
2).  To move the selection to the denominator, press Ÿ then †:

   

dP
dΩ = I2

2πc

cos2 π
2 cos θ

sin2 θ
, kd = π

4 cos4 π
2 cosθ

sin2 θ
, kd = 2π
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Type 2 åP C (Mac) or ÅçP C Ÿ (Windows).

Now start on the big, ugly part.  First, type ˚ß[ (or ç™)to make a set of 
curly braces.  Press ßŸ, which invokes the Select Out command to select 
the whole set of braces and their contents.

The braces are part of a fence composite, which surround an expression 
with a fence style (e.g., bracket, brace, etc.) or combination of fence 
styles.  Invoke the Change command by pressing ˚K (or çK), which 
brings up the Change Fence dialog.
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This dialog has many 
keyboard shortcuts for 
the various fence 
styles. Experiment a 
little.

This dialog lets you change various attributes of the selected fence 
composite.  You can change the fence style, make a fence on one side, or 
make a fence on the top and/or bottom.  You can mix and match fence 
styles.  In this case, we just want a curly brace on the left, so press use 
the Tab and/or arrow keys to choose Nothing on right and press œ.

Select the question mark inside the fence by pressing ˚E (or çE).  This 
invokes the Select In command, which selects what is inside the selected 
structure, and is the opposite of the Select Out command used a few steps 
previously.

Make a fraction with ˚- (or çF) and type C O S in the numerator.  Press 
˚H (or çH) to make a superscript for the “cos”.

Type 2 for the superscript, then Ÿ to get out of the superscript.  Type ̊ åß9 
(ç¡) to make the parentheses, and inside them make a fraction with ˚- (or 
çF).  Type åP † 2 (or ÅçP † 2) so you have:

Press Ÿ to get out of the inside fraction, which still leaves the cursor 
inside the parentheses.  Then, type C O S, then ÅÇQ (or åQ) to make a θ.  
That is it for the top of the fraction: 
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Type ß\ (backslash) 
for the vertical bar.

Select the denominator by typing Ÿ †.  Type S I N then make a 
superscript with ÇH.  Type 2 Ÿ ÅÇQ (2 Ÿ åQ):

Type Ÿ to go to the end of the big fraction, and press , to insert a      
comma:

Press ßŸ to Select Out.

Copy it to the clipboard.  Press ˘ to move the cursor.  Press ˚† (or Åß†) 
to invoke the New Field command, which adds a matrix column.  Press 
œ for New Line, which adds a matrix row with the bottom-left cell 
selected.  Paste it to the clipboard.

Next, we must make changes in the bottom expression.  With the cursor 
still in the bottom part you just pasted in, press ¯ twice, then press †.  
Press ¯ to put the cursor just to the left of “cos2”, then type 4 ˙ ( or 4).  
Then, select the superscript 2 by pressing ̆  followed by † twice, and type 
4 in its place:
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Select the top-right cell of the matrix by typing Ÿ twice and † three times, 
then type K D = åP (or K D = ÇP) to make:

The next part is an exercise for you.  Using the keyboard only, select the 
bottom-right matrix cell and enter the expression “kd = 2π”.  Using the 
mouse is cheating; bonus points if you copy and paste.  You want to end 
up with

The equation is complete.

   

dP
dΩ = I2

2πc

cos2 π
2 cos θ

sin2 θ
, kd = π

4 cos4 π
2 cosθ

sin2 θ
, kd = 2π
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COOKBOOK EQUATIONS

Now that you have completed the tutorials and acclimated yourself with 
Expressionist, you can construct equations with a minimum of guidance.  
For each ‘recipe’ below, start with a new expression window.  If the 
recipe shows a button, click it.  If it shows a key, type it.  If it shows a 
menu item, choose it.

Uranium 
Isotope

  

Change prescripts on, superscripts and subscripts off.

 ßU  92  235

Eigenvectors

    

Choose Left Side and press OK.

The  button is on 

the  pop-up and 
on the Insert 
Something dialog.

    1     OK  
(The cursor disappears after the second Escape, but reappears at the end 
of the expression when you begin typing…)

Pi (π) is on the palette.
=     EXP  I2 π (1)(  Ø )/4   = 

  U92
235

  
1 1

1 2

1 3

1 4

=

exp i2 (1)(1)/4

exp i2 (1)(2)/4

exp i2 (1)(3)/4

exp i2 (1)(4)/4

=
i

–1
–i
1
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  I  -1  -I  1

 Language Tree Turn off Auto Spacing (from the Options➧Editing submenu) before 
doing this one.  Pay attention to the nesting and escape levels as you 
create this tree.  Also notice how the Raise command works.

Macintosh… ˚ßT “Insular Celtic” † ˚ßT “Gaelic” † “Manx” ˚ß˜ ˚† 
“Scots Gaelic” ˚† “Irish” ˚ß˜ Ÿ ˚ß˜ ˚† ˚ßT “Cornish” † 
“Breton” Ÿ ˚† ˚ß˜ ˚ßT “Old British” † “Welsh”

Windows… ÇP ÇT “Insular Celtic” Åß† ÇT “Gaelic” Åß† “Manx” 
Å˜ † “Scots Gaelic” † Å˜ “Irish” Ÿ Å˜ † ÇT “Cornish” † 
“Breton” † ƒ ø Ÿ † Å˜ ÇT “Old British” † “Welsh” † ƒ ø

Tree Pay attention to the nesting and escape levels as you create this tree.  Also 
notice which commands backselect the previous string.

Macintosh… A ˚ß† B ˚† C ˚† D ˚ßT E ˚† F ˚ß† G ˚† H Ÿ ˚† I Ÿ ˚† J 
˚† K

Windows… ÇT A † B † C Åß† ÇT D Åß† E † ÇT F † G † H Ÿ † I 
Ÿ Åß† J Åß† K

 InsularCeltic

Gaelic

Manx

Scots Gaelic

Irish

Cornish
Breton

Old British
Welsh

 a

b c d
e f

g h
i

jk
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Sideways Tree Pay attention to the nesting and escape levels as you create this tree.  Also 
notice which commands backselect.

Macintosh… A ˚åßT B ˚åßT C ˚† D ç ˚† E ˚åßT F ˚† G
Windows… A ÅÇßT B ÅÇßT C Åß† D Ÿ Åß† E ÅÇßT F Åß† G

Triple Integral Pay attention to the nesting and escape levels as you create this tree.  Also 
notice which commands backselect.

Macintosh… ˚J ƒ † 0 † 1 ßŸ ßŸ ˚C Ÿ ˚V ˚V ß¯ ˚1 ˚F DX ˙ DY ˙ DZ 
† ˚R X ˚H 2 Ÿ + Y ˚H 2 Ÿ + Z ˚H 2 ˚A

Windows… ÇJ ƒ † 0 † 1 ßŸ ßŸ ÇC Ÿ ÇV ÇV ß¯ Ó ÇF DX ˙ DY ˙ 
DZ † ÇR X ÇH 2 Ÿ + Y ÇH 2 Ÿ + Z ÇH 2 ÇA ÅE M
The last two keystrokes drop down the Edit menu and choose Magic 
Alignment.

Nonlinear

 Y  ˘ ß¯  X  

+ η  Y  ˘ ß¯ X 

+  ƒ   ω   2 

 

a

b
c

d

e
f

g

  

0

1

0

1 dx dy dz
x2 + y2 + z2

0

1

   d2 y
d x2 + ηd y

d x + ω2sin x
nonlinear part

= 0
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S I N X    ÇP “nonlinear part”    
Allow Uneven Rows OK  = 0
Note the similarity between the “nonlinear part” in the equation above 
and the “volume weighting” in the expression which follows.  Both use 
different methods to accomplish similar tasks.

Volume

˚T (or ÇP for Windows)   W    I   

“volume”  ˙ ˙ ˙ ˙   
On the ↔ pop-up. Subscripts and Superscripts…    off

Underscripts and Overscripts…  on

 fi   “volume” œ “weighting”   ̇  ̇  ̇  ̇   

ω  “grid”  ˙ ˙ ˙ ˙   
£ Subscripts and Superscripts

¢ Underscripts and Overscripts Ø

 ⇒   “FFT”  ˙ ˙ ˙ ˙  ω
Multiple 
Aligned Lines

Macintosh… S I N åQ = - S I N ( åQ + åP ) œ = - C O S ( åQ + åP / 
2 ) œ = C O S ( åQ + 3 åP / 2 ) ˚A ˚K
Align Along This Character

  wi
volume ⇒

volume
weighting

ωgrid ⇒FFT ω

  sin θ =–sin (θ + π)
=–cos (θ + π /2)
=cos (θ + 3π/2)
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Windows… S I N ÅÇQ = - S I N ( ÅÇQ + ÅÇP ) œ = - C O S ( ÅÇQ 
+ ÅÇP / 2 ) œ = C O S ( ÅÇQ + 3 ÅÇP / 2 ) ÇA ÇK
Align Along This Character
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INTRODUCTION

This is an advanced 
topic; you may wish to 
skip this section.

This section shows how to use commands on the Expressionist 
application program’s Options menu to customize your equation editing 
environment and to fine-tune the output.

The Options menu consists of commands that change Expressionist’s 
option settings.  Most of these commands bring up dialogs with lots of 
settings in them.  The settings are saved in the EXPR.PRF file, which is 
in the EXPRPREF directory, in the EXPR directory.  These directories 
should have been created when you installed Expressionist.

When Expressionist starts up, it reads in this preferences file, which tells 
Expressionist the palette layout, keyboard assignments, and other 
options to use.

By making copies of the preferences file, you can save your preferences 
the way they were and bring them back later.  You can also move this 
preferences file to other machines and share them with colleagues who 
also own Expressionist.  In fact, you can even move your preferences file 
to other computer platforms running Expressionist version 3 or later.  
(However, due to operating system incompatibilities, some machine-
specific options such as keystrokes and fonts will likely be lost.)

Prefs Backups After you learn how to modify Expressionist’s options, you may be 
dependent upon the settings saved in the prefs file.  Though not a 
common occurrence, sometimes a bug in a Windows display driver can 
corrupt information in this file.  You may also make option changes 
which turn out to be detrimental.  In these cases, you can return to your 
desired settings if you restore a backup copy of the prefs file.  So keep a 
backup of your prefs file!

Save Your 
Prefs or Lose 
Them

The following examples change your current preferences in ways you 
will not appreciate (e.g., erasing existing palette buttons), so consider 
your current preferences file a write-off unless you make a backup of the 
prefs file.  You can do this with the Windows File Manager or at the DOS 
prompt.  The following steps describe how to back up the prefs file at the 
DOS prompt.

Do not use the C: 
drive if your drive has 
a different letter.

➀ Change the current directory to the Expressionist preferences   
directory by entering CD C:\EXPR\EXPRPREF.

③ Make a copy of the prefs file by entering the command COPY  
EXPR.PRF EXPR.BAK.

After you are done with the options tutorials in this chapter, you should 
delete the prefs file and restore the original prefs.  You can do this with 
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the Windows File Manager or at the DOS prompt.  The following steps 
describe how to restore the backup prefs file at the DOS prompt.

➀ Change the current directory to the Expressionist preferences  
directory by entering CD C:\EXPR\EXPRPREF.

③ Delete the prefs file by entering the command DELETE  
EXPR.PRF.

➂ Restore the backup prefs file by entering the command  
RENAME EXPR.BAK EXPR.PRF.

Getting Started Go to Windows and start up the Expressionist application program to 
begin the examples.
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FONTS AND CHARACTERS

Inserting an 
Obscure                
Character

Let us say that you are editing an equation, and you need to insert the 
clubs playing card symbol, ♣.  You know that it is somewhere in the 
Symbol font but you do not know its keystroke.  Choose Insert 
Something… from the Edit menu, click on ω Symbol, then double-click 
on the ♣ character, as shown:

Notice that was easy because a Symbol font command is listed in the 
corner of the Insert Something dialog.  Now let’s say we want to insert 
the ★ symbol from the Wingdings font.  (The Wingdings  font has lots 
of “dingbats” such as ò!(ÒãX.)  Unfortunately, there is no font 
command for Wingdings in the list of pre-defined font commands.

Adding a Font    
Command

To add Wingdings to our list of font commands, first, make sure the 
Wingdings  font is installed on your machine.  Then, choose               
Options➧Editing➧Font Commands…, which lists all of your font 
commands.
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Click on New Font Command…, and when the FSS dialog comes up, 
find Wingdings and click on it.  It’s a good idea to turn italics off for these 
symbols. so do that and click OK.  That will bring you back to the font 
commands dialog.  Make the logo character a capital J and click OK.  
Now you can use the Insert Something dialog as described before and 
insert a ★ in your expression window.

The font commands are a place to record favorite combinations of font 
family, size and style variation that you often use in your equations.  
Each is like clicking on the FontSizeStyle box and choosing various 
options, except that all of the things you select are all encapsulated into 
one compact font command.  There are font commands pre-defined for 
Symbol as we have seen, and there are more to change size and styles, 
but you can add your own, as we did here.  If you want to use the Insert 
Something dialog for inserting mathematical symbols in special fonts, 
you should make font commands for those fonts.

Changing the 
Default Font 

Let us say that you are working on a paper with many equations.  When 
you started the paper, it was all in the Times New Roman font, but now 
you want to change the main font to Arial.  Besides changing the font  in 
your word processor, you also have to change your equations.  (The word 
processor can not change fonts in equations.)

For more information 
on OLE, see the 
Encyclopedia section.

You must re-edit each equation and replace it in your document.  
Although this sounds tedious, there are two tricks that can make this a 
rapid process.  By changing the Default Font and using OLE, all you 
have to do is double-click the equation in the word processor then close 
its equation window in Expressionist.  This automatically changes the 
main font of the equation and replaces it in the word processor.  
Moreover, if your equations are linked, they are automatically updated to 
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the new Default Font whenever you open your document with your word 
processor.

If your word processor can not use OLE, you must copy and paste 
between your word processor and Expressionist.

Changing the Default Font (e.g., from Times New Roman to Arial) is 
simple.  Choose Default Font… from the Options➧Characters 
submenu, which gives you the familiar FontSizeStyle dialog.

All you have to do is to change the font family to Arial.  From then on, 
every equation you re-edit will have all of its Times New Roman 
characters automatically changed to Arial.  (Everything that was in 
Symbol font or any other font will remain the same.)

Internally, each character in each equation remembers either that it was 
in the Default Font, or that it was in another specific font.  If it was in the 
Default Font, however, it does not remember what that Default Font was, 
so if you change the Default Font, everything that was in it is changed.  
Everything that was specifically in Symbol font or Wingdings or 
whatever is not changed.

Taking this into account, you should always set Expressionist’s         
Default Font to match the font family and size that you are using for the 
body text in your document.  This way, if you ever have to change your 
font, it will be easy.  (The Default Font is the starting font in new 
expression windows; if you find yourself constantly changing this to 
something else, you should instead change the Default Font itself.)
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If you change the Default Font size, be sure to change the Character Size 
Steps (described below, and in the Encyclopedia section).

The only differences between the default font in your word processor and 
the Default Font in Expressionist should be italics and vertical squeeze.

Italics In Expressionist, you may want the Default Font Italics style option set 
to Non-Functions.  This way, most alphabetic characters will be in 
italics, as they should.  Digits, mathematical symbols and letters that 
spell a recognized function name (e.g., “sin”, “log”) will not be italic.  
(To change the list of recognized functions, see the Encyclopedia 
section.)

Vertical Squeeze Expressionist has a special Vertical Squeeze style option not found in 
word processors.  It tells Expressionist to pay special attention to the 
exact extent of each character in your equation.  This way, for instance, 
superscripts on x’s will be lower than those on X’s, as they should be.  It 
should be on in your Default Font; this way proportions will come out 
better.  (If the differing proportions of letters causes something to mis-
align, you can usually fix it with Magic Alignment.  See the         
Encyclopedia section.)

Changing 
Subscript and 
Superscript    
Sizes

Let us suppose you need subscripts that are significantly smaller than 
those that Expressionist is generating for you.  The size of subscripts that 
look “right” depends upon the size of your body text, the resolution of 
your printing device or screen, and other factors such as your own 
personal taste.

Expressionist manages sizes by using size steps.  Four steps larger or 
smaller means inflation or deflation by a factor of two, so that each step 
means about a 15% to 25% change in size.

By default, Expressionist gives you subscripts that are three steps 
smaller.  You can change this by choosing Sub, Super, Summation… 
from the Options➧Adjustments submenu, which brings up a dialog:
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Superscripts are 
changed similarly.

To change subscripts to being half size, simply change the setting on the 
pop-up menu from Three Steps Smaller to Four (Half Size).

In the same dialog, you will notice a setting for sigma and pi sizes.  This 
is because summation and pi product structures are made using a 
variation of the subscript/superscript composite, where the character in 
the “base” position is larger than the default font size.

The size that Expressionist uses for subscripts of subscripts (and 
superscripts of superscripts) can be found by reducing the subscripts size 
by the same factor again.  The size is limited by the Minimum Size.

Setting the 
Minimum Size 
and Size Steps

By default, the minimum size is six points, but you can change this by 
choosing Options➧Characters➧Step Sizes….  By setting this           
minimum to be much smaller than the Default Font size, you can get 
many steps of reduction before the minimum is reached.
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The exact sizes Expressionist uses in its scale of size steps are controlled 
by the Character Size Steps dialog.  On the top is listed the current 
definition of the entire scale of size steps, going from the minimum size, 
through the Default Font size, all the way to sizes that are much larger 
than you may ever need.  On the bottom are three boxes that tell exactly 
what sizes will be used for one cycle from the default size to the size that 
is twice as large.

If you are using a 10 point Default Font size, the three numbers you 
should enter here are 12, 14, and 18.  If you are using a 12 point Default 
Font size, the three numbers you should enter here are 14, 18, and 20.  If 
you are using Adobe Type Manager or TrueType, though, consider the 
Make Logarithmic button, which chooses well-spaced increments.
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CUSTOMIZING THE 
PALETTE

Adding an 
Obscure 
Character

For this example, we will assume you need to use the ♣ symbol often.  
Instead of just using Insert Something, you can put it on the palette so 
you can click on it any time you want to insert it into an expression.

Choose Options➧Editing➧Palette Buttons….  A large dialog shows 
your entire palette.  The dialog is so large that it will not fit entirely on 
your screen, unless you have a large screen.  (The parts that you cannot 
see are empty and so you are not missing anything.)  This dialog lets you 
change the palette.

Note the dots 
bordering the buttons 
correspond to your 
current palette window 
size.

Find a button on the palette that you rarely use.  We will use the ¢ prime 
symbol button and change the button’s purpose to insert the ♣ symbol.  
Click on your chosen button, which highlights it.  Then click on the 
Insert Something… radio button, which brings up the familiar Insert 
Something dialog.  (This time, instead of inserting the ♣ symbol into 
your expression, you are defining a button so that every time it is clicked, 
the button inserts the ♣ symbol.)  Double click on the ♣     symbol.  When 
you get back to the Palette Buttons dialog, click OK.  This saves your 
new palette, which now has a ♣ symbol.
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Adding a 
Composite For our next example, let us say you need the arc  composite           

frequently for geometry lessons.  Unfortunately, the arc composite is on 
a pop-up palette, which requires an extra step to access it.  You would 
rather have an arc right there on the palette, a click away, and you could 
sacrifice the " pseudocharacter that you never use.  Here is how to do it.

Choose Options➧Editing➧Palette Buttons….  Click on the button you 
want to reprogram, the " button in this case.  Then, click on Insert 
Something.  When the Insert Something dialog comes up, double click 

on the arc  icon.  That is all there is to it.

Making a Macro
Let us say you want to make a  button to insert a vector on the bottom.  
There is no such button in the Insert Something dialog, because there is 
no such pre-fabricated composite.  However, you can make a macro 
button to insert a bottom vector.

Editing the 
Macro         
Expression

Choose Options➧Editing➧Macro Definitions….  Click on New Macro.  
A window named Macro Scratchpad appears for editing the macro 

expression.  Click on the   button to get a vector.  Select All and 
Change.  In the Change Mark dialog, choose below, normal then click 
OK.  Close the Macro Scratchpad window to return to the Macro 
Definitions dialog.
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Creating the 
Macro Button 
Icon

Now that you have created a new macro for a vector on the bottom, you 
need to make an icon to represent it on the palette.  You do this by 
clicking in the box on the lower right side to “paint.”

The automatic icon 
generation feature is 
not appropriate for our 
macro.  Besides, you 
need to learn this.

Sometimes making the icon is the most difficult part.  One technique is 
to simply copy the design of another icon.  Since you need an “a”, find 
another macro that has an “a” in it.  Copy its design scan line by scan line, 
clicking back and forth between the macro you are making and the one 
you are copying from.  For instance, the bottom line of the “a” on many 
buttons has four black pixels in a row, then a white pixel, then three black 
ones again.  Make sure you have the positioning right before you start, 
though.  If you find that you later want to move it, you can do so one scan 
line at a time again, but this time you do not have to click between 
macros.  Do not spend a lot of time on an icon if you are not sure that 
you’ll keep it.
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When you click OK, the macro and its icon are stored in the preferences 
file.  Though it is defined and you can use the macro from the Insert 
Something dialog, it is not on the palette where you may find it more 
useful.  So, the next step is to place it on the palette.

Choose Options➧Editing➧Palette Buttons….  Click on an existing 
button to replace, perhaps the , button.  Then, click on Insert Something.  
When the Insert Something dialog comes up, locate your new bottom 
vector macro in the scrolling list of macros on the left (it is probably the 
first one), and double click on it to place it on the palette.

You can make macros for more substantial things than simple 
composites.  For instance, the summation is a macro.  In fact, you can put 
any expression in a macro.  Make sure that any characters in a macro are 
in the Default Font; otherwise the macro will change the font on you 
every time you use it.

For our next example, let’s suppose you want a palette button which 
changes any selected characters to the Wingdings font.

First of all, there must be a Wingdings  font command.  (If you have been 
doing the examples in this section, you have already defined a 
Wingdings  font command; if not, go back to “Adding a Font Command” 
and follow the instructions.)  The font command must have a character 
to represent it on the palette, and we used J, which is a smiley face in 
Wingdings.

Colors

Making a Pop-
up Palette

Let’s replace the T button (Times New Roman font command) with the 
new Wingdings font command.  Choose OptionsºEditingºPalette 
Buttons….  Click on the T button then click change the Font….  
Choose Wingdings  from the list of font commands.
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Click OK , then click OK  again in the Palette Buttons dialog.

Adding Other 
Editing 
Command 
Buttons

There are many other editing commands that you can add to the 

palette, such as Cut  and Paste , Guide mode , and Change 

.
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Arrow Selection For instance, let’s say you want buttons on the palette which correspond 

to the left and right arrow keys,  and .  Choose 
Options➧Editing➧Palette Buttons…, click on a button to replace (such 
as ∂), and click on do something else….  In the dialog presented to you, 
scroll down to where the arrow buttons are, and double click on the left 
arrow.

Do the same to replace the ∞ symbol with the right arrow and click OK  
in the Palette Buttons dialog.

Colors You can make a color command button using the same technique.  The 
color commands are down near the bottom of the scroll box.  The color 
of each one is shown in the scroll box.

The very last entry with the rainbow color patch allows you to concoct a 
color of your own.  When you choose it from the list, Expressionist 
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brings up the color picker dialog and you can choose whatever color you 
want your button to be.

Making a Pop-up 
Palette

You can make a button pop-up with a sub-palette of your own design 
when it is activated.  Pop-up palettes are made in much the same way the 
main palette is made.

Let us assume you want a pop-up palette with the four playing card suits, 
♠♣♦♥.  First, choose Options➧Editing➧Palette Buttons… to get to the 
Palette Buttons dialog.  Choose a button to replace.  (For this example, 
choose the ♣ button you made previously.)  Click on the activate 
popup… radio button.  A new Palette Buttons dialog appears with an 
empty grid representing your new pop-up.

Double-clicking an 
empty button space is 
a short cut to the 
Insert Something 
dialog.

This dialog lets you define buttons to insert something, change the font, 
or do something else, but for this example you will make five “insert 
something” buttons.  Make five buttons insert the characters as arranged 
in the illustration below.

Include the extra club, 
and ignore the dark 
corner square.

Click on the middle button (with the club) and click on the dialog’s check 
box named Origin Cell.  When you click down on a pop-up button, the 
origin cell is the cell that will be immediately under your mouse arrow 
when the palette pops up.  It is never active; that is, you will never get a 
club symbol inserted by clicking on it, it is there just for show, like the 
word “File” on the File menu.  (This is why we have two clubs on the 
pop-up palette; one is the origin for “show,” and the other is a character 
for “go.”)

A loose guideline for 
pop-ups is to put real 
buttons to the left of 
origins.  Check out the 
various pop-ups 
already on the palette.

The icon on the origin cell is the one that will show up on the main 
palette.  When you make a pop-up palette you should make an origin with 
a distinctive icon that summarizes the whole pop-up palette.  For 
instance, any of the four symbols would have been somewhat useful, 
although the diamond could be mistaken for something that had nothing 
to do with playing cards.  A spade or club pretty much puts all doubt to 
rest.

Click on OK twice.  You can now use your new pop-up palette button.
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Examining 
Existing 
Buttons

If you see a button on the palette, and you do not understand what it does, 
you can use the Palette Buttons dialog to find out.  Simply double click 
on the button and a dialog appears with the button’s function selected.

Rearranging 
the Palette

If you do not like the palette arrangement that we supplied you, you can 
change it by resizing the window, erasing buttons, adding buttons, or 
moving buttons.

Resizing the 
Window

For another example, let’s say you want a palette only four buttons high, 
and you decided that you could do without all of those buttons on the 
bottom row.  All you have to do is drag the palette window’s resizing 
bars to resize the window.  It is not necessary to go into the Palette 
Buttons dialog.

Erasing Buttons There is a more radical and destructive method of achieving the same 
result.  Choose Options➧Editing➧Palette Buttons….  In the Palette 
Buttons dialog, click on the first button in the bottom row, and then click 
on do nothing.  This erases the button.  Do the same with all of the 
buttons on the bottom row.

The palette (as determined by the preferences file shipped with 
Expressionist) comes with four rows and sixteen columns of pre-defined 
buttons, but there is nothing sacred about those boundaries.  The palette 
is really a 30×30 playing field where you can place buttons anywhere you 
want, assuming your screen is big enough.  If you place buttons outside 
of the original 4×16 area, you must resize the palette window.

If you prefer a vertical palette instead of a horizontal palette, simply drag 
individual buttons to the left side until you have them all in place the way 
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you want them.  Then, resize the palette window and drag it into position 
on your screen.

If you are trying to make a vertical palette on a smaller screen in this way, 
it may be necessary to move the outer-most (right-most or bottom-most) 
palette buttons inward first.  There are two arrangements of the Palette 
Buttons dialog, one designed for horizontal palettes, and one for vertical 
palettes.  Expressionist intelligently decides which arrangement to use 
based upon whether the right-most or the bottom-most button is further 
away.  It is possible to get into a situation where you can not access the 
buttons on the far right because the wrong style dialog is up.  If you get 
into a fix like this, move in the outermost buttons that you can see, click 
on OK and use the Palette Buttons dialog again until you can get at them.

Moving Buttons In the Palette Buttons dialog, you can exchange two buttons by clicking 
and dragging one to the location of the other.

Adding Buttons You are not limited to changing existing palette buttons; you can make a 
blank button location do something.  However, you must make sure the 
palette window is sized large enough so that your added button appears 
in the palette window.
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CUSTOMIZING 
KEYSTROKES

Greek Letter        
Keystrokes 

Expressionist allows you to define any keystroke on the keyboard to 
perform any editing function you could make a palette button do.  For 
instance, the preferences file that comes with Expressionist lets you 
insert a Greek letter simply by typing its Roman equivalent while 
pressing the Alt and Control keys.  For example, type ÅÇY to insert the 
Symbol font psi character y.  You do not have to juggle fonts as you 
would with other systems.

Appendix B lists the Greek letters and the special Control keystrokes you 
can type to insert them.

Redefining        
Keystrokes

Typing ÅÇL in Expressionist inserts a lambda, l, from the Symbol font.  
Let’s assume you want to redefine ÅÇL to give you ≅ from the Symbol 
font.

First, choose Options➧Editing➧Keystroke Definitions….  Type ÅÇL.  
The “Keystroke to Reprogram” box shows the keystroke you typed (“ctrl 
alt L”), and on the right you can see what it currently is defined to do, 
which is to insert λ.

Ignore the 
“Backselects first” 
checkbox, which is 
described later.

Below the λ are four radio buttons which work just like the buttons in the 
Palette Buttons dialog.  Click on Insert something…  and when that 
dialog appears, click on ω Symbol in the scrolling list of font commands 
in the upper right corner.  (It is already selected because the keystroke we 
are redefining uses the same font command.)



Using Expressionist’s Options

106

Note that on this 
dialog you must click 
OK; you can not use 
the œ shortcut.

Next, find the ≅ symbol in the character matrix (it is in the lower right 
corner) and double click on it.  Back at the Keystroke Definitions dialog 
you can see the keystroke “ctrl alt L” now inserts ≅.  Clicking on OK 
saves the redefined keystroke in the preferences file.  Type ÅÇL in an 
expression window to verify its operation.

Go back to the Keystroke Definitions dialog and type A.  The keystroke 
“A” appears in the dialog, and you can see it is defined to insert a lower 
case “a”.  Redefine it to insert the ∀ character from the Symbol font.  
Type A in an expression window to verify its operation.

Resetting a 
Keystrokes to 
Normal

If you do not want the redefined keystroke actions, you can tell Expressionist 
to revert to the normal characters for these keystrokes.

Warning:  this button 
can destroy hours of 
work.

In the Keystroke Definitions dialog, click  Reset to Original… .  Since 
this has a major effect on many keystrokes, a dialog asks you to confirm 
the command.  When you click OK Expressionist resets all normal 
keystrokes (i.e., those without Alt and/or Ctrl modifiers) to their normal 
functions.  For instance, A is reset to insert a instead of ∀.  However, 
ÅÇL is not reset, so it still inserts ≅.

Inserting an 
Obscure 
Symbol

You can use Expressionist’s Keystroke Definitions dialog to redefine 
keystrokes to insert commonly used or hard-to-find characters without 
having to juggle fonts and ASCII reference charts.  For example, we will 
define Ç∞ to insert the ★ character from the Wingdings font.

Hopefully you have worked through all the previous examples in this 
section and you have defined a Wingdings font command.  If not, go 
back and do it now.

Choose Option➧Editing➧Keystroke Definitions….  Type Ç∞ and the 
dialog tells you the keystroke inserts a double absolute fence composite.  
Let us assume you have no need for a keystroke for this composite and 
you need a star frequently.  Click on Insert something….  When the 
familiar dialog appears, choose Wingdings from the list of font 
commands, then double click on the ★ symbol in the character matrix.  
Click on OK back in the Keystroke Definitions dialog and now you can 
make ★ with Ç∞ in your expressions.

Inserting Macros 
and Composites

Not only can you redefine keystrokes to insert characters, but you can 
make them insert composites and macros.  For example we will redefine 
the keystroke Ç• to insert the bottom vector macro you constructed 

previously in this section, .

Choose Options➧Editing➧Keystroke Definitions….  Type Ç•.  (Notice 
the current definition inserts the hollow brackets composite.)  Click on 



Using Expressionist’s Options

107

Insert something….  When the dialog appears, double click on the  

macro icon.  (You may have to scroll through the macro list for it.)  Click 
OK in Keystroke Definitions.  Type Ç• followed by ßT in an expression 

window to get .

Backselecting Expressionist’s Keystroke Definitions dialog includes an option which 
selects the character or word preceding the cursor before the defined 
action is taken out.  The keystroke ÇH  backselects like this, which is 
useful for attaching a superscript to something you have already typed.

In an expression window type ßT then Ç•.  This results in:

That is not what we want, so access the Keystroke Definitions dialog.  
Type Ç• to look at our macro keystroke.  Click on the Backselects first 
checkbox.  Click OK.  Now, in a new expression window, you can type 

ßT Ç8 to get .

Reviewing         
Keystrokes

Choose Options➧Editing➧Keystroke Definitions….  Type ÇX and 
notice that it “does something else;” specifically, it Cuts.  Type ÇI and 
notice that it changes the font to the I font command (italics).  Type 
various keystrokes and examine their actions and you will find that 
keystrokes can do more than insert characters.

Reserved 
Keystrokes

You should not redefine ÅF, ÅE, ÅO, or ÅW, which correspond to 
Expressionist’s File, Edit, Options, and Windows menus.  Also, the 
keystrokes ¡ and ß¡ are reserved for Help.  If you redefine these 
keystrokes to perform various editing operations, the results could be 
unpredictable.  (For example, if you define ÅF to insert a fraction, 
Expressionist will get confused as to whether ÅF inserts a fraction or 
drops down the File menu.)

Unusable 
Keystrokes

Certain keystrokes can not be recognized by Expressionist and therefore 
can not be redefined.  For example, the Control key with any number key 
is not recognized at all.  When the Control key is used with Shift, it is as 
if you are not holding down Shift in many cases.  If you type a keystroke 
in the dialog, and nothing appears, or if the wrong keystroke appears, 
then you can not define an action for it.

T

T
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Quick 
Reference List

You can make your own quick reference list of all redefined keystrokes.  
This is especially handy if you have forgotten all of the neat keystrokes 
and their actions.

Choose Options➧Editing➧Keystroke Definitions….  Click on the Print 
Keystroke Assignments…  button to print a list of all keystrokes (except 
the basic keys unless they were redefined).  The list will likely require 
about a page and a half.

Note:  If you keep forgetting certain keystrokes, you might consider 
making palette buttons to accomplish their actions, since the palette’s 
visual clues are easier than remembering keystrokes.  If you frequently 
mistype keystrokes (such as typing ÇL and getting a subscript when you 
were expecting λ), you might consider forcing Expressionist to conform 
to your own habits (for instance, define ÇL to insert λ).



109

Using Expressionist’s Options

APPEARANCE 
ADJUSTMENTS

Expressionist has a variety of options that control the details of how 
certain composites are drawn.  These are collectively called 
Adjustments.

Thicknesses Let us say that you have decided that your Ph.D. thesis should be done in 
Bodoni, a serif font (like Times New Roman or Palatino), known for 
having heavy vertical strokes, almost as though it were bold.

Because Bodoni is the main font in your word processor, you set 
Expressionist’s Default Font to Bodoni.  As you start to produce your 
thesis, you notice that while the Bodoni characters all look consistent 
relative to each other, some of the composites that Expressionist draws 
are not consistent with the text.  In particular, the strokes of the square 
brackets fence composite do not look like those from Bodoni; their 
vertical strokes are not thick enough.

Choose Options➧Adjustments➧Fences… and adjust the pop-up menu 
setting labeled Thickness of Vertical Strokes from Normal to Thick.  
From that point on, all vertical strokes in square brackets, absolute 
values, and angle brackets will be thicker.  Even parentheses and braces 
will have thicker vertical parts, tapering off to points where appropriate.

There are many similar options to adjust the thickness of what 
Expressionist draws, for fences, marks, integrals, roots and fractions.  
The default settings were chosen to be satisfactory with most typical 
fonts, but you might want to adjust them, especially if you are using a 
font with atypical characteristics.  Usually optimal results come only 
with some experimentation.

Below are some examples of varying line thicknesses.

Thinnest Normal Thickest

Gaps In several instances, Expressionist composites are separated from their 
sub-expressions by a certain amount of white space.  This space is 
calculated for optimal results in most circumstances, but there are 
situations where you might want to adjust these for best results.

  a a
b ab a a

b

c   a a
b ab a a

b

c   a a
b a

b

a a
b

c
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For instance, the gap between a fraction bar and its numerator and 
denominator is controlled by a setting in the Fraction Adjustments 
dialog.  The gap between a mark and its contents is controlled by the line 
thickness setting in the Mark Adjustments dialog.  The Sub, Super, 
Summation Adjustments dialog controls not only the gap between the 
subscripts and superscripts from the base, but also the height of each.  
The Integral Adjustments dialog allows you to exclude the space 
between the integrand and the integral sign.

Below are some examples of varying spacing.

Tight Normal Loose

Other 
Adjustments

There are a wide variety of other settings available.  Each composite has 
its own idiosyncrasies, with adjustments to match.  Please refer to this 
manual’s Encyclopedia section and Appendix D for more information, or 
just explore the program’s options using Help.

Balanced Fences Some people like their fences balanced, so that, for instance, the dimple 
of curly braces always rests along the math axis.  Since this sometimes 
requires the addition of extra space, other people prefer for this to not be 
the case.  You can choose this by setting an option in the Fence 
Adjustments dialog.

Normal Balanced

Straight Strokes Curly braces, parentheses and integral signs are curved in nature, but 
sometimes, on lower resolution printers, the curves result in 
unacceptable aliasing (also known as the dreaded “jaggies”).  This can be 
minimized by activating the Straight Strokes option in the fence and 
integral adjustment dialogs.

Normal Straight

  a
b ab

c a
b

c   a
b ab

c a
b

c   a
b

a b

c
a

b

c

  a + 2
1 + b

c

  
a + 2

1 + b
c

  a
b
c

a
b

c   a
b
c

a
b
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Root Flange Square roots traditionally have a check mark on the left and a solid bar 
along the top.  Some writers, when drawing a square root by hand, 
include a small tab that hangs down from the right side of the top bar, as 
though to keep the contents from sliding out to the right.  With 
Expressionist, you can include such a flange in all root signs by turning 
on the appropriate option in the Root Adjustments dialog.

Normal Large flange

 ab  ab
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PICTURE OPTIONS

Rotating Let us say that you are making a graph in a graphing application and the 
vertical axis of the graph needs to be labeled with an equation.  You 
could just paste in a normal, upright equation from Expressionist, but it 
would look better if it were rotated 90°.

First, enter your equation.  Just before you want to copy it out, choose 
Options➧Copying➧Picture Rotation… and click on the radio button 
Rotate Counter-Clockwise (or click on the icon right next to it).  Then 
press ¥ or click on the Next Picture Only button.  Then, select the whole 
equation and do a Copy.  Expressionist rotates the equation as it is being 
copied, but you do not see any rotation on the screen until you Paste it 
into a document.

If you need to make several equations all rotated the same way, you could 
click on the button OK, Permanently  instead.  This causes 
Expressionist to rotate all equations cut or copied to the clipboard.  Do 
not forget to reset the rotation to normal later.

Adding Borders Although the designers of the fonts and the software that you use try their 
hardest to make everything work correctly, there are times when things 
just do not work out.  For instance, there are some situations where the 
ink that is drawn by an equation picture may extend slightly outside of 
the natural bounding box of the picture.  You will be able to tell that this 
is the case if printouts of your equations show these extensions clipped 
off, because some applications clip pictures at their boundaries.  Some 
Windows printer drivers simply will not print the character if it is even 
partially clipped.

Sometimes this is because of a fault in a font that you are using.  
Sometimes this is due to a bug in some piece of software.  Whatever the 
cause, you can correct for this with Expressionist.

Let us say that your word processor has a bug in it where, for some 
reason, it always clips off one pixel on the right side of every picture that 
it prints.  Choose Options➧Copying➧Picture Border… and you will be 
presented with a dialog with four boxes.  In the rightmost box, type in the 
number 1.  Click OK.  From that point on, all pictures that Expressionist 
generates will have one point (1/72 inch) of extra white space added on 
the right side, to compensate.
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INTRODUCTION

This chapter describes Expressionist’s Copy As Text facility, which 
allows you to copy Expressionist equations out as text (rather than 
pictures), for use with other applications.

Typically, typesetting systems create aesthetically pleasing equations, 
but lack a simple means of creating these expressions.  Expressionist 
permits you to build complicated equations in a WYSIWYG manner, 
then use Copy As Text to move the equations to a text-based system.

Copy As Text (herein also referred to as CAT) creates a textual 
description of a graphical equation.  This description may be used to 
create complex equations in traditional text-based typesetting systems 
(e.g., TEX, troff, etc.) or word processors which have proprietary equation 
markup languages, such as Lotus Ami Pro and WordPerfect.

Expressionist can translate WYSIWYG equations into various text 
formats, including several varieties of TEX, troff’s eqn, and PostScript.  
Each format requires a translation table, or CAT file, that describes the 
rules of the particular markup language.

In general, copying text out of Expressionist is done this way:

1.Choose the desired CAT Translation Table.

2.Make Expressionist Copy As Text (instead of Copy As Picture).

3.Select the expression to be copied.

4.Copy the selection to the clipboard.

5.Paste into the desired document (e.g., TEX document).

The specific steps are described in the following Quick CAT Tour.
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SUPPLIED TRANSLATION TABLES

Expressionist includes many different translation tables, known as CAT 
files, for use with various applications and markup languages.

If you modify a table, be sure to make a copy of the original CAT file.

Translation
Table Intended Use

AMIPRO.CAT For use with Lotus Ami Pro’s proprietary equation 
markup language

WP.CAT For use with WordPerfect’s proprietary equation 
markup language

EQN.CAT For use with eqn and troff systems

PS.CAT Produces PostScript descriptions of expressions, 
complete with EPS headers

TEXT.CAT For copying paragraphs of text and learning how the 
CAT system works

TEX.CAT For use with TEX systems

LATEX.CAT For use with the LATEX  macro package developed 

by Leslie Lamport

AMSTEX.CAT For use with the AMSTEX macro package, a special 

macro set from the American Mathematical Society
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QUICK CAT TOUR

Choosing a        
Translation 
Table

Choose Translation Table… from the Options➧Copying… submenu.  
A dialog appears with a list of translation tables.

Click on a translation table (e.g., TEX.CAT) in the scrolling list, then 
click OK.

Setting for Text 
Copying

Choose Copy As Text from the Options➧Copying… submenu.  This 
tells Expressionist to copy text instead of pictures when a Cut or Copy 
command is issued.

Copying Select the expression to be copied.  (Drag or use Select All.)

Cut or Copy.  Expressionist puts a text description of the selection in the 
clipboard.

Pasting Go to an application (e.g., a text editor or a word processor) and Paste the 
clipboard.  Examine the text exported by Expressionist.

%]|Expr|[#>`b___}))# b(<" *~: ;bP8&c55*V <c!$1^P} "!Symbol^:!&c0  .Z|

%|: &c55* /0 <c" #(&&c55)E :!&c0  /7: &c55* d&c55)l}^;&&c552O^P}}# b D 
b!( b!L!WW}]|[

$$V\ \left({P}\right)\ \rm \equiv \rm \mit \ -\ 
\int_{O}^{P}\bf E\ \rm \rm \cdot \rm \mit \ d\bf l$$

Your text will be different depending on your expression and the selected 
translation table.  It may look like random nonsense now, but as you will 
see, it all makes sense.



Copying As Text

117

MODIFYING A               
TRANSLATION TABLE

You can modify a translation table so that it outputs a different text 
description for one or more composite, string, or character.  The 
following pages take you through the various areas of a CAT translation 
table, making simple modifications as you go.

Instead of modifying the TEXT.CAT file directly, make a copy of it so 
you will modifying the copy.  Go to the DOS prompt and enter the 
command CD C:\EXPR\EXPRPREF.  Then, enter the command 
COPY TEXT.CAT MYTEXT.CAT.  When the copy is completed, 
return to Windows and start Expressionist.

From Expressionist, choose MYTEXT.CAT as the current Translation 
Table.  Next, make sure Expressionist is set to Copy as Text.  (You 
learned how to do these steps in the Quick CAT Tour.)

Expressionist’s Translation Browser is used to view and/or modify the 
current CAT output descriptions.  Choose Translation Browser… from 
the Options➧Copying… submenu.  

This is a browser which shows you the output text that Expressionist 
generates for each possible equation element.  Above, it is showing the 
output text for a fraction, “?a/?b”.  The “?a” represents the numerator and 
the “?b” is for the denominator.  The text output for  would be “1/2”.1

2
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Notice the three radio buttons on the left side.  The Composites button 
lets you browse the typical Expressionist structures, including fractions, 
fences, integrals, and the like.  The Characters button lets you browse 
individual characters, including pseudocharacters and font changes.  The 
Strings, etc. button lets you browse other output text.

The scrolling list to the right of the radio buttons lets you choose a more 
specific category, such as fence composites or pseudocharacters.  The 
scrolling list on the far right is for choosing a specific kind of element in 
the category, such as a long division composite or a script ell 
pseudocharacter.

The box at the bottom of the Translation Browser is for typing in the 
sequence of characters to be output for the item selected in the right scroll 
box.

Modifying            
Composites

In this example we will change the output text for a diagonal fraction 
composite.  Enter a diagonal fraction in an expression window:

Copy the fraction out of Expressionist, then Paste into your editor.

1/2 = one/half

Go back to the Translation Browser and choose Composites, Fractions, 
diagonal fraction.  Change the output string to ?a over ?b.  

Click OK, then select and copy out the same expression.  Go to your 
editor and paste to get:

1 over 2 = one over half
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Note that in the Translation Browser’s output string the numerator was 
indicated by ?a and the denominator was ?b.

In this example, we examine the behavior of a composite.

Make the expression:

Copy it and Paste it into your text editor.  You get:

(8)^(1 / (3))

Use the Browser to select Composites, Roots, root, and change the 
output string to (root ?b of ?a).

Click OK, then select and copy out the same expression.  Go to your 
editor and paste to get:

(root 3 of 8)

Next, go back to the expression window and delete the 3 from the 
expression.  Select and copy. Go to your editor and paste to get:

sqrt(8)

Because the exponent string of the root composite was empty, 
Expressionist used a different item from the translation table.  
Something similar occurs with subscripts and superscripts.

In this example, we are going to redefine the character “i”.  Select 
Characters, Normal Fonts, i from the Translation Browser.  Edit the 
output string, replacing i with the word confusion.
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Click OK, then create this expression:

Select it, copy it, and paste it into your editor.

quconfusionck fox

The “i” in the word “quick” was replaced with the new output string for 
“i” you put in the Browser.  This feature can lead to unexpected results, 
so use with caution.

A more likely and useful implementation of this technique is to modify 
the definition of a special symbol. For instance, you could change the • 
character in Symbol font to the equivalent TEX macro \infty.

Symbol and Other 
Fonts

If, instead of clicking on Normal Fonts, you click on Symbol Font, you 
will access the output text for all of the characters in the Symbol font.  
This is an entirely independent set which is used only when Symbol font 
characters are used in an expression.

If you have other special fonts, you can have Expressionist recognize 
them for special treatment also.  With the Characters radio button set, 
click on a blank entry below Symbol, click the Change Font button, and 
choose the special font.

If the font or style is changed inside an expression, these font changes 
may be defined in the translation table.
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Create the following expression (with the styles applied as shown):

Select it, copy it, and paste it into your editor.  The resulting text does not 
have any font styles (which is the nature of plain text):

brown fox jumps over

Go into the browser and select Characters, Font Changes, start bold.  
Edit the output text—which is nonexistent for this item—to <Bold ON>.

Edit the end bold item to <Bold OFF> and do likewise for the italic and 
underline font changes.  Click OK, then select and copy out the same 
expression.  Go to your editor and paste to get:

<Italic OFF>brown <Bold ON>fox<Bold OFF> <Italic 
ON>jumps<Italic OFF> <Underline ON>over

(The default font can affect the style changes.  For instance, this was 
made with italic default, it was all changed to plain, then styles were 
applied individually.)

There are many other kinds items that you can tinker with, most of which 
work like the examples in this chapter.  There are some exceptions and 
some special circumstances that you should be aware of.  You might 
have to experiment with these to see how they all work for your situation.

Many composites have alternative special cases.  For instance, integrals 
have many variations.  All marks are listed twice; once for above and 
once for below.
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Fences, because they have two independent sides that can be mixed and 
matched, each invoke two concentric entries.  If the output text for 
“parenthesis on left” were “(((?a”, and the text for “bracket on right” 
were “?a]]]”, the expression (5] would copy as “(((5]]]”.

Matrices, tensors, and trees work differently because they are variable-
sized.  Their output text comes in three or four pieces.  For matrices there 
is text to start a matrix (perhaps an opening bracket), text to separate 
columns (perhaps a comma or tab), text to separate rows (perhaps a 
semicolon or return), and text to end (perhaps a closing bracket).  For 
tensors and trees there is text to start, which takes the base as an 
argument, then there is text to be repeated once for each index or child, 
then text to end.

To make a special case for a word that is a function name, such as “log”, 
go to Characters, Font Changes, and choose Function Name.  The 
argument is the name itself.  Normally this is ?a, which has no effect.  
TEX, on the other hand, uses “\?a” which makes it so that “sin” comes 
out as “\sin”, which is a TEX convention.

Be careful when 
using this powerful 
item.

The most powerful output text item is under Strings, Global, Layout.  
This defines the entire expression string that you copy out.  Normally this 
is “?a”, to just pass through what you intended.  If you wanted to enclose 
all equations in dollar signs, you would change this to “$?a$”.  If you 
changed the output text to say “oxford”, with no ?a or anything, you 
would always get the result “oxford” regardless of your expression.  The 
Expressionist equation encoding can be included by adding ?b.  If this 
part of the copied text is pasted back into Expressionist, your equation 
will be recreated.  (Hiding this encoding in your destination text—
usually by commenting it out—is an issue you will have to deal with).  
The code ?c refers to the PostScript rendition of your equation, as if you 
had generated an EPS text file.

The encoding line break can be used to break up long lines in case your 
target system cannot deal with long lines of text.

Special 
Symbols

The Expressionist Copy As Text facility uses special codes to represent 
various elements of expressions.  You have probably already figured out 
that a question mark followed by the letter “a” is used for the first 
argument.  The codes used are as follows:

All codes start with a 
question mark.  To 
output a question 
mark, enter two 
together.

Code Purpose

?. new line
?, tab
?{ start font grouping
?} end font grouping
?a, ?b, ?c, ?d arguments of Expressionist macros/expressions
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INTRODUCTION

TEX is a special document typesetting language renowned for 
programmability and its high quality output.  TEX was designed by 
Donald Knuth of Stanford University during the late 1970s and early 
1980s.  It was designed for the highest typesetting quality, high 
functionality and programmability, consistency, reliability, and ease of 
use relative to contemporary systems. 

Although TEX is not WYSIWYG (what you see is what you get), TEX has 
a large following, especially since documents prepared on one computer 
system can be easily moved to other computer systems running TEX.  It 
is very popular in academic environments where mathematical 
typesetting is required, and where the structure of documents is complex 
enough to require programmability using macros.

Using Expressionist, you can create equations in a WYSIWYG manner 
for use with TEX programs.  This section describes how to do so.  If you 
installed Expressionist as described in the installation chapter and you 
read the section on Copying Text, you are ready to go.

Three TEX translation tables are supplied with Expressionist.  These 
CAT files in the EXPRPREF directory are:  AMSTEX.CAT, 
LATEX.CAT, and TEX.CAT.  The appropriate translation table should 
be used for the TEX you are using, i.e., TEX.CAT for standard TEX 
expressions, AMSTEX.CAT and LATEX.CAT for the AMSTEX  and 

LATEX macro packages respectively.

Each TEX  translation table exports equations in display style.  If you wish 
to change them to inline style, instructions to do so follow.  The text 
generated by Expressionist includes a comment that describes the 
encoding of the mathematical expression.  This can be removed as 
explained in a later example.

For more information on TEX, contact:  TEX Users Group, P.O. Box 869, 
Santa Barbara, California  93102.  Phone (805) 963-1338, fax 
(805) 963-8358, or e-mail tug@math.ams.org.

Prescience recommends the following references:

Donald Knuth, The TEXbook, Addison-Wesley, 1986

Leslie Lamport, LATEX, Addison-Wesley, 1986
Michael Spivak, The Joy of TEX, AMS, 1986

Jane Hahn, LATEX  for Everyone, Prentice-Hall, 1993



Working with TEX

125

TEX.CAT Notes Equations are set using the standard $$ to begin and end mathematical 
expressions.  The translator does not know when to use \big, \bigg, 
etc. for creating large delimters, e.g., parentheses, braces, etc.

AMSTEX.CAT 
Notes

Equations are set using the standard $$ to begin and end mathematical 
expressions in display style.  You must modify arrays to generate the 
correct alignment for items.  (See the example in the following LATEX 
notes.)

LATEX.CAT 
Notes

Equations are set using the standard \[ to begin and \] to end 
mathematical expressions.  You must modify arrays to generate the 
correct alignment for items inside the array.  The following example 
explains the necessary changes.

\[\left({\begin{array}{2c}\cos(\theta \rm )&1\\
1&\sin(\theta \rm )\end{array}}\right)\]

The {2c} following {array} must be changed to describe the 
preferred column alignment.  For example, if you want right-aligned 
columns, change the 2c to rr.  Currently, the TEX translator emits the 
number of columns and a c to specify the columnar alignment.

\[\left({\begin{array}{rr}\cos(\theta \rm )&1\\
1&\sin(\theta \rm )\end{array}}\right)\]

Function 
Macros

Special TEX macros for mathematical functions are included in the file 
FMACROS.TEX.  If you want to use some of the non-standard functions 
that Expressionist knows about, but TEX does not, copy this file into your 
TEX inputs directory.  These are special TEX macros for symbols and 
functions that are not defined in standard versions of TEX.  Examples 
include " and arc (for use in functions like “arc tan”).

Changing to 
Inline Equation 
Style

To change from display style to in-line style there are two choices:

• Edit the TEX code generated by Expressionist every time you 
need an inline equation.

• Modify the TEX  translation table once, then modify the TEX  
any time you need equations set in display style.

To modify the TEX translation table so that in-line expressions are 
generated instead of display equations, choose Translation Browser… 
from the Options➧Copying… submenu.  In the Translation Browser 

  cos(θ) 1
1 sin(θ)
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dialog, click the Strings, etc. radio button, then choose the Global 
category, then choose  layout from the right scroll box.

Change the output string from

 %?b?.$$?a$$?.
to

%?b?.$?a$?.

After making this change to your TEX  translation table, all copied 
expressions are ready for use as in-line equations.

Encoding When text is copied out of Expressionist, the default translation tables 
generate a TEX comment and TEX code that describes the expression.  The 
comment includes encoding necessary to paste the equation back into 
Expressionist.

Consider the following simple expression:

The TEX code generated by Expressionist for this expression is:

%]|Expr|[#>`b___})!# b$.<c" #(#" *~: ;bP8&c552x 
dx}__}}# b D b!( b!L!WW}]|[
$\int_{}^{}\mit x\ dx$

The percent sign is the comment delimiter.  The sequence of characters 
starting with ]|Expr|[ and ending with ]|[  is the special 
Expressionist encoding.  The remainder is TEX code.

  xdx



Working with TEX

127

Removing the 
Encoding

If you do not need to move TEX expressions back into Expressionist and 
do not want the Expressionist comment cluttering up your TEX 
document, you can remove the encoding by editing the translation table.

Choose Translation Table… from the Options➧Copying… submenu.  

In the Translation Browser dialog, click the Strings, etc. radio button, 

then choose the Global category, then choose  layout from the right 

scroll box.

Edit the output string, changing it from

%?b?.$$?a$$?.

to

$$?a$$?.

for display equations.  Or, for inline equations, change it from

%?b?.$?a$?.

to

$?a$?.

When the expression is copied out of Expressionist, the following text is 
in the clipboard:

$\int_{}^{}x\ dx$

Clearly, this is much shorter than the code originally generated.  Just 
remember you can not move this equation back to Expressionist to 
modify your equations if you make this change.

Translation     
Limitations

The TEX  translator can not capture all the control provided by TEX.  The 
following example illustrates this.

Consider the following equation,

and the TEX  code generated by Expressionist,

$$n/\log n$$

Use Expressionist’s tweaking features to move various characters 
around as shown below.

 n/log n

 
n
/ log n
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The TEX code generated is the same as shown previously because 
Expressionist’s TEX translators do not translate any tweaking within an 
equation.

$$n/\log n$$

If you are using Expressionist to tweak equations, please note that the 
TEX translators do not include this extra descriptive information in the 
resulting TEX code.

Acknowledg-
ments

We would like to thank Diane Heininger and Lance Carnes of Personal 
TEX, Inc. for supplying us with the most recent version of PC TEX and 
for their assistance in testing Expressionist.  For more information 
regarding the PC TEX software, contact:

Personal TEX, Inc.
12 Madrona Street
Mill Valley, CA  94941
phone (415) 388-8853
fax (415) 388-8865



Encyclopedia



130

Encyclopedia

INTRODUCTION

This chapter, the Encyclopedia, provides reference information in an 
easy-to-use form.  This format was chosen because it is the most 
straightforward way to classify arbitrary concepts that are related to other 
arbitrary concepts.  It is the closest thing you can get to the concept of 
“HyperText” in paper form.

To find any information that you need, convert it to an English word and 
look it up here.  For instance, to find out how to do a modulus, look up 
“Modulus.”

If you see a word in boldface you should look it up for more information.

All Expressionist menu commands are listed, as are all palette buttons, 
all composite types and many fonts.  There are listings for many special 
symbols, Greek  and other letters, and sundry mathematical concepts.  If 
you can convert it into words, look it up.

Keystrokes are described by listing the keys on the keyboard that you 
hold down simultaneously.  For instance, ÇV means to hold down the 
Control key and press V while Control is still down, then release both.  
(Do not use the Shift key unless expressly told to do so.)  The keystroke 
definitions used throughout this manual are defined in the default 
preferences file.  If you use a different file or change the keystroke 
options, some keystrokes may not work.

For a semi-guided tour of the Encyclopedia,  think of a topic that you 
don’t understand about Expressionist.  (“Clicking” is a good place to 
start.)  Look up that word and read its description.  From the boldface 
words in its description, choose the one or two that seem most interesting 
to you.  Look them up.  Repeat.  (This works best when there is actually 
something you need to know that gives you direction.)
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This is the Insert Index button.

About 
Expressionist... 
menu command

Choosing this menu command from the Help menu displays a window 
giving information about the current version of Expressionist, and other 
important information.

absolute value You can make absolute value in one of two ways.  You can use the 
vertical bar on the keyboard (ß/).  For larger things you can select them 

and click on , or type Ç¢.  See also fence.

addition You can represent addition by using the + symbol in almost any font.  If 
the Auto Spacing option is on, spaces surround it when you type it.

adjustment 
options

The Adjustments submenu of the Options menu has various items to 
change the characteristics of different kinds of equation structures, 
mostly composites.  For instance, the Roots… item brings up a dialog to 
change the way square and cube roots are drawn.

Adjustment settings are global to all expression windows in use.  Any 
changes are recorded in your preferences file and are remembered for the 
next session.  Adjustment settings are not recorded in the expressions 
themselves and will not find their way to another machine unless you 
move the preferences file.  For instance, if your default font is Bookman 
and your fixed height integral option is on, but a friend’s default font is 
Palatino and he has the fixed integral height option off,  then any 
expression you create will instantly change to Palatino with variable 
sized integrals the instant the expression is read or pasted into his version 
of Expressionist.

See also Fence Adjustments, Fraction Adjustments, Root 
Adjustments, Marks Adjustments, Sub/Super/Summation 
Adjustments, Matrix Adjustments, and Integral  Adjustments.

Adobe Type 
Manager

ATM is used with PostScript fonts to render sharp, accurate, good-
looking characters on the screen and PostScript printers.  This is 
especially useful with Expressionist, which doubles font sizes on the 
screen in Magnify mode.

afterscript Available as a change option from a sub-/superscript composite, which 
is used to make summations, as shown here.  To turn on and off the 
afterscript, select the whole structure and change.

See also change subscript/superscript, subscript/superscript 
composite.

 x
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aleph ℵ The first letter of the Hebrew alphabet.  Expressionist redefines the 
keystroke ÅÇßA to insert this character from the Symbol font.  Please 
note that this character sometimes appears upside down by mistake in 
certain texts; the way it is printed here and in Symbol font is correct.

all, for ∀ See For All.

all, select See Select All.

alpha α Α The Greek letter alpha is available on the palette and by typing the 
keystroke ÅÇA to insert this character from the Symbol font.  See 
Greek.

Alphabetics This option for the italic style is provided because punctuation and digits 
are not traditionally italicized in equations.

This style option, on the FontSizeStyle dialog’s Italic pop-up menu, 
specifies that the italic style should apply only to alphabetic characters 
between a-z and A-Z.

For example, if you select “a+1”, invoke the dialog, and make the Italic 
pop-up menu simply ON, all three characters will be italicized.  If you 
set the pop-up to Alphabetics, then only the “a” will be italicized.

See also Non Functions.

Alt key Å The Å key is a modifier key on your keyboard.  It functions like the ß key 
in that you hold it down while doing something else to modify the result.  
In general, Expressionist uses this key in conjuction with the Control 
key and other key to insert Greek letters, though there are some Alt 
keystrokes which perform other editing commands.

You can define Control keystrokes with the Keystroke Definitions 
dialog.

AMS American Mathematical Society

AMSTEX A TEX macro package from the AMS.  See also the Copying as Text and 
Working with TEX sections.

and ∧ This Symbol font character is available from the » pop-up palette.  Note 
the difference from the ^ caret (ß6 in normal fonts).

angle ∠ An angle symbol is on the palette’s – pop-up menu, and is available from 
the Symbol font.

angle brackets 〈 〉 You can make angle brackets in one of three ways.  You can use the less-
than< and greater-than > symbols (ß. and ß, in most fonts)but they are 
inferior to real angle brackets 〈 〉.  For these, use ÅÇßB and ÅÇßK (which 
insert Symbol font characters).  To enclose larger things you can select 
them and click on  for a set of polymorphic brackets which grow and 

shrink with their contents.  See also fence.
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application A program designed to accomplish a specific task or general tasks (e.g., 
equation editing, word processing).

approximately 
equal to

Some people use ≈, which is in the Symbol font and is available on the 
× pop-up palette.  Others use ≅, which is also in Symbol.  Still others use 
an equal sign with a dot over it  which is 8 in the Adobe Mathematical  
Pi  #6 font.  You can fake these with the ≅, and the equal sign with the 
dot over it macros, which use marks, overstrikes, and tweaking.  There 
are many variations of the “dot” form available in the Adobe 
Mathematical Pi fonts.

area
 

Use a fence or just type parentheses to represent the region.

array See matrix.

arrow ←↑↓→
To make an arrow over a character like a vector  see vector mark.  To 

make a single or double headed arrow as a symbol in its own right  
←↑↓→, there are a variety of symbols available.

Use Insert Something to insert a character from the Symbol font for ↔ 
← ↑ ↓ → ⇔ ⇐ ⇑ ⇒ ⇓, or use the ↔ pop-up menu.

The Wingdings font, a pictorial TrueType font available with Windows 
3.1, has many different styles of arrows, including ➔➢➲➯.

The Zapf Dingbats font, a pictorial PostScript font available with most 
laser printers, has many different styles of arrows, including three-
dimensional ones like this:  ➫➭➮➬.

The Adobe Mathematical Pi fonts contain a variety of arrows: 
.

See also Appendix A.

arrow keys ̃ ¯¿˘ The arrow keys on the keyboard move the insertion point around in the 
current expression in the directions shown on the keys.  You probably 
cannot rely on them entirely; use the mouse when the arrow keys do not 
seem to get you where you want to be.

If you hold down Shift, then the arrow keys will select as they move 
along, like dragging the mouse.  This can be useful for selecting 
subexpressions from the keyboard.

If you hold down Alt Å with the arrow keys, the subexpression that is 
selected will be tweaked by one point in the direction you requested.

ascender

 A R

F
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The part of a lower case character that extends above the x-height.  The 
letters b, d, f, h, k, l, and t have ascenders, and the other lower case letters 
do not.

ascent The height, above the baseline, of the upper case characters in a font.  
See also descent, math axis, and x-height.

astrological 
symbols

The Adobe Mathematical Pi #6 font contains some of these symbols, 
including Earth ⊕ and sun ¤.

Auto Spacing This item on the Options➧Editing submenu determines whether 
Expressionist automatically inserts spaces into your equations as you 
type.

Spaces are inserted where you would expect them, such as around 
operators.  If you find Expressionist inserts a space where you do not 
want one, you can delete it.  If you find Expressionist does not insert a 
space where you want one, you can add it.

When a check mark appears next to the menu item, it means Auto 
Spacing is on.  This option is on by default.

B palette button Issues the bold style font command.

Background This submenu of the Edit menu controls the background color of the 
frontmost expression window.  For instance, to make white-on-blue 
viewgraphs, set the background to Blue using this submenu, and then 
select the whole equation and click on the white color button (from the 
colors pop-up palette) to change the equation to white.

You should be careful with colors.  If an expression is made the same 
color as the background, the expression will be invisible.

Color embellishments are displayed only when Guide mode is off.

See also transparent background.

backspace key ø Erases the element to the left of the current selection, if the selection is 
a blinking caret (enclosing zero characters).  This includes divisions 
between strings in a composite, if appropriate.  However, if the selection 
is not blinking (i.e., it is highlighted), ø works just like ƒ and erases the 
selection.

See delete key to compare the function of these two keys.

bar To get a bar over a character or expression, see overbar.  To get a bar in 
the middle of a character, use the Overstrike and put the character in one 
place and a hyphen, or minus or dash, in the other place.  You will 
probably have to tweak it to get it to look right.  See also minus.

baseline

ascent

Age
descent

x-height
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baseline An imaginary horizontal line that most characters rest on.  Some 
characters have descenders that extend below the baseline, such as g, y, 
p and j.

becomes → ⇒ Use Insert Something to insert a character from the Symbol font, or use 
the ´ pop-up menu.  See also arrow.

beginner If you are a beginner at Expressionist, start reading at the beginning of 
this manual.  If you don’t have time, just start using the program and look 
up any topics you don’t understand in this Encyclopedia.

belongs to a set 
∈

Use Insert Something to insert a character from the Symbol font, or use 
the ∪ pop-up menu.  This set membership symbol is also available by 
typing E in Adobe Mathematical Pi #1  and #4 , or ßP in Math Pi #5 .

beta β Β The Greek letter beta is usually available only in full Greek fonts.  It is 
commonly used, so it is available in many different locations.  It is on the 
main palette, under the a pop-up palette, and available from the Insert 
Something dialog.  The keystroke ÅÇB was redefined to insert β from 
the Symbol font.

binomial 
coefficient

 

(As used in statistics) can be made by enclosing a matrix inside a 
parentheses fence composite.  Just make the parentheses, click the 

matrix palette button, and enter the numbers.

bold style To get bold style enhancement, select what you want bold, and click on 
B (as opposed to P, which removes it).  See also style and font 
commands.

bottom 
justification

In strings and matrices, where there may be several items grouped 
together with different heights, specifying this means to make sure that 
the bottoms of all items line up along the bottom of the available space.

Normal (math axis) justification Bottom justification

boundary of a 
set S

Type ÅÇß6 for the ∂ symbol.

box See frame or Guide mode.

bra’s As used in Quantum Mechanics, see bra-kets.

bra-kets 〈 〉 As used in Quantum Mechanics, to write state vectors and inner 
products.  To make simple fixed-size bra-kets, just type in the 
appropriate character (see angle brackets and absolute value).  For an 
example of this, see the “Quantum Mechanics” example in the Tutorial 
Equations section.

baseline

ascent

Age
descent

x-height

 5
3
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For rubber bra-kets that resize to conform to their contents, use the  

button (or type Ç£) and Change  as needed.  See also fence.

braces { } This term is a bit general.  Some use the term to refer to curly braces, but 
others use the term to apply to [square] or other brackets (see individual 
listings).  To make curly braces, just type them in, or use the  button 

for rubber braces.  (You can also type Ç™.)  See fence.

brackets [ ] This term is a bit general.  This manual uses the term to refer to [square 
brackets], but some people use the term to apply to curly or other 

brackets (see individual listings).  To make square brackets, use the  
button.  (You can also type Ç§.)  See fence.

bug A bug is a malfunction in a computer system.  Depending on the software 
publisher, bugs are also known as undocumented features, software 
anomalies, and beta residuals.

Many so-called bugs are simply misunderstandings about the software, 
which we call cockpit errors (aka pilot errors), not bugs.  Solutions are 
usually found in the manual.

If you think you have found a bug in Expressionist, report it to 
Prescience (using the form near the end of this manual) and we will 
attempt to reproduce it.  If it is a bug in our program, we will try to fix it 
and release an updated version as soon as possible.  If it is a bug in 
another program or the operating system, we will try to get the other 
software publisher to fix it.

built-up fraction See vertical fraction.

button A “button,” as this document uses the term, is either a button on a dialog, 
or is an icon button on the palette.

caret Another name for the cursor used for string selections.  Also sometimes 
refers to the “^” character (ß6 in most fonts).

CAT See Copy as Text.

CAT file Another term for a Translation Table.

ceiling  x + 0.5  To make a ceiling enclosure, either use the Symbol font characters  

and  or the composite button   (or type Çº).  See also change fence 
and floor.
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center 
justification

In strings and matrices, where there may be several items grouped 
together with different heights and widths, specifying this ensures that 
each of the items are centered either vertically or horizontally (depending 
upon context).

centi
c

This prefix means multiply by 10–2.

Change The Change command is a general-purpose command to change 
characteristics of a string, character, or composite.

To use Change, select one whole composite, or one single character, or 
one whole string.  If you have selected none or more than one, or only a 
partial one, Change will give you an error message.

For instance, if you select one composite in a string, you can do Change 
on that composite.  If you select all of the elements in a string, you can 
do Change on the string itself (changing things such as ruler status), 
because you have selected the whole string.

If you select more than one, but not all, of the elements in a string, it will 
not work because you have selected either more than one element, or a 
partial element (a part of the string), depending upon how you look at it.

After you select your one composite or character or string, click on  
or press ÇK or §.  A dialog allows you to change characteristics of the 
selected string, character or composite.

The exact form of the dialog depends upon what you are changing.  Some 
composites cannot be changed because they don’t have anything to 
change.  Try changing lots of different composites; many features of 
Expressionist are only accessible by using a more vanilla composite, and 
then Changing it to what you want.

See also Change Character, Change Fence, etc.
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Change 
Character

This dialog lets you change the font, choosing from a list of the available 
fonts; it lets you change the size relatively or absolutely; and it lets you 
change the style of the character, turning on or off each style 
independently.  For more information on the available styles, see 
individual listings in this encyclopedia for each check box.  See also 
FontSizeStyle box.

Change Fence  
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Type the various 
fence keys as 
shortcuts instead of 
clicking the radio 
buttons.

This dialog lets you change the fence symbol on each side independently.  
Use “nothing” for one-sided fences.  When you select the fence, be sure 
to select the whole fence including its contents; you can’t select just one 
side of the fence.  See also the “Antenna Example” in the Examples 
chapter.

If you click on Top & Bottom instead of Left & Right, you will get top 
& bottom fences .  If you use top & bottom fences, the left options 

in the dialog are for the top and the right options correspond to the 
bottom.

Change Fraction This dialog lets you change a fraction among diagonal, vertical, 

horizontal, and intermediate styles.

Change Frame

  a + b
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This dialog lets you change a frame.  You can select among several line 
thicknesses, choose whether it has a shadow, and choose which side the 
shadow is on.  The Quantize switches will quantize the height and width, 
so you can make many frames that appear together look like they line up.

Change Integral

This dialog lets you change the number of signs and determine what kind 
of signs are used.  It also allows you to make the limits above and below 
the integral sign as opposed to the default, which has the limits to the 
right.  Finally, click the “for In-Line equation” box if your equation is to 
be on the same line as text; the sign will be more compressed vertically.

Change Mark
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This dialog lets you change the kind of mark that you selected.  It also 
allows you to lower the mark if the one displayed is too high.  Vertical 
Squeeze usually lowers marks for you automatically for lower case 
characters, so if you use it you will probably want to keep this “normal.”

The fixed width checkbox causes the mark to retain a set width 
reagardless of what is underneath it.  If off, the mark stretches to fit its 
contents.  The default setting depends upon each kind of mark.

Fixed Width Not Fixed Width

Fixed Width Not Fixed Width

You have the choice of having the mark above or below its contents.  The 
inside options are usually only useful if Vertical Squeeze is off.  If an 
inside option is chosen, upper-case characters may collide with marks 
above them, and characters with descenders may collide with marks 
below.

You can fine-tune the location of a mark if necessary by using tweak:  
simply tweak the contents of the mark composite relative to the mark, 
then tweak the entire mark composite as a whole into place.

T T

 TOTAL  TOTAL
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Change Matrix

This dialog lets you change the number of rows and columns, and the 
vertical and horizontal justification.  You can click on the icons as well 
as the radio buttons, and can choose a matrix size by clicking on the large 
matrix, or by typing in numbers.  (It is also possible to add new rows and 
columns with New Line [press œ]and New Field [press Åß†], and to 
delete them by simply selecting them and pressing Delete.)

The Eliminate Overhang checkbox affects the sizing of the matrix 
slightly.  When off, the matrix will be sized as you would expect, with 
extra space on all sides of all elements.  When it is on, the unnecessary 
space on the top of the top row, the bottom of the bottom row, the left of 
the left row and the right of the right row is removed.

The Partition Lines button will get you to another dialog.  This dialog 
allows you to add and delete matrix partition lines for a matrix.  Simply 
click and drag in the spaces between the gray rectangles to add or delete 
partitions.  Each partition line separating two matrix elements can be 
present or absent independently, and each partition line can be either 
solid or dotted independently.  Only the first eight rows and columns can 
have partition lines.
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Change String

The most important setting in this dialog determines whether there is a 
ruler.  If not, all other controls are grayed out and inaccessible.  Most 
small strings in expressions have no ruler.  Such strings do not do 
automatic word wrapping.  The outer-most string, which encloses the 
whole equation, usually has a ruler.  See also lockstep ruler, 
independent ruler.

This dialog also lets you change vertical justification.  You will probably 
only want to change to “baseline” from the normal default of “math axis” 
when you are doing text on a line.

The horizontal justification of the selected string depends on its ruler 
settings, which must be viewed in Ruler mode.

Change 
Subscript/
Superscript
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This dialog lets you change a subscript/superscript composite.  This 
composite always has a base (represented in the drawing by the large U).  
In addition, there are four independent options that can be either absent 
or present.  The Subscript and Superscript are what you get when you ask 
for a subscript or superscript from the palette.  When you generate a 
summation, you get only the Underscript and Overscript, and the 
Afterscript turned on.  By clicking off Underscript and Overscript and 
clicking on Subscript and Superscript, you can change a summation to 
have limits to the left of the ∑ sign.  The Prescripts are useful if you are 
making something like . U92

235
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Change Tensor

This dialog lets you change the number of indices on a tensor, and 
whether each one is co-variant (lower) or contravariant (higher).  If you 
have fewer than eight indices, the latter check boxes can be set but will 
be ignored.

You can also add additional indices by using the New Field command.  
Indices can be removed with Delete, and they can be raised and lowered 
with the Raise  and Lower  commands.

Change the 
Font…

This radio button in the Palette Buttons or Keystroke Definitions brings 
up a dialog listing all of the possible font commands that you can 
program your button or keystroke to do.  To change a font command or 
to make new font commands, choose Font Commands from the 
Options menu.

The first entry in the list is always Choose Font from Dialog.  This 
choice will make the button or keystroke behave like the FontSizeStyle 
box.  When pressed, it will bring up a dialog allowing you to choose what 
font, size and style variation you want.  On the palette, it displays the 
current font, size and style of the selection.  If you program in more than 
one in a row on the palette, they will join together automatically into one 
large FontSizeStyle box just like the one on the default palettes provided 
with Expressionist.

The second entry in the list is always Default Font.  Such a button can 
be used to remove all font embellishments from the selection and return 
it to its natural font, size and style, which is the Default Font, modified 
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according to the size constraints of the given location (for instance, 
superscripts are smaller).

The third through the last entries always impose some font modification, 
such as switching to Symbol font or turning off Bold.  See Font 
Commands and FontSizeStyle box for more information.

Change Tree 
Node

This dialog lets you change the number of child nodes of a parent tree 
node, and change the branching.

You can also add additional children by using the Add Column 
command.  They can be removed with Delete.

If your tree is excessively wide, you can choose to put certain children in 
the mezzanine.  This will cause all children to be broken up into two 
levels: those in the mezzanine and those on the floor.  All children on the 
mezzanine form one level, all those on the floor form another level.  
Usually it is best to put the smaller children on the mezzanine and the 
larger children that branch out widely themselves on the floor where they 
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have room to branch out.  You can also move individual children up or 
down by choosing the Raise or Lower commands.

Another option lets you turn the tree sideways by checking the box. 
Horizontal (or sideways) trees are frequently more compact than vertical 
trees, especially when their children are long.

character A character is any symbol available in a font.  Letters, digits, punctuation 
marks and spaces are all characters.  For an introduction to this, see the 
Guided Tour  section in the Using Expressionist’s Features chapter 
and the Pressure equation in the Tutorial Equations chapter.

Most mathematical symbols are characters, too, unless they contain other 
strings.  Such things are called composites.

Characters have internal properties besides just which character they are.  
Each one has a font, a size and a style.  You can change the font, size or 
style by clicking on the icon buttons in the upper left corner of the 
expression window.  See also Change Character, character mapping, 
Pseudocharacters, Ellipses, and Thin Space.

character 
mapping

A correspondence between character codes in the computer and the 
graphic symbols that they draw.

For instance, a Q in Times New Roman font becomes a Q in Arial, but 
it turns into a Θ in Symbol font.  Times New Roman and Arial have the 
same character mapping; Symbol has a different mapping.

Most fonts, such as Times New Roman and Arial, have ANSI mapping 
or ISO mapping, which are almost identical.  Some fonts have OEM or 
some other ASCII-derived mapping.  They will match ANSI/ISO 
mapping only on the characters shown on U.S. keyboards.  Characters 
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such as ü, å, æ, and punctuation like ¿, “, ”, «, and » may changed to 
something else when the font is changed.

character size 
steps

The Size Steps… item on the OptionsºCharacters submenu brings up a 
dialog that allows you to control the set of sizes Expressionist uses when 
adjusting the sizes of expressions.  Specifically, it controls the sequence 
of sizes used by the + and – font commands, and also the sizes used when 
subscripts, superscripts, integral bounds, Σ characters, et cetera, are made 
larger or smaller in the process of equation drawing.

This is a feature for 
advanced users.  It 
will cause confusion 
for the uninitiated.

The sequence of sizes starts at the size of the Default Font and proceeds 
upward and downward from there.  Four steps is always a factor of two, 
except when the sizes get very small they are rounded to nearby integers.

The smallest size in the set is the minimum size.  Set it to the smallest 
legible size for the tiniest limits and subscripts of subscripts.  For laser 
printers, this should be 5 to 7 points; for dot matrix printers, 7 to 10 
points, and for typesetters, 4 to 5 points.  For most work, you should keep 
in mind your settings for subscript and superscript sizes; the approved 
scheme is for subscripts to be smaller, and subscripts of those to be 
smaller still, but to not get any smaller than that size.

The three numbers at the bottom determine the actual values for off-
default sizes.  If you are using outline fonts (TrueType or ATM), click on 
Make Logarithmic.  If you are using bitmapped screen fonts, enter the 
sizes of fonts that you have available (or double the sizes you have 
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available).  The size steps should be chosen in concert with the size 
settings in the Subscript/ Superscript/Summation adjustments and other 
such adjustments.

Traditionally in equation typesetting, superscripts and subscripts are 
reduced twice before reaching a minimum size and then they remain at 

this size.  For instance, in , the z is smaller than the y (which is 
smaller than the x), but a, b, and c are all the same size as z.  You do not 
have to be bound by this rule, but if you choose to be, make sure your 
minimum size is smaller than two steps below (or whatever the subscript/
superscript size step adjustment is set to) the default, but at least half of 
the default.

Example:  With the “factory” settings, the default size is 12 and the sizes 
leading up to it are 6, 7, 9, and 10.  Since superscripts are by default set 
to three steps smaller, the first level of superscripts will be 7 points and 
all levels beyond that will be 6 points.

Example:  All of your equations for a presentation will be displayed on a 
screen and you are worried that people will not be able to read 6 point 
type.  You set the minimum to 9 points.  This way, superscripts of 
superscripts will be 9 points, the same as superscripts.

Example:  In the same situation as the previous example, you want to 
take advantage of an 8 point font you have installed.  Change the 
minimum size to 8 points, which causes superscripts to be 9 points but 
superscripts of superscripts will be 8 points.

charge To represent charge on an ion in a chemical equation, use a superscript 
with a + or – in it.  See superscript.

chi χ Χ The Greek letter chi is usually available only in full Greek fonts.  Use the 
α and ∆ pop-up menus, or use the keystroke ÅÇC to insert χ from the 
Symbol font.  See also Greek.

circumflex To make a circumflex on a character, select the character and click on 
 (or press Çßº).  See also mark.  To make a circumflex all by itself, 

type ß6 in most fonts.

Clear command The clear command will delete whatever you have selected.  It is 
identical to the Clear menu command on the Edit menu.

Clicking In Expressionist, you can do many things by clicking the mouse, 
depending upon where you click it.

 xyza
bc

 
He

++
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On the palette window is a grid of small squares called icon buttons.  
Each one does something when you click on it.  See palette for more 
details.

By clicking and/or dragging on the expression itself, you can select 
single characters, or whole composites, including their contents, or any 
sequence of characters and composites in a string.  You can select a 
sequence of characters or composites from only one string at a time.  
Alternately, you can select portions of a matrix by dragging within one.  
See string selection and matrix selection for more details.

When you click down and drag, Expressionist will try to figure out what 
you are trying to select, and will show it by highlighting what you have 
selected.  If you start inside of a string that is inside of a composite, it will 
start by assuming that you want to select in that inner string.  If you 
subsequently drag outward, it will assume that you are interested in 
selecting over a larger string.

See also drag, double-click, shift-click, and tweak.

clipboard The “clipboard” is the place where data is stored (for text and/or pictures) 
when you Cut, Copy, or Paste.  Cutting or copying will transfer selected 
data to the clipboard; Pasting will transfer the clipboard data to your 
document or expression.

close box Double-clicking the close box on any window closes that window or 
makes it disappear.  Closing the last expression window exits 
Expressionist.

Close menu 
command

The Close command, on the application’s File menu, closes the window 
that is in front.  Double-clicking on its close box has the same effect.

Color Buttons These buttons on the palette set the current color of the selected 
subexpression to the given color.  For instance, to emphasize a piece of 
an equation in red, choose the red color button from the colors pop-up 
palette.  To make white-on-blue viewgraphs, set the background to 
Blue, and then select the whole equation and use the white color button 
to change it all to white.

Each button is a solid square showing the color to which it will turn the 
expression.  You can add your own color buttons to the palette by 
choosing Palette Buttons and Do Something Else.  The rainbow icon 
can be used to make a button for an unlisted color.  Note that not all 
colors available on your screen are available to make a button, as 
Expressionist ‘rounds off’ some colors to those it supports.

You can also assign color commands to keystrokes; see Keystroke 
Definitions.
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You should be careful with colors.  If any piece of the expression ends 
up being the same color as the background, that part of the expression 
will be invisible.  You can always turn on Guide mode to temporarily 
get rid of color embellishments so you can see what you are doing.

column vectors Column vectors are simply matrices with one column. See also matrix.

combinatorial See binomial coefficient. 

complex 
numbers

Complex number constants can be represented either in rectangular 
form, , or in polar form, r ∠ θ, using the angle symbol.  Use the 

italicized letter i (or j) for ; do not use ¡, which is an upside down 
exclamation point used in Spanish, ¡aye carumba!

composite An Expressionist composite (or composite structure) is an indivisible 
piece of an expression that may contain strings.  On the outside it behaves 
like a character, being enclosed inside a string.  On the inside, it, in turn, 
contains strings.  For an introduction to this, see the Guided Tour  
section in the Using Expressionist’s Features chapter of this manual.

The kinds of composites are:

Fences (parentheses, brackets) Overstrikes
Fractions Roots
Frame (box enclosure) Sub-/Superscript (summations)
Integrals (incl. evaluate at) Tensor
Long Division Tree Nodes
Marks (diacriticals)
Matrices

See also character and string.

congruent to ≅ Available on the × pop-up palette and by pressing ß2 in Symbol font.

conjugate ψ∗ There are many ways to represent conjugate.  One way is to use an 
asterisk, *, after the character.  In some fonts, such as Times New 
Roman, the asterisk is raised as though it was a superscript; in others it is 
not,  so you must do the superscript by hand.

contour integral See loop integral.

contravariant 
indices

See tensors.

Control key Ç The Ç key is a modifier key on your keyboard.  It functions like the ß key 
in that you hold it down while doing something else to modify the result.  

  a + ib

 – 1
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In general, Expressionist uses this key in conjuction with other keys to 
effect special editing commands which do most of the things that you see 
on the palette.

You can define Control keystrokes with the Keystroke Definitions 
dialog.

Copy command The Copy command copies the current selection to the clipboard, in 
either  graphical form or textual form.  You can subsequently Paste it 
into an expression, or into any place in the Windows environment that 
accepts text or pictures (such as a WordPerfect or PageMaker document). 
For an introduction to this, see the Guided Tour section in the Using 
Expressionist’s Features chapter.

An Expressionist picture includes a hidden encoding which represents 
its expression structure so that it can be retrieved and edited later.  For 
instance, if you inserted it in a WordPerfect document all you have to do 
is select, Copy, and Paste it back to Expressionist.

Text copied out of Expressionist frequently contains encoding, 
depending upon which copy-as-text table you use.  When you copy this 
text back to Expressionist the encoding is reconstructed into the 
expression.

The Copy command on the Edit menu does the same thing as the  

button, as does ÇC.

When used within Expressionist, this command can be done on multiple 
selections.  The contents of each selection will be extracted and each 
such result will be concatenated together into a string.

Copy as Picture This command on the Options➧Copying submenu sets copying to 
generate a picture.  The characteristics of the generated picture are 
determined by the neighboring commands Picture Format, Picture 
Rotation, and Picture Border.

Copy as Text This command on the Options➧Copying submenu sets copying to 
generate a textual representation of the equation.  The way the text is 
generated is determined by the current Copy as Text (CAT) Translation 
Table file.  You can choose between different translation tables with the 
Translation Table command.  You can modify an existing table by 
using the Translation Browser dialog.  Expressionist comes with CAT 
files for translating equations into TEX, PostScript, and other common 
formats.

Copying This submenu of the Options menu has several commands that affect the 
way data is copied out of Expressionist when you do a copy.  Some of 
the options also affect other kinds of graphics exporting, such as EPS 
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files.  Most important of all is the Copy as Picture and Copy as Text 
settings.  These determine what kind of data you get when you do a 
Copy.

If you set it to Copy as Picture, you will get a picture in the clipboard, 
the characteristics of which are determined by the set of options in the 
middle group (Picture Format, Picture Rotation, and Picture Border).

If you set it to Copy as Text, you will get text in the clipboard.  The way 
the text is generated is determined by the current Copy as Text (CAT) 
Translation Table file.  You can choose between different translation 
tables with the Translation Table command.  You can modify an 
existing table by using the Translation Browser dialog.  Expressionist 
comes with CAT files for translating equations into TEX, PostScript, and 
other common formats.

covariant indices See tensors.

cross † The cross symbol, †, is available in most fonts.  Typing the keystroke 
ÅÇß3 inserts this character in the default font.  It can be used in a 
superscript as any other character.

cross product × To make a cross product symbol, ×, do not use a lower case x, use the 
Symbol font character on the (surprise) × pop-up palette.  Some 
typesetters prefer this symbol in boldface if it is used as a vector cross 
product.

cube root
 To make a cube root, click on , type in the contents of the root, then 

† 3 Ÿ.  See also root.

curly brackets/ 
braces

See braces.

current 
expression

The current expression is the expression that is displayed in the front 
window (all of it, not just what is selected).

current selection The current selection is the subexpression that you have selected in the 
current expression.

cursive l (ell) l L See script ell.

cursor The cursor is the arrow that moves around the screen when you move the 
mouse.  Sometimes “cursor” refers to the caret, the blinking vertical bar 
which is the insertion point.

  B3
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Customer 
Support

See the page entitled Support near the end of this manual. 

Cut command The Cut command on the Edit menu effectively does a Copy and then a 
Clear, cutting the current selection into the clipboard as a picture for a 
subsequent Paste.  For an introduction to this, see the Guided Tour 
chapter in the Using Expressionist’s Features section.

The version on the Edit  menu does the same thing as the  button 
(except see the note in the description of Copy).

Cyrillic 
characters

Cyrillic characters are used in the Russian language.  Sometimes people 
write equations using them when they run out of Roman and Greek 
letters.  Cyrillic is not very common in America for obvious reasons.

Default Font This command on the Characters submenu of the Options menu brings 
up a dialog that allows you to change the default font using a dialog that 
is essentially identical to the FontSizeStyle dialog.  This dialog affects 
almost all of your expressions.

Normally, when you type new text into Expressionist, it picks up its font, 
size and style from neighboring text.  In some situations, however, this is 
inconclusive.  For instance, when you create a new expression window, 
or when there is no text at all in an expression window, there is no 
surrounding text.  In those cases, Expressionist chooses the default font.

More than that, however, the default font is a background font from 
which all other fonts in your expression are measured.  For instance, the 
size of each character is (usually) recorded as a number of steps larger or 
smaller than the default font.  You can change the predominant font, size 
or style of all expressions by simply changing the default font.

The default font affects new expressions, existing expressions pasted 
into new or existing windows, and many macros.

You should set the default font to the font, size and style that you are 
using for the body text of your document.  It is OK in this case to set the 
size to be absolute; the size for the default font is always absolute.  For 
professional results, you should additionally set Italic to “Non-
Functions” and turn Vertical Squeeze on.

If you change the body text font in your word processor, you should then 
change the default font in Expressionist so the equations are converted 
to the new default font when they are pasted back to Expressionist.  
Peripheral fonts in expressions, such as Greek letters in the Symbol font, 
are not adversely affected by the default font change.

defined as ≡ This Symbol font character is available directly from the palette.
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degrees ° This Symbol font character is available on the ∠ pop-up palette.

del ∇ This Symbol font character is available directly from the palette or by 
typing the keystroke ÅÇßZ.

Delete key ƒ Clears, or erases, the current selection.

If a range of anything is selected, it is deleted.  (Deleted matrix elements 
are changed to question marks, unless whole rows or columns are 
selected, in which case they are removed.)

If the selection is a blinking caret (enclosing zero characters), ƒ does not 
backspace and erase to the left—the ø key does this.

See backspace key to compare the function of these two keys.

delta δ ∆ The Greek letter delta is available directly from the palette or by typing 
the keystrokes ÅÇD for lower case d or ÅÇßD for upper case ∆, which 
insert characters from the Symbol font.  See also Greek and Alphabetic 
Only.

derivative There are many ways to represent a derivative; all of them can be done 
with Expressionist.  The prime (on the palette), as in z′, can be used 
immediately following a variable.  A fraction of differentials can be 
made,  (see differentials).  The operator Dx  is sometimes used; use 

a capital D and a subscript of x, in italics.  See also partial derivative.

descender The part of a character that extends below the baseline.  The lower case 
letters p, q, j, g and y all have descenders.

descent The distance that descenders reach below the baseline of a font.   See 
also ascenders, ascent, math axis, and x-height.

determinant To represent the determinant of a matrix, make a matrix, and then 

enclose it in an absolute value by  selecting it and clicking the  
button (or pressing Ç¢).

diagonal fraction To make a diagonal fraction, you can use the slash / character in most 

fonts, or you can use the diagonal fraction composite.  The  icon is 

available on the  pop-up palette.  The keystrokes Å/ and ÅD make a 

 dy
dx

baseline

ascent

Age
descent

x-height

 α β
−β α

 5 65 6
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diagonal fraction.  A normal fraction composite can be changed to a 
vertical fraction.

diamond Most fonts have a diamond character.  The Wingings font has a few 
diamond symbols t u.

differential dx  To make a differential, use a lower case d.  You should put the d in italics 
by convention, and the variable you are taking a differential of should be 
in its usual style, italic (x) if scalar or bold (x) if a vector.

a dimension of 
vector space

Just type it.  The dim function is not in the default functions file, so it will 
be italicized if the italic style is set to non-functions.  See also functions.

dimensions To change the dimensions of a Matrix, select the whole entire matrix and 
click on the Change button.  On the dialog is a large grid with the upper-
left corner highlighted (see change matrix for a picture of the dialog).  
Note that the number of cells highlighted is the same as the dimensions 
of your matrix.  Click on another cell to change the dimensions, or type 
in new numbers in the boxes below the grid.  The maximum size of a 
matrix is 127 by 127, but performance suffers past 16 by 16.

The commands New Line  (press œ) and New Field  (press Åß†) 
add rows and columns, respectively.  A matrix row or column can be 
removed by selecting it and pressing ƒ.

directional 
derivative

You can make a directional derivative,

just like a partial derivative.

distance 
between 
points    d (P, Q)

Just type it.  Use regular parentheses or the fence composite.

division To represent division, you should probably use a vertical fraction.

There are a variety of other division symbols, such as ÷. The Symbol 
font character ∏ is on the × pop-up palette.  To make a diagonal    
fraction, use the  button and change, which presents you with five 

  dimV

    ∂ f
∂u x0
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different flavors of fraction to suit your every need.  To make a simple 
textual fraction just use the slash /.

To get a long division structure click on the  button.

Do Something 
Else

You can define a keystroke or palette button to Do Something Else (other 
than insertion and font commands) from a list of editing commands.  
Each command is listed with its icon and a short description of its 
function.

Towards the bottom of the list are color commands for setting selected 
expressions to certain colors.  See color buttons.

dot 
You can make this notation by clicking on the  button (or typing Çß¡) 
and then typing in the character under the dot.  In-line dots ® • ⋅ are 
available in most fonts, including the Symbol font characters on the 
palette.  See mark and change mark.  See also pixel.

dot dot
 

You can make this notation by clicking the  button (or typing Çß™ ) 
and then typing in the character under the double dots.  See also mark 
and change mark.

dot dot dot
 

You can make this notation by clicking the  button (or typing Çß£) 
and then typing in the character under the triple dots.  See also mark and 
change mark.

dot product 

k

Click the • or ⋅ Symbol font characters on the palette.  See also dot.

double-click You can double-click on a string in an expression to select the whole 
string.  If you double-click in a matrix the whole matrix is selected.  
Double-clicking a word selects the whole word, like a word processor.

dragging By dragging the mouse over an expression, you can select single 
characters, whole composites, including their contents, or any sequence 
of such.  You can select a sequence of characters/composites from only 
one string at a time.  Alternatively, you can select sub-matrices of a 
matrix by dragging along it, as in a spreadsheet program.

When you click down and drag on an expression, Expressionist will try 
to figure out what you are trying to select, and will show it by 
highlighting what you have selected.  If you start inside of a string that is 

a

 ψ

a

 a b
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inside of a composite, it will start by assuming that you want to select in 
that inner  string.  If you subsequently drag outward, beyond the bounds 
of the string, it will assume that you are interested in selecting over a 
larger, more widespread string (or matrix).

See also double-click, shift-click, tweak, and clicking.

dyadic vector
 

A dyad is a double-headed arrow above a symbol.  It is available from 

the  pop-up palette or by using Change on an existing mark 
structure.  See mark and change mark.

e For the number e, the base of natural logarithms, equal to 2.718281…, 
simply use a lower case e, available in most fonts.  Make it italic.

The Edit Menu The Edit menu has the standard editing functions Undo, Cut, Copy, 
Paste, and Clear, along with other items specific to Expressionist.  
(Look up the items for more information.)

ell , + See script ell.

ellipsis … An ellipsis signifies a sequence that can be inferred given the first few 
instances.  For example:

 

There are several types of ellipses.  The most obvious is to type three 
periods in a row (...).  (Some fonts have a special single character as a 
shortcut to do this, “…”.)  Note, however, that those dots are at the 
baseline…, not along the math axis , as are the dots in the above 

example.  Each has its purpose.  The centered ones are more appropriate 
for situations where, for instance, you are continuing sums, where the + 
is the “glue” between items.  If, instead, commas are the glue, you should 
use the baseline ellipses.

Expressionist also has four custom ellipsis symbols, , used 

mostly in matrices and thus available under the  pop-up palette.

empty set The Symbol font character ∆ is on the » pop-up palette.  The character Ø 
in some fonts is not a null set symbol but a Scandanavian character.  See 
null set.

 F

  1+ 1
2

+ 1
3

+ 1
4

+
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To enlarge something, select it, and click on the + button, or Å0 (zero).  
If you do it four times, the size of your selection will double.  See  
character size steps.

Do not confuse this with the magnifying glass, , which simply 
magnifies the display so you can see it better, without actually changing 
the expression or the way it will print.

Enter key œ The œ key invokes the New Line command, which splits the current 
string you are typing into two strings piled on top of each other.  It is 
labelled ¥ on some keyboards.  See also matrix and paragraph.

epsilon ε Ε The Greek letter epsilon is usually available only in full Greek fonts.  The 
Symbol font character ε is available under the α pop-up palette, from the 
Insert Something dialog, and by typing ÅÇE.  See also Greek.

eqn A mathematical typesetting pre-processor for use with the troff 
typesetting system available on UNIX systems.  You can translate 
Expressionist equations into eqn format using the EQN.CAT translation 
table and the Copy As Text copying option.

equation As far as Expressionist is concerned, an equation is the same as an 
expression.  You do not have to make valid equations with the program.

equation number Create a centered tab stop with your word processor and paste your 
equation there.  Type in the equation number at the left margin, or set a 
right-justified tab stop and type the number.

Another method is to set tab stops with Expressionist’s ruler and type 
the number in Expressionist itself.

See the section Numbering Equations in the Working with 
Expressionist chapter.

equivalent ≡ This Symbol font character is available on the × pop-up palette.

Escape key Ÿ Escape moves the selection out a level within a composite or out of the 
composite entirely.  It is most effectively used in conjunction with the 
Tab key.  See Select Out.

eta η Η The Greek letter eta is usually available only in full Greek fonts.  The 
keystroke ÅÇH inserts the Symbol font character h, which is also on the 
α pop-up palette.
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evaluate at Click on the  button (on the  pop-up palette) or make an integral 

and use the Change Integral dialog.  The  and  forms are 

available as macros.

examples See the Tutorial Equations chapter of the manual.

exists, there ∃ See there exists.

exponent 
Use a superscript.

expression An expression is an arrangement of symbols that can be manipulated by 
Expressionist that looks like an expression from mathematics or a 
related field.  It consists of characters and composites that are all 
arranged into strings.

expression file An expression file is a file that contains an Expressionist expression.  
See file.

expression 
window

An expression window is a window in which you edit an expression.  It 
can be saved as an expression file.

factorial n! To get a factorial, simply suffix whatever you have with an exclamation 
point.

femto f This prefix means multiply by 10–15.

Fence A fence is an enclosure, such as parentheses, brackets, or absolute value.  
Expressionist supplies ten different fence composites and you can even 
mix and match fences.  In addition, you can even have fences applied on 
the top and bottom instead of left and right.

There are many fence palette buttons.  (There are also keystrokes to make 
many of them.)  To make the other kinds, create a fence with any of the 
buttons, select it, and change.  (Make sure you select the whole fence 
composite; you cannot select just one side.)

By selecting what is inside and clicking on  (the unmark button), 

you can remove the fence from its contents.

Fence 
Adjustments

This command on the Options➧Adjustments submenu brings up a 
dialog that allows you to change fence drawing parameters.  With it, you 

   f(x)
x− 1 x= 0  x y

z
 x y
z

 ex
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can change the thickness of parenthesis and bracket strokes, and the way 
some of these composites are proportioned.

Two pop-up menus determine the thickness of vertical and of horizontal 
strokes.  The “normal” settings have been chosen to be best with most 
fonts.  You should choose fence stroke thicknesses that looks right for the 
default font you are using.  The horizontal and vertical thicknesses 
should be the same as the horizontal and vertical strokes of letters.  You 
might want to experiment by making an extra-large equation with some 
letters in your default font.  Expressionist draws the strokes with widths 
proportional to your character sizes so everything will stay in proportion 
if you enlarge or shrink your expression.

Notice that for most serif fonts the stroke width is much thicker for 
vertical strokes than for horizontal strokes; this is taken into account 
automatically.  You may want to adjust for this if you are using sans-
serif fonts.

The Balance Fences option determines what happens if the contents of 
a fence is top-heavy or bottom-heavy.  Turning the option on ensures that 
the middle of the fence runs along the math axis.

off on

The Quantize Fence Sizes option causes fence sizes to round off to even 
increments.  It is provided for compatibility with version 2.  For the most 
part, the same goals can be achieved with Magic Alignment.

  a + 2
1 + b

c

  
a + 2

1 + b
c
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The Draw with Straight Strokes option causes parentheses and curly 
braces fences to be drawn with straight segments for part of their length.  
The overall proportions of the composite are not changed except for this 
change.

Fence Overhang enlarges the height of fences slightly so that they extend 
beyond the top and bottom of their contents.   The most noticeable effect 
of this is when you have many fences nested deeply

An expression file can be saved with the Expressionist application.  

       

Expression files can be opened and used by Expressionist, but other 
programs cannot recognize expression files.  To import an equation file 
into another application, Save As EPS or Save As Metafile.

File menu The File  menu in the Expressionist application has the usual items for 
opening and closing Expression files, plus commands to create new 
expression windows and print expressions.  Look up the individual items 
on the menu for more information.

Find & Replace This item in the Windows menu brings up the Find & Replace window.  
You can enter any expression in the Find and Replace fields; they are like 
miniature expression windows—you can use Guide mode, different 
fonts, composites, etc.  The Find & Replace window may be resized to 
show more of the fields.

The Find & Replace facility works on the last active expression 
window.

When you click the Find button, Expressionist searches for the 
expression specified in the Find field.  It selects the first occurrence, or 
beep if the search expression is not found.  Clicking Find again selects 
the next occurrence, until their are no more occurrences, in which case 
Expressionist beeps and starts over.

When you click the Find All button, Expressionist searches for the 
expression specified in the Find field.  It attempts to select all 
occurrences, or beep if the search expression is not found.  (Note that 

 straight
strokes

off

 straight
strokes

on

 
Most  None
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since you can not have more than one selection in the same string, you 
may not get all the selections you are expecting.)

When you click the Rep, Find button, Expressionist replaces the found 
selection with the expression in the Replace field, then does another 
Find.  (Note that since you can not have more than one selection in the 
same string, you may not get all the selections you are expecting.  In this 
case, just use Rep, Find repeatedly.)

When you click the Rep All button, Expressionist does a Find All and 
replaces all found expressions with the expression in the Replace field.

floor  x + 0.5  To make a floor enclosure, either use the Symbol font characters  and 

 or the composite button .  See also change fence and ceiling.

font A font is a collection of character images used to print or display text.  
You may change the font of the text you are printing, and change the 
style and size of your text independently of the font.

Font families are identified by their names.  Some common ones are 
Arial, Helv, and Times New Roman.  The Symbol font contains Greek 
letters and mathematical symbols (and Expressionist expects it to be 
present).

The Adobe Mathematical Pi font set includes numerous mathematical 
symbols in place of normal characters.

See also the individual font names, and Adobe Type Manager and 
TrueType.

Font Commands This command on the Options menu brings up a dialog that allows you 
to add new font commands and change or delete existing font commands.
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Each font command can subsequently be assigned to a palette button or 
keystroke by choosing Palette Buttons or Keystroke Definitions. In 
addition, these font commands appear in the Insert Something dialog, 
to be applied to characters that are to be inserted into your expression.

For instance, the Ω button on the palette is a font command button that 
changes the font to Symbol font, but leaves the size and style unchanged.  
The – button is a font command that reduces the size of the selected text 
by one step, but leaves everything else unchanged.  The P button 
forcefully turns off bold, italic, underline, and all other style variations.

You should define font commands for fonts and styles that you use 
commonly.  For instance, if you use the German letters in 
Mathematical Pi 2, you will want a font command set to that font, so 
that you can make a palette button with that font, and also so you can 
make palette buttons or keystrokes to insert German letters.

Use the scroll box to select which font command to work on.  You can 
then double-click on the font name, or click on Modify this Font 
Command to bring up a FontSizeStyle dialog that allows you to change 
the definition of this font command.

The button Delete this Font Command simply takes the currently 
selected font command and sets it all to “keep the same” and sets the logo 
character to a space.  The button New Font Command… finds a unused 
font command and brings up the FontSizeStyle dialog for you to define 
it, as though you had selected an empty font command and chosen 
Modify this Font Command.

Be careful if you delete and reassign font commands.  Since this is really 
just like modifying them, any existing keystrokes or palette buttons 
which used the old font command will use the new or modified font 
command.



Encyclopedia

165

The logo character is the character that is displayed on the palette if you 
make such a button; the character is displayed under the influence of that 
font, of course.  You should choose the character to remind you of that 
font.

The Reverts to Default check box determines whether the font is sticky 
or slippery.  Usually, when you type, the font of the character that you 
insert is taken from the character before it, just like in a normal word 
processor.  If you click on a font command that has this option off, the 
font command’s influence will continue as long as you type, because 
upon each keystroke, the character before had that font variation.  If it is 
on, however, the font command’s influence will end after one keystroke.  
The effect also works if you click down right after an existing character 
in a special font, and then start typing.  If the font is set to Reverts to 
Default, you will not pick up that font and start typing in it, as would 
normally happen.  Reverts to Default is useful for fonts, such as 
Symbol, which are usually used for isolated individual characters only.

There are fifteen font commands available with Expressionist..  In 
addition, the default font can be changed like any other font command.  
(It is always the first font command on the list.)

FontSizeStyle 
box

The FontSizeStyle box displays your current font, size, and style.  For 

instance, it looks like this:   when you are 

using Times New Roman 12, plain.  But, if you were using Palatino 28 

point Bold Underline, it would look like this:  .  

The “bu” at the end shows the style:  b=boldface, i=italic (non-
functions), I=italic, u=underline, v=vertical squeeze.  Note also that the 
font name is displayed in the appropriate family and with appropriate 
style(s), except for non Roman fonts such as Symbol and Wingdings, 
which are displayed in Arial.

If your selection encompasses more than one font family or more than 
one size (beyond the normal variations for subscripts, etc.) then the font 
family or size is not shown.

Clicking on the FontSizeStyle box (or pressing ÇD) brings up the  
FontSizeStyle dialog.

FontSizeStyle 
dialog

The FontSizeStyle dialog is used to change the font, size and/or style of 
characters.  With it, you can completely specify the font of a character.  
In addition, you can also specify which characteristics to leave 
unchanged or to change relatively.

 Times NewRoman12

 Palatino 28 bu
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You can arrive at the FontSizeStyle dialog in a variety of ways.  The 
most common is to click on the FontSizeStyle box in the top left corner 
of the palette.  In addition, several commands on the Options menu use 
this dialog.

The three main parts of the dialog change the font family, the font size, 
and the font style variations.

In the upper left third of the dialog, there is a listbox with all font    
families available on your system listed to choose from.  In addition, 
there is a checkbox underneath named ‘keep same family’.  To keep the 
family the same, check this box, otherwise, choose one of the font 
families listed.

Along the bottom of the dialog is a box where you can direct the 
changing of the font’s size.  The most common choices are to change the 
size a number of steps larger or smaller.  (Four steps is a factor of two.)  
In addition, you can choose to set the size to an absolute point size.  Note, 
however, that if you do set the size to an absolute size, that all characters 
selected will assume that size, regardless of whether they should be 
smaller or larger (such as superscripts or summation signs).  Also, the 
size will at that point become independent of the default size, which may 
be undesirable.  For the most part, you should stick to changing font sizes 
by a number of steps.

In the upper right corner are several popup menus for changing style 
variations.  The four variations are bold, italic, underline and vertical 
squeeze.  Each has a choice for turning the style on, turning it off, or 
leaving it the same.  In addition, the italic popup has additional choices, 
Alphabetics and Non-Functions.  Alphabetics will make a distinction 
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between alphabetic characters (a-z and A-Z) versus other characters; 
only alphabetical characters will be italicized while nonalphabetics will 
remain unitalicized (but may be boldfaced or have other variations).  
Non-Functions goes further: only alphabetics that do not form words that 
are function names in the current functions list are italicized.  This is so 
that expressions such as sin(x) don’t come out looking like sin(x).

for all ∀ Use the character in the Symbol font, which is on the ∀ pop-up palette.

fraction
Use a vertical fraction  or change it to a diagonal fraction, or just 

use a slash character.  See also division.

Fraction 
Adjustments

This command on the Options➧Adjustments submenu brings up a 
dialog that allows you to change fraction drawing parameters.

With it, you can change the thickness of vertical fraction bars and the 
gap between fraction bars and the numerator and denominator.  Also, you 
can change the relative size of diagonal fraction subexpressions.

The sizes shown to the right of the two popup menus gives the 
approximate thickness and gap size for normal fractions done in the 
Default Font.  Fractions where the size is other than that of the default 
font, such as fractions in superscripts or fractions whose sizes have been 
modified by font commands, will be different but will be in proportion to 
the ambient font size.
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You should choose a fraction thickness that looks right for the default 
font you are using.  The bar thickness should be the same as the 
horizontal strokes of letters, or the thickness of – and + signs.

frame
 

You can enclose a frame, or box, around your expression or a portion of 
your expression by selecting it and clicking the frame  button.  See 

change frame.

French brackets See braces.

functions There are different ways of representing functions in mathematics.  
Standard functions such as sine, cosine, logarithm, etc. are usually 
written without parentheses (unless the argument is complicated), as in 
sin x.

Arbitrary functions are usually written with parentheses, as in f(x), 
because fx just does not get the message across.  In all cases, just type in 
text as you normally would.  If the argument is large and complicated, 
you can use brackets or parentheses around it.  Never italicize the 
names of standard functions such as sin and cos; otherwise use standard 
rules as though the function name was a variable.

Expressionist has an italic style option, Non-Functions, which avoids 
italicizing functions named in the functions list.

Functions List The functions list is the set of function names that Expressionist 
recognizes when your italic setting is set to Non-Functions.  The default 
functions list includes common function names such as sin, log and exp, 
and also more esoteric functions such as Si and Ei.

The functions list is also used in other circumstances, such as with Copy 
as Text.

In the EXPRPREF subdirectory in the EXPR directory, there is a file 
named FUNCTION.NAM which contains a list of all of the function 
names in use by Expressionist.  You can open this file with your word 
processor and add function names.  Save it as a text file in the appropriate 
subdirectory.  When you later open Expressionist, it recognizes the new 
function names as ones to avoid italicizing.

  
H = E
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Function Names Recognized by Expressionist’s Default Functions file

gamma γ Γ This Greek letter is usually available only in full Greek fonts.  Lower 
case γ is on the main palette and the a pop-up palette.  Upper case Γ is on 
the ∆ pop-up palette.  The keystrokes ÅÇG and ÅÇßG insert gammas 
from the Symbol font.

German letters German letters are very fancy, old-English-like letters used when 
equation writers run out of the usual Roman and Greek letters.  Many 
newspapers use them for their titles.  Adobe Mathematical Pi #2 
includes some, such as abcdeABCDE.

giga Γ This prefix means multiply by 109.

Gothic font A Gothic font usually means a sans serif font.  Sometimes it refers to an 
old English style font, similar to German.

gradient ∇ The gradient symbol ∇ is available by typing ÅÇßZ, which inserts the 
Symbol font character.  Some people use a bold ∇, which you make by 
just adding the bold style.  The Adobe Mathematical Pi #4 font has a 
boldface .

greater than > To make a greater than symbol, simply use ß. in any normal font.

adj arccos arccosh arccot arccoth arccsc

arccsch arcsec arcsech arcsin arcsinh arctan

arctanh arg bei ber Ci CONF

cos cosh cot coth csc csch

curl def deg det diag dim

div Ei erf erfc even exp

gcd grad hom Im inf kei

ker lcm lg Li lim liminf

limsup ln log lq lub max

min mod modulo odd Pr Re

Res sec sech sgn Si sign

sin sinh span sqr sqrt sub

sup tan tanh trace
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greater than or 
equal to 

The symbol font character is on the × pop-up palette of operators.

Greek letters are used a lot in mathematics, especially because people 
quickly run out of Roman letters for symbols and variables. 

You can insert a Greek letter into your equation by clicking on the 
desired letter displayed on the palette. The α pop-up palette contains 
lower case Greek letters and the ∆ pop-up palette contains upper case 
Greek letters (except for those which look just like Roman letters).

Many Greek letters can be entered by holding the Å and Ç keys and 
typing the Roman letter which corresponds to the desired Greek letter.  
For instance, ÅÇL inserts λ and ÅÇßL inserts Λ.

Another way of entering Greek letters in your expressions is to switch to 
Symbol font and then type the Roman letter which corresponds to the 
desired Greek letter.

The Insert Something dialog, with the Symbol font command and the 
Insert Character button, is yet another way of entering Greek letters.

Guide mode The guide mode button toggles guide mode.  When it is on, your current 
expression is displayed with rectangles outlining all of the strings and 
matrix cells.  (Some other composites are changed to make them easy to 
edit, too.)  Normally this is on.

off: on:

Use this mode when you are having trouble selecting what you are trying 
to select with the mouse, or if you do not understand the structure of an 
expression that you see displayed.

Since it distorts your expression to make room for the dotted lines, click 
it again to turn it off to see how your expression really looks.

hat See circumflex.

Hebrew Hebrew letters are yet another character set that mathematicians resort to 
when they run out of Greek and Roman letters.  The letter Aleph, ℵ, is 
available in Symbol font, but for a full treatment of Hebrew, you should 
consider getting a true Hebrew font.
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Help Choose Index from the Help menu or press the ¡ key to invoke the 
Expressionist help system.

Press ß¡ to invoke context-sensitive help, then click on an area of interest.

The Expressionist help system works like the help systems used by most 
other Windows application software.

Helvetica Helvetica font is one of the original PostScript fonts.  It is a sans serif font 
that looks like this.  See also sans serif fonts.

Helvetica was designed in 1957 by Max Miedinger for the Haas type 
foundry at Basel, Switzerland.  Its name comes from Helvetia, the Latin 
name for Switzerland.  Imitations come under names such as Arial, Helv, 
Swiss, and Geneva.

hyphen - This is what you usually get when you type - from the keyboard.  It is not 
a minus sign.  However, the - key was redefined to insert a minus sign 
from the Symbol font.

I palette button Issues the italic style font command.

icon, button D  
  

This refers to one of the squares on the palette.  You click on these to 
perform commands in the window.

icon, application T\he Expressionist application icon identifies the executable file in the 
Windows Program Manager.  Double-click the icon to open the 
application.

imaginary Im z The imaginary operator, Im, is best written as just that:  two letters, Im.  
Do not make them italic.  Some people use ℑ, a Symbol font character 
available on the ∠ pop-up palette.

infinity ∞ This Symbol font character is available directly on the palette or by 
typing ÅÇß5.

Independent 
Ruler

A ruler that is independent of enclosing rulers, as opposed to a lockstep 
ruler.  Independent rulers always display in ruler mode and they never 
inherit characteristics of an enclosing ruler.

Insert Character A button on the Insert Something dialog inserts the selected character 
from a list of all characters available from a chosen font.  Double-
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clicking on the desired character also inserts the character into the current 
expression.

When you choose a character, you must select not only the character 
itself, but also the font command for the character.  To choose the font, 
use the listbox on the upper right side of the dialog.  It lists all available 
font commands, including Default Font, and a special entry, Current.

Choose Current to insert the character in the same font as the 
surrounding text.  Choose Default Font to insert the character with in the 
default font/size/style combination, even if the surrounding text differs in 
size and/or has some font embellishment.  Choose one of the other font 
commands to insert the character with that font command applied to it.

You should choose Current unless you need a character in a special font 
such as Symbol.  This is especially important if you are defining 
keystrokes or palette buttons.  Anything other than Current means that 
the font command chosen will be invoked whenever you subsequently 
use the keystroke.  For instance, if you program ˙ to insert a space with 
boldface on, then boldface turns on every time you press ˙.  If you 
program it with Default, then it turns off any non-default font settings 
which may be in effect.  (This does not happen if the font command 
Reverts to Default, as does the Symbol font command.)

The array of characters shows all 256 characters in the font family of the 
given font command.  Some of these characters may not be valid for that 
font, in which case they may be displayed as a hollow rectangle or as just 
a space.  (Do not use these; they may print differently in different 
circumstances!)

For instance, to choose a character in Symbol font, scroll to the entry “ω 
Symbol”, and then click on it.  The array of characters will be redrawn, 
now showing all 256 characters available in Symbol font.

To insert a space character, choose the character directly above the digit 
“0”.  To insert a Tab character, choose the character three rows above the 
digit “9”, on the top row.

Insert Composite A button on the Insert Something dialog inserts the selected composite 
from a list of all available composites.

To insert a composite, select one from the array of icons in the middle, 
and click the This Composite button.  Alternatively, you can double 
click on the macro to insert it quickly.

Notice that near the bottom of the composite list are the 
pseudocharacters:  thin space, ellipses, Planck’s constant, and script ell.  
Since they are not really characters in any particular font, they have been 
grouped with the composites.
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Insert Index 
Inserts indices into a matrix.  First, it brings up a dialog allowing you to 
select exactly what you want inserted.

The most common settings are Row Index or Column Index.  The 
others are combinations of these two.  First, select the matrix and do a 
Select In.  Type what you want into each component.  When it comes 
time to do an index, click on the  button, which is on the  pop-

up palette.

You can not use this command unless the selection is within a matrix.

Insert Macro A button on the Insert Something dialog inserts the selected macro from 
a list of all available macros.

To insert a macro, select one from the scrolling list box on the left side 
and click on the This Macro button.  Alternatively, you can double 
click on the macro to insert it quickly.

See Macro Definitions.

Insert Something This dialog allows you to choose a character, composite or macro to be 
inserted into your expression.

You can get to this dialog in three ways:  from the Insert Something 
command on the Edit menu, or from the Insert Something radio button 
in the Palette Buttons or Keystroke Definitions dialog.  In the first case, 
you are causing something to be inserted immediately.  In the other cases, 
you are choosing something to be inserted when you later click on the 
palette button or when you later type the given keystroke at the keyboard.



174

Encyclopedia

There are three main sections to this dialog, for macros, for composites 
and for characters.  See Insert Character, Insert Composite, and    
Insert Macro.  For pseudocharacters such as ellipses and h-bar, see 
Insert Composite.

Installation See the Getting Started section at the beginning of this manual.

integral i 
Use   , , , or  to insert an integral.  Use  to change 
various aspects of the integral (see change integral).  See also loop 
integral and multiple integrals. 

Integral Elements

You can choose how integrals are drawn by setting integral 
adjustments options from the application.

Integral 
Adjustments

This command on the Options➧Adjustments submenu brings up a 
dialog that allows you to change integral drawing parameters.  With it, 
you can change the size and thickness of integral signs and also change 
some general proportions of the composite.

The first setting controls how much smaller in size the integral limits 
should be.  Two to four steps smaller is usually sufficient.

   e– x dx
0

∞

integrand

upper limit

lower limit

 
a

b

c
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The second setting controls how thick the integral sign should be.  The 
normal setting is usually good but you may want to change it depending 
upon your default font and other circumstances.

The third setting controls the default height of integral signs.  The check 
box below that, if on, will make integral signs fixed height.  Normally, 
integral signs expand to fit their contents, but there is a default minimum 
height in case of small integrands.  The popup menu controls this height, 
which is always proportional to the ambient font size.  If the check box 
is on, the integral sign is always exactly this height, mimicking 
traditional typesetting methods where integral signs are printed with 
fixed-sized symbols.

Quantize Integral Heights will round off the integral size to fixed 
increments, which makes similarly-sized integrals the same size.  For the 
most part you can achieve better results with Magic Alignment.

Draw with Straight Strokes is similar to the option of the same name for 
fence adjustments.

The Integrals Have No Interspace will remove the excess space between 
the integral sign and the integrand.

Intersection ∩ This Symbol font character is available on the » pop-up palette.

inverse In mathematics, there are many things that can have an inverse, in many 
ways.  To make the inverse of an operator, frequently it is given a 

superscript of –1, as in D–1.  Use  for superscript.  The ¬ character 
is available in most fonts, including the Symbol font version on the ∀ 
pop-up palette.

iota ι Ι This Greek letter is usually available only in full Greek fonts.  Lower 
case ι from the Symbol font is on the α pop-up palette.

is  <x> For any thing that you are looking for in this Encyclopedia that has a 
name of the form “is <x>,” see <x>.  For example, instead of “is greater 
than,” look up “greater than.”

Italic style To make something italic, like this, select it by dragging the mouse over 
it.  Then, click on the I palette button.  Note that this may only affect the 
alphabetic characters (see Non-Functions for more details on why and 
how to override this).  See also font commands and style.

Italics are used in equations to indicate a scalar variable. 

justification Left, right, top or bottom justification means to place something along 
the left, right, top or bottom limit.  Center justification means to place 
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it half way in between, either vertically or horizontally.  To change 
justification of something, select it and use the change button.

-ket The right hand side of a bra-ket.  See bra-ket.

Keystroke 
Definitions

This dialog allows you to reprogram your entire keyboard so that you can 
change what each keystroke does in Expressionist..

To program a keystroke, simply press the keystroke to program.  The 
keystroke that you pressed will be displayed in the Keystroke to 
Reprogram field.

what it shows what you typed
A A
shift A ßA
ctrl A ÇA
alt shift A ÅßA
ctrl alt shift A ÅÇßA
5 5 (on regular keyboard)
5 (numpad) 5 (on numeric keypad)
shift 5 (numpad) ß 5 (on numeric keypad)
F3 £ (Function key #3 )
Space ˙ (the space bar)
shift Tab ß†

After giving the keystroke, define its action.  The action can Insert 
Something (a macro, character, or composite), Change the Font (to a 
previously defined font command), or Do Something Else (perform an 
editing command).  You can also make a keystroke do nothing, which is 
useful to avoid inserting unwanted characters.
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The radio buttons control what happens when the keystroke is used.  To 
find out what kind of function a keystroke has, type it and the appropriate 
radio button will turn on.  To change the function of such a keystroke, 
you can click on a different radio button to summon a dialog.  The dialog 
that is summoned depends upon which of the radio buttons you click.

To make the keystroke insert a character, composite or a macro, click on 
the Insert something… button.  To make the keystroke change the font 
or size of the selection, click on the change the Font… button.  To make 
the keystroke do another editing command such as Paste or Select All, 
click on the do something else… button.  To make the keystroke do 
nothing, click on do nothing.

The Backselect checkbox will cause the keystroke to select what is 
immediately behind the blinking caret just before executing.  This is 
useful for keystrokes such as ÇH.  If Backselect was off for the definition 
of ÇH, if you type X ÇH 2, you get x2?, instead of x2 the way you 
intended, because the x would not be selected when the superscript 
composite is created.  Backselect selects the preceeding character unless 
that character is part of a number or a function name, in which case it 
selects the whole function or number.  Backselect works only if there is 
a blinking insertion point; otherwise it has no effect.

The button Print Keystroke Assignments prints a quick reference 
listing of keystrokes and their assigned functions.  Each keystroke’s 
function is represented by the icon that would be displayed if the 
keystroke were on the palette.

keystrokes See typing.

kilo k This prefix means multiply by 103.

l (ell) l L See script ell.

lambda λ Λ This Greek letter is usually available only in full Greek fonts.  Lower 
case λ is on the a pop-up palette.  Upper case Λ is on the ∆ pop-up palette.  
The keystrokes ÅÇL and ÅÇßL insert lambdas from the Symbol font.

lambda-bar This is sometimes used to represent the angular wavelength, which is the 
wavelength, λ, divided by 2π.  The main palette includes a button for a 
macro which is a Symbol font lambda in an overstrike composite with 
a bar tweaked into position.  Mathematical Pi 2 has the character shown 
at left.

Laplacian 
operator ∇2

Use the macro on the  pop-up palette.
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LATEX A close derivative of the TEX mathematical typesetting markup 
language.  See also the Copying as Text and Working with TEX 
sections.

left justification In rulers and matrices, where there may be several items grouped on top 
of each other with different widths, specifying this means to make sure 
that the left sides of all items line up along the left side of the available 
space.  See also right justification and center justification.

Use the absolute value fence composite for the vertical bars.

less than < In almost any font, you can simply use the < which is ß, (comma).

less than or          

equal to 

Click the symbol on the × pop-up  palette of operators.

Use the limit macro button on the  pop-up palette.

Lockstep Ruler A ruler that is set so that it matches the characteristics of the ruler on the 
string that encloses it.  Lockstep rulers are useful when you have several 
paragraphs in a sequence that all need the same paragraph formatting.

To use Expressionist like a word processor, simply type in text and press 
Enter at the end of paragraphs.  The first time you press Enter, 
Expressionist will create a matrix, one column wide and two rows high, 
that will hold the sequence of paragraphs.  Successive paragraphs will 
add more rows, one per paragraph.

By default, each string in the matrix made in this way will have a 
lockstep ruler.  Each of them will mimic the characteristics of the ruler 
that encloses the matrix.  By simply changing the outside ruler, you can 
change all of the lockstep rulers for all of the paragraphs simultaneously.
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To make a ruler into a lockstep ruler (or to change a lockstep ruler into 
an independent ruler), select everything in the string and Change.  (If 
there is only one element you may have to temporarily insert a space.)  

long division
To make a long division sign, click on the  button  This will give

 you a long division structure with four slots: 

  

with the slot on the left empty.  Select any one question mark and type in 
what you need.  Select Next (press †) to move to the next one.

The last slot, on the bottom, has the most in it and takes the most work.  
It needs to be a matrix.  Type rows of digits, pressing Enter between 
each.  Select the whole matrix, click on change, and choose Left Justify.  
To make the columns line up, you can use a fixed-width font like 
Courier, but in some fonts such as Times, a space is about half the width 
of a digit.  Make your columns line up with spaces.  You can add the total 

bars by selecting a row (by double clicking) and clicking on  to put a 
bar over it.  (You can put a bar under a row instead by selecting the mark 
structure and changing it to be underneath.)

If you are making many of them, you may want to set one of the macro 
buttons to make a long division.

See also Division.

loop l (ell) , + See script ell.

loop integral 
 Click  to make a loop integral.  To make the loop a clockwise or 

counter-clockwise arrow select the integral structure and change it (see 
change integral).

Lower 
This command, if applied to a selection that is a contravariant tensor 
index, lowers the index to be covariant.  If applied to a selection that is a 
tree node child that is in the mezzanine, it lowers the child to the floor.

Lower is available on a few pop-up palettes which also contain structures 
which may need to be raised (trees and tensors).  Its keystroke 
equivalent is Å¿.

macros

 
108423

47

92
164
161

3
 

??
?

?

   B •ds
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Macros are user-defined expressions which can be inserted into your 
expression window with a keystroke or a click on a palette button.  
Expressionist includes many pre-defined macros of commonly used 
structures, symbols, and expressions.  See also Macro Definitions.

Macro 
Definitions

This command on the Options menu brings up a dialog that allows you 
to add new macros and change or delete existing macros.

The list box on the left shows all defined macros, including their icons.  
When you click on a macro in this list, the macro expression is shown 
(magnified) to the right, with its icon bitmap image shown at the lower 
right.

Underneath the macro expression is a legend that displays the keystroke 
and/or palette button definitions for the macro (if any).  If no keystroke 
or palette assignments exist, it says “unassigned.”  (Unassigned macros 
can be inserted with Insert Something.)

To make a new macro, click on  New Macro .  A window appears in 
which you can create the macro like any other expression.  (Most macros 
should be created with the Default Font so they work smoothly when 
used in equations.)  Close the window to return to the Macro Definitions 
dialog.

To edit an existing macro expression, first click on it from the list box, 
then click on the  Edit Macro in Window  button.  (Or just double click 
the macro in the list box.)  The macro appears in a window; edit the 
macro like any other expression.  Close the window to return to the 
Macro Definitions dialog.
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To edit the macro’s icon, first click on it from the list box.  An enlarged 
icon bitmap image is shown at the bottom right.  Use the mouse pointer 
to click on and off pixels in the 16×16 grid.  This task is made easier with 
the Generate Icon button, which takes a snapshot of the expression and 
turns it into the icon.  After you click the button, the dialog says “Click 
and Drag Above to Generate Icon” and you can click on the expression 
image and drag a rectangle…

The selected portion of the expression is turned into the bitmap icon, 
replacing any previous icon contents.  You may want to do some 
touching up of the icon, as the snapshot is never perfect.  The  Clear Icon  
button erases the image in the icon grid so you can start fresh.

To delete a selected macro, select it from the list box and click on the 
Delete this Macro button.

Macros are stored in the preferences file, which allows a maximum of 
255 macros.

Magic 
Alignment

 
 

A way of aligning independent expression composites that otherwise 
would not align with each other because their subexpressions vary 
greatly in size.  To make them align, select all of them simultaneously 
and choose Magic Alignment from the Edit menu.

For instance, examine equation 1 below.  Even though the fraction bars 
align with each other, and each fraction independently looks correct, the 
equation does not look right as a whole because the numerators do not 
align with each other.  The same problem is also true of the 
denominators.  To fix the problem, select from the first fraction through 
past the second one and choose Magic Alignment, which produces the 
results shown in equation 2.

  ax

b
+

c
d2
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before magic align after magic align

In order for Magic Alignment to work, the two composites must be 
identical.  In other words, you cannot align a fraction with a root, and you 
cannot align two matrices that have a different number of rows.

When you select multiple composites that are all in a string, as in the last 
example, Magic Align will only pick out the composites that match the 
first one in the selection.  For instance, in the following equation, if you 
select the whole equation and choose Magic Alignment, only the two 
integrals will be aligned with each other.  If you want to align the two 
fractions, you should select starting at the first fraction, through and 
including the second one.

To select multiple composites that are not in the same string, you will 
have to make multiple selections by shift-clicking.  For instance, to align 
these two matrices, each of which is embedded inside parentheses 
fences, double click while dragging between two elements of one, then 
hold down shift, and double click while dragging between two elements 
of the other.  If you simply select the whole string, you will end up 
aligning the parentheses with each other (which might be of value in a 
different situation).

no magic alignment

  x
y=

a + b
c

d
(1)

  x
y

=
a + b

c
d

(2)

  
xdx + x

y= dx
1 – x20

1
3

+
a + b

c
d

  
a11 a12
a21 a22

=

b11
3

b12
3

b21
3

b22
3

  
a11 a12

a21 a22

=

b11
3

b12
3

b21
3

b22
3
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matrices aligned with each other

parentheses aligned with each other

Magnify mode Magnify mode causes the current expression to display on the screen 
twice as big as it is on paper.  To turn it off or on, click on the magnify 
mode icon.

Do not confuse this with enlarge + or shrink –, which change the size of 
the selected subexpression and actually change the way the expression 
will look when printed.

main palette The palette that you see on the screen without clicking anything, as 
opposed to pop-up palettes.

mark A Mark is a composite which puts one of a selected set of symbols above 

or below any character or expression:  .  Frequently, though, marks 
are only useful over one character at a time.

To make a mark, click on one of the buttons on the palette.  You can 
select what you want enclosed first, or you can type it in afterwards.

There are eleven marks, Dot , Double Dot , Triple Dot , Vector 

, Back Vector ,  Dyad , Overbar ,  Double Bar , Tilde , 

Circumflex , and  Arc .  In addition, each mark has  and 

 versions, for putting the mark above or below.  There are eleven 

mark buttons:   , , , , , , , , , , and .  
There are also many keystrokes to make marks.  To make one of the other 
variations, make any mark, select it, and change it.  (See change mark.)

Mark composites have almost the same size as their contents.  For this 
reason, when you are trying to select the composite itself, or the whole 
string in the middle, it can get confusing.  Use Guide mode  to help; 

click in the character box and drag up to select the mark.

  
a11 a12
a21 a22

=

b11
3

b12
3

b21
3

b22
3
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  AB

T T T
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Note that the mark 
cannot be selected 
alone; its contents 
must be selected with 
it.

contents of mark selected mark and contents selected

Mark 
Adjustments

This command on the Options➧Adjustments submenu brings up a 
dialog that allows you to change Mark drawing parameters.

The first setting allows you to change the thickness of lines.  This setting 
controls the thickness of circumflexes, tildes, vectors, and similar 
marks.  This setting also controls the separation between the mark and 
the subexpression to which it applies.

The second setting allows you to change the size of dots, affecting the 
dot, dot dot and dot dot dot marks.  It also controls the width of 
arrowheads for vectors, dyads and backvectors.

markup 
language

A set of textual commands used to describe something to be typeset.  
TEX, eqn, nroff, and troff are markup languages.  Lotus Ami Pro and 
WordPerfect have their own proprietary markup languages for 
equations.

Markup languages are not always popular with personal computer users 
because they are difficult to use compared to the WYSIWYG capabilities 
of graphic user interfaces such as Macintosh and Windows.

Expressionist provides the capability to output equations for markup 
languages.  See Copy As Text.



Encyclopedia

185

Math axis An imaginary line used in mathematical typesetting that all vertically 
symmetric symbols and composites line up along.  The math axis runs 
through the middle of +, –, =, and vertical fractions.  If you want to see 
where the math axis of something is in Expressionist, put a vertical 
fraction next to it.  (Sometimes font designers are sloppy about making 
characters such as + and – line up with each other, so you can’t always 
trust characters.)  See also baseline, Change String.

The Math Axis Newsletter published by Prescience Corporation and sent to registered 
users of Expressionist and Theorist.

Mathematical Pi A set of six fonts from Adobe Systems which include extensive math 
symbols and Greek letters.  See Appendix A for lists of characters in 
these fonts.

matrices Plural for the word matrix.

matrix
 

You can create a matrix with one of the many palette buttons with preset 
matrix dimensions or use the New Line (œ) and New Field (Åß†) 

commands.  The  pop-up palette includes buttons for all preset 

matrix sizes and other matrix-related buttons.  You can change the 
dimensions of a matrix or its justification with Change.

Newly created matrices have no brackets or parentheses surrounding 
them; you may add these fences if you wish.

See change matrix, matrix selection, New Field, and New Line.  See 
also the Matrix example in the Tutorial Equations section.

matrix selection A matrix selection is one that spans a rectangular subset of a matrix.  You 
can type into or Cut and Paste matrix selections.

If you select one or more whole columns of cells, Expressionist treats it 
as if it were a selection of one or more characters in a string.  Delete 
eliminates the column(s), and insertions replace the column(s), creating 
their own newly-inserted column(s).

If you select one or more whole rows of cells, Expressionist treats it like 
columns.  Delete eliminates rows and insertions replace rows.

If you select the whole matrix, insertions and deletions result in the 
removal of the entire matrix.

Like character string selections, you can have a blinking caret selection 
which fits between rows or columns (including the edges).  Deletions 
remove the previous row or column; insertions create one or more new 
rows or columns.

math axis
baseline

 A + 1
2

  1 0 0
0 a b
0 –b –a
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If you Paste a non-matrix or a smaller matrix into a large matrix 
selection, the element or small matrix rows and columns are repeated in 
order to fill the selection.

mega Μ This prefix means multiply by 106.

Metafile The standard Windows graphic format for pictures.  Expressionist can 
copy Metafile-format pictures to the clipboard or save Metafiles on disk.  
(See Save As Metafile.)  See also Picture Format.

micro µ This prefix means multiply by 10–6.

Microsoft Word For details on how to use Expressionist with a word processor, see the 
Working with Expressionist section.  For details on how to use 
Expressionist with Word in particular, see the section’s Companion 
Applications chapter.

milli m This prefix means multiply by 10–3.

Minimum Size This number, set in the Character Size Steps dialog, controls the 
minimum character size that Expressionist will generate characters at. 
This is most useful for limiting how small subscripts of subscripts of 
subscripts… can get.

Minimum Size A real minus sign is different from a hyphen - or dash.  Minus signs 
should have the same size and position (on the math axis) as the 
horizontal bar on plus + signs.  Notice that the minus sign is the same 
width as a plus sign:

hyphen:-
plus:+
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minus:-

You may be used to typing the hyphen key, -,  to insert the hyphen 
character, -, but the preferences file supplied with Expressionist 
redefines the - key to insert a minus sign, –.

Typographers usually think in terms of a hyphen, -, which is short, an en 
dash, –, which is the length of an “n”, and em dash, which is the length 
of an “m”.  An en dash usually makes the best minus sign, but fonts are 
not usually designed with mathematics in mind, so you may have to 
experiment.

minus-or-plus ± Not available in Symbol font, but it is in Adobe Mathematical Pi #1.  
Expressionist has a macro on the × pop-up palette which comes close.

modulus Use the word “mod” like this:

15 mod 7 = 1

Lower case, no italic or boldface. Floor may also be useful.

moving 
equations

To move equations and pieces of equations, simply select them, then use 
Cut and Paste.  See also the Moving Equations chapter in the Working 
with Expressionist section.

mu µM This Greek letter is usually available only in full Greek fonts.  Lower 
case µ is on the α pop-up palette.  The keystroke ÅÇM was redefined to 
insert µ from the Symbol font.

much greater 
than 

Some fonts have the character », which is really a French quotation mark.  
Adobe Mathematical Pi #1 has a better one, .

much less than Some fonts have the character «.  Adobe Mathematical Pi #1 has a better 
one, .

multiple 
integrals Click either  or , or use the Change Integral dialog.  This 

method does not allow limits on each sign, just the last.

For multiple integrals with limits on each:  Click , type ƒ Ÿ, and 
repeat as many times as necessary.  Then select the integrals and give the 
Magic Alignment command.  (Each integral structure can be changed for 
limits above and below.)  See also integral.

Multiple 
Selections

Expressionist allows multiple selections by simply shift-clicking.  There 
are other ways to make multiple selections, such as Select In.
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With a multiple selection, all operations now apply to all of the selections 
simultaneously.  For instance, you can select an entire matrix and then 
choose Select In, so that you have a multiple selection where each 
element of the matrix is selected.  Then, when you type, everything you 
type is inserted into each matrix element simultaneously.

multiplication There are several ways to do multiplication.

Frequently, multiplication is represented by just writing two things next 
to each other, like this:  2y.  That means two y’s added together, or y times 
2.

Others put a dot or an × between things to be multiplied.  The dot, ⋅,  and 
× are on the × pop-up palette.  Also on the pop-up palette is the • dot .  Do 
not use x or X in place of ×.

nabla ∇ See gradient.

nano n This prefix means multiply by 10–9.

New Field 
The keystroke Åß† makes it easier to type in matrices with this 
command.  When applied to a matrix element selection, it advances the 
selection to the next column in the matrix like Select Next.  If the 
selection is in the last column in a matrix, New Field appends a new 
matrix column and moves the selection to the corresponding element of 
the new column.

When applied to a selection that is a tensor index, New Field inserts a 
new index for you to enter.  If applied to a selection that is a tree node 
child, it similarly inserts a new child for you to enter.

New Line 
The keystroke œ makes it easier to type in matrices with this command.  
When applied to a matrix element selection, it starts a new matrix row 
and moves the selection to the first element of the new row.

If the New Line command is invoked without a matrix, it creates a matrix 
and you get a sequence of paragraphs.

New menu 
command

This command on the Expressionist application’s File menu creates a 
new expression window. 

node, tree See tree node.

Non-Functions This setting in the italics popup menu on the FontSizeStyle dialog will 
cause text with that setting to be in italics only if it is alphabetic, and only 
if the alphabetics don’t form a function name on the function list.
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A normal integral is one without a loop.  Click the  button from the 
palette.  You can Change  an integral from Loop to Normal and back.  
See also integral, Change Integral, and multiple integrals.

not ¬ People do a “not” in different ways, depending upon exactly what is 
being negated and in what way.   To put an overbar over something select 

it and click on .  The Symbol font character ¬ is on the ∀ pop-up 
palette.

not equals ≠ The Symbol font character π is on the × pop-up palette.

nu ν N This Greek letter is usually available only in full Greek fonts.  Lower 
case ν is on the α pop-up palette.  The keystroke ÅÇN inserts ν from the 
Symbol font.

null set A null set is a concept from measure theory; it is not the same as the 
empty set.

numbering 
equations

See the Working with Expressionist section’s Numbering Equations 
chapter for explicit directions.

omega ω Ω This Greek letter is usually available only in full Greek fonts.  Lower 
case ω is on the a pop-up palette.  Upper case Ω is on the ∆ pop-up palette.  
The keystroke ÅÇW inserts w from the Symbol font, and ÅÇßW inserts 
Ω.  (The optional omega, ϖ, is ÅÇV.)

Ω omega palette 
button

Changes the selection to the Symbol font.

omicron ο Ο This Greek letter is usually available only in full Greek fonts.  Pretty 
boring; it looks just like a regular “O”.  Purists can use O and ßO in 
Symbol font.

Open File This command on the File menu opens an existing Expressionist file.  You 
can close it with the Close File menu command or by double-clicking on the 
window’s close box on the upper left corner.

Options Expressionist allows you to change various options which control the 
editing environment and adjustments which affect printed output.  See 
Palette Button Options, Keystroke Definition Options, Macro 
Definition Options, Typestyle Definition Options, Adjustment 
Options, Copying Options, and Other Options.
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Most options, except Copy As Text tables, are saved in the preferences 
file.

Origin Cell The main button in a pop-up palette.  You can change the origin cell of 
a popup palette with the Palette Buttons dialog.

Other 
Preferences

This command on the Options menu brings up a dialog that allows you 
to change miscellaneous preferences.

Screen Drawing options let you choose Instant Redraw or Smooth 
Redraw.  Instant redraw is faster, but may cause the screen to flash as 
you are typing.  Smooth redraw eliminates the flash, but may be slower 
overall.  Try both settings to see which you like best.

The paste behavior determines whether question marks behave like 
wildcards when you do a Paste, the way they do for macros.  For 
instance, if you copy the expression “(a + ?)”, and you then select the 
expression “Q”, and do a Paste, you will either get “(a + ?)” or “(a + Q)”, 
depending upon this setting.

outline fonts Outline fonts are scalable fonts which provide sharp, accurate, good-
looking characters.  Adobe Type Manager (ATM)/PostScript outline 
fonts are used to create text on PostScript printers.  TrueType outline 
fonts are used to create text on non-PostScript printers.

outline letters The Adobe Mathematical Pi #6 font contains these letters:  
ABCDEFGHIJKLMNOPQRSTUVWXYZ.
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overbar  
Select what you want to have an overbar over (it can be a single 

character, or a whole expression).  Then click on .  See also mark.

Overstrike  
To type two characters on top of one another, use the overstrike 

composite button, .  It looks like the letter “a” being overstruck by the 
letter “b”.

So you can see what you are doing the overstrike elements are separated 

when Guide mode  is on.  For instance, consider an “x”       
overstruck with a “y”:

Guide mode off Guide mode on

One use for overstrike is to make a lambda-bar symbol, .  Start with an 
overstrike and put  “λ” in one string and a minus – or slash / in the other 
string.  Use Tweak to align them to look right.  (The lambda-bar has 
already been done in a predefined macro, which you can examine.)

overscripts See Underscripts/Overscripts.

P palette button Changes the selection so bold, italic, and underline styles are off.

Page 
Setup…               
menu command

This menu command is used to declare to the printer what size of paper 
you are using along with other details.  You should do this at least every 
time you change printers.

PageMaker See the Working with Expressionist section’s chapter on Companion 
Applications.

paint programs See the Working with Expressionist section’s chapter on Companion 
Applications.

palette This is the panel of square icon buttons that floats on your screen.  
Clicking on each icon button executes a specific command.

x

 OX



192

Encyclopedia

When you first open Expressionist, it might be that only a few sections 

are visible, but you can see the rest by resizing the window.  If the palette 
is not visible at all, choose Palette from the Windows menu.

The upper left area of the palette has font commands.  See FontSizeStyle 
box, Default font, Symbol font, Plain, Bold, Italic, Enlarge, and 
Shrink.  To the right of these are the guide box, magnifying glass, and 
ruler icons; see Guide mode, Magnify mode, and Ruler mode.

Below the font commands is Undo, followed by the clipboard commands 
Cut, Copy, Paste, and clear.  Continuing to the right, the yin-yang icon 
is Change, followed by Unmark, Select First, Select All, 

Select In, Select Out, Select Next, and Escape.  The  pop-up 

palette contains color control buttons.  The  pop-up palette contains 

tweak tools.

To the right of the FontSizeStyle box, we find pop-up palettes 
containing buttons that generate composites.  See fence, subscript/
superscript, fraction, root, mark, integral, tree, and frame.  The button 
in the upper-right corner is overstrike.

The middle area of the palette is devoted to matrix composite buttons.  
The  pop-up palette has all matrix buttons, with New Field and New 

Line buttons, ellipsis buttons, the special Insert Index command, and 
the macro.

The  pop-up palette contains various macros and the adjacent  

pop-up palette has function name macros.

The rest of the palette is devoted to Greek letters and various math 
symbols, most of which are Symbol font characters.  The  and , symbols 
are special pseudocharacters.  Some symbols, such as , , and 7, are 
macros constructed from multiple symbols to look like a single symbol.  
(These are mostly on the pop-ups.)

 AB
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The palette design can be changed by choosing the Palette Buttons… 
item on the Options menu’s Editing submenu and working with the 
Palette Buttons dialog.

If you can not find something on the palette or its pop-up palettes, try the 
Insert Something dialog.

 Palette Buttons This dialog allows you to reorganize Expressionist’’s floating palette.  
One of two different arrangements is used depending upon whether your 
palette is predominantly vertical or predominantly horizontal.  Both 
styles present a dialog with borders which may extend beyond your 
screen; there is nothing of importance beyond the bounds of your screen 
(unless you have placed buttons there on a bigger screen and you are now 
working on a smaller screen).

Horizontal layout dialog

 Vertical layout dialog

Each button position can be made to insert a character, composite or 
macro, or to execute a font command, or to do some other editing 
command.  Alternatively, a button can be deleted so that the button space 
is unused and the button does nothing.

The radio buttons control what kind of button it is.  To find out what kind 
of function a button has, click on it and the appropriate radio button will 
turn on.  To change the function of such a button, you can click on a 
different radio button to summon a dialog, or else you can simply double-
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click on the button if you want a function in the same category.  The 
dialog that is summoned depends upon which of the radio buttons you 
click.

To make the button insert a character, composite or a macro, click on the 
Insert something… button.  To make the button change the font or size 
of the selection, click on the change the Font… button.  To make the 
button do another editing command such as Paste or Select All, click on 
the do something else… button.  To make the button bring up a pop-up 
palette, click on the activate popup… button.

As far as Expressionist is concerned the palette is a 30×30 grid of 900 
square buttons.  You can put buttons anywhere you want, although it is 
usually best to pack them along the top or left sides.  The palette 
window’s resize box allows you to view as many or as few buttons as you 
desire.  Its outline is shown in the Palette Buttons dialog to remind you 
what is or is not visible.

The only difference between a horizontal palette and a vertical palette is 
the arrangement of the buttons.

Paragraphs You can use Expressionist like a word processor to make paragraphs 
with word wrap, right and center justification, etc.

To use Expressionist like a word processor, simply type in text and press 
Enter at the end of paragraphs.  The first time you press Enter, 
Expressionist creates a matrix, one column wide and two rows high, that 
holds the sequence of paragraphs.  Successive paragraphs add more 
rows, one per paragraph.

If you turn on Ruler mode, you can see a ruler at the top that dictates 
the column width.  You can change this width, set tab stops, etc.

Each paragraph is in a string that has an invisible lockstep ruler.  This 
ruler behaves exactly the same as the ruler at the top.

parallel ||
Use two vertical bars ||, ß\ (backslash) or use the  composite and 
change it to a single side.  Avoid the use of the vertical bar symbols in 
Symbol font and certain other fonts which have too much space between 
them.

parentheses
Use  or just the normal parentheses on the keyboard.  The  
resize themselves automatically to fit what is inside them.  See also 
fence.
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partial derivative
 

 

Use ÅÇß6 or the palette for the ∂ symbol.  Just make a fraction out of it.  
Maybe enclose it in parentheses, if appropriate, with a subscript.

The  pop-up palette has a  macro.

Paste command The Paste command (on the Edit menu or on the palette) pastes an 
expression or fragment into the current expression window at the 
selection, replacing the selection.  If it is a multiple selection, multiple 
copies are inserted in each selection.

For an introduction to this, see Guided Tour chapter of  this manual’s 
Using Expressionist’s Features section.  The Matrix example in the 
Tutorial Equations chapter shows how you can duplicate subexpressions 
into matrices with Paste.

The clipboard should either hold text, or should hold an expression 
picture which is the result of a previous Cut or Copy from 
Expressionist..

See the Working with Expressionist  section’s chapter Moving 
Equations section for details on pasting expressions into your 
application program.

If the clipboard contains text, and the text does not contain the sequence 
“]|Expr|[”, then the text is simply inserted as though it were typed at the 
keyboard.  Tabs and returns are interpreted as though they were typed in, 
also.  (To paste matrices, you might want to temporarily change the 
keystroke definition of the † key to New Field.)

If the clipboard contains text, and the text does contain the sequence 
“]|Expr|[”, then the text is interpreted as a Copy As Text encoding.  
Expressionist attempts to read in text between the “]|Expr|[” and the 
ending “]|[” and the resulting expression is inserted over the current 
selection, as when you paste in a picture.  See the Copying as Text 
section for more details.

perpendicular ⊥ This Symbol font character is available on the ∠ pop-up palette.

phi φ ϕ Φ This Greek letter is usually available only in full Greek fonts.  The 
keystrokes ÅÇF and ÅÇßF insert the Symbol font characters φ and Φ.  
The keystroke ÅÇJ inserts the ϕ form.  Both lower case forms are on the 
a pop-up palette and the upper case letter is on the ∆ pop-up.  φ is also on 
the main palette.

The keystrokes ÅÇP and ÅÇßP insert the Symbol font characters π and 
Π.  Lower case π is on the main palette and a pop-up palette.  Upper case 
Π is on the ∆ pop-up.

  ∂S
∂T V
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pi product
 

 The  pop-up palette has pi product macro.

pico p This prefix means multiply by 10–12.

Picture Border This command on the Options➧Copying submenu brings up a dialog 
that allows you to add extra border space to generated pictures that you 
copy out with the Copy command.

You should add a few points around the borders of your picture if you 
have a problem with italics being clipped off, or any piece of any 
expression stepping out of bounds.  For example:

Not Clipped Clipped on Right

Picture Format

   aΠ
n =1

∞

 OK  OUCH!
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This command on the Options➧Copying submenu brings up a dialog 
that allows you to change the resolution of pictures that you copy out 
with the Copy command or save as Metafiles.

Most laser printers have 300dpi resolution, but some are higher, such as 
600dpi.  Other kinds of printers can be anywhere from 60dpi through 
4000dpi.

Clicking on the Printer Default button and clicking OK is usually all 
you need to do.  This button checks your computer system and your 
chosen printer and changes the resolution to match your printer, if 
possible.  You can type in the resolution yourself if necessary.

Picture Rotation
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This command on the Options➧Copying submenu brings up a dialog 
that allows you to change the rotation settings for generated pictures that 
you copy out with the Copy command.

You have three direction choices:  normal, clockwise, and 
counterclockwise.  Only these rotations in 90° increments are available.

pixel A pixel (picture element) is the smallest possible element of a picture 
drawn by a computer.  If you look carefully at your screen, you will see 
that the picture is made up of individual dots.  These are pixels.

There is a widespread tendency to call them “dots.”  Precisely, a dot is an 
image of a tiny circle.  If it is on a computer screen, this image may be 
composed of one pixel or of several pixels (look at periods and colons in 
your favorite font—those are dots).

See also resolution.

Plain style To remove all style enhancements like boldface and italic, select the text 
you want to change, and click on the P palette button font command.

Planck’s  

constant

Not available in normal fonts, nor is it found in the Symbol font, the h-
bar character can be found in Adobe Mathematical Pi and Universal 
Greek Pi.  An Expressionist  pseudocharacter is on the palette, and you 
can make this symbol with the overstrike composite.

plus+
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Just use +.  Auto Spacing puts spaces before and after:

a + b

plus-or-minus ± Use the Symbol font character on the × pop-up palette of operators.

point The term “point,” as used here, usually refers to a typographer’s point. 

The exact definition of a point varies; Expressionist uses  inch for 
compatibility with other computer systems.  Usually, font sizes are 
measured in points.

Your computer’s screen resolution is probably between 60 and 120 
pixels per inch, so points and pixels are not the same thing.  When a font 
is said to be “12 Point,” that means that the distance from the ascent to 

the descent is  inch.  Nine or 10 point is a typical point size for 
normal text that is typeset or laser printed, 12 point is more appropriate 
for lower resolution printing.

Pop-up Palette A pop-up menu of palette buttons that appear when you click on certain 
buttons on the main palette.  Pop-up palette buttons appear on the main 
palette with an extra-heavy shadow.  To choose one of the buttons in the 
pop-up, simply click down on such a button on the main palette, and 
when the pop-up appears, drag to the desired button.

To program a pop-up palette, choose the Palette Buttons… command 
from the Options➧Editing submenu.  The activate popup radio button 
summons another dialog like the original one.  This time, however, the 
palette shown is the particular pop-up palette for this palette button.  If 
the button has had no pop-up palette, there are no buttons on it.  You can 
create new palette buttons on this pop-up palette the same way as for the 
main palette (except that you cannot create a pop-up on a pop-up).

The Origin Cell for a pop-up palette is the button which appears on the 
main palette and which is directly under the mouse pointer when you first 
click on it to pop up the palette.  The image of the pop-up on the main 
palette is that of the origin cell.  The origin cell simply serves as the 
anchor for the pop-up palette and it has no effect if you choose the origin 
while editing.  Items usually appear twice on pop-up palettes because one 
is the non-functional origin and one is the working item.

When a pop-up is activated, or popped up, the buttons on the pop-up 
expand out in a direction depending on the location of the origin cell.  For 
instance, if you have a 3×3 pop-up palette, and the origin cell is the upper 
left cell (the default), when you click on the pop-up’s button on the main 
palette, the pop-up extends down and to the right.  If on the other hand 
the origin cell is the middle button, the pop-up extends in all directions 
from that cell.  Use the pop-up palettes to see the effect the origin has on 
the pop-up direction.

 
1 721 72

 
12 7212 72
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position vector See vector.

PostScript font The page description language made by Adobe Systems (built into many 
laser printers and typesetters) which allows high-resolution printing.  
Expressionist creates Metafile format pictures which are converted to 
PostScript when you print on PostScript printers.  Expressionist  can 
save Encapsulated PostScript (EPS) files for output on a PostScript-
equipped device.  See also Picture Format and EPS.

A font which works with the PostScript page description language to 
allow high-resolution, scalable font characters.

The term generally refers to the 35 typefaces built in to most PostScript 
printers and/or fonts which can be downloaded to a PostScript printer.  
The former include Courier, Times, Symbol, Palatino, etc., and the latter 
include Mathematical Pi, Garamond, Optima, etc.

Under Microsoft Windows, PostScript fonts should be used with the 
Adobe Type Manager.

power 
To raise an expression to a power, select it and click on superscript , 
then type in the power you want.

preferences See Options.

preferences 
directory

The directory which stores the preferences file, functions file, and CAT 
translation tables.  The directory is named EXPRPREF and is a 
subdirectory of the EXPR directory.

preferences file

preferences file When you make any changes with Expressionist’s Options menu, the 
changes are automatically and transparently saved in a file named 
EXPR.PRF, which is in the EXPRPREF directory.

prefix See tera, giga, mega, kilo, centi, milli, micro, nano, pico, femto.

prescripts A subscript/superscript composite is a complicated thing.  It has many 
optional parts to it.  One part is the prescripts.  To turn on and off the 
prescripts, select the whole structure and click on change.

See also change subscript/superscript, subscript/superscript 
composite.

prime mark y′'  
y∀

The Symbol font characters for the single prime ′, and double prime ″ are 
on the ∠ pop-up palette.  An apostrophe ' is a cheap substitute, but is easy 
to type.

  x 5

 P1/2
2 – S1/2

2
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printer fonts PostScript printer fonts contain detailed information on how to render 
characters on a laser printer or similar device.  The term usually describes 
PostScript fonts, which can be resident in a PostScript-equipped device 
or downloadable.

Print 
Expression…   
menu command

This command on the File menu is used to print the expression in the 
current expression window.  The equation appears alone on the page.

product
Click on the  macro button and type in whatever you need.  This 
macro is the same as a summation with a ∏ instead of the ∑.  (Actually, 
it’s an underscript/overscript/afterscript composite.)  In fact, you can 
type in other characters (such as set symbols) in place of the ∏.  See 
subscript/ superscript composite and multiplication.

proportional to   
∝

Some people use the Symbol font character µ, which is on the × pop-up 
palette.  Some people use ~, which is simply on the keyboard.

Pseudocharacter
s

These are characters drawn specially by Expressionist.  They are not 
characters in the usual sense and they are not available in other programs 
in your system the way normal characters are.

The pseudocharacters are script ell, planck’s constant, four ellipses and 
thin space.  You can insert them into your equation by clicking on the 
appropriate palette button or by pressing the appropriate keystroke.

psi ψ Ψ This Greek letter is usually available only in full Greek fonts.  The 
keystrokes ÅÇY and ÅÇßY were redefined to insert the Symbol font 
characters ψ and Ψ.   Lower case ψ is on the α pop-up palette.  Upper case 
Ψ is on the ∆ pop-up palette.

quad n There is no real quad (four-dimensional ∇) symbol in Symbol or Times 
New Roman, but Adobe Mathematical Pi #6 has o and o.  As an 
alternative, you can fake it with one of a few characters in Wingdings, 
n.  Another workaround is to surround a space or thin space with a 
frame.  See also rectangle.

Some fonts use a hollow rectangle  character for missing characters in 
its fonts.  Do not use this “illegal character” symbol; it does not print on 
many printers.

Quantization When Expressionist calculates sizes of composites, sometimes you are 
given an adjustment option or a change option to quantize some 
measurement.  This means that the resulting number is an integer 
multiple of a step size, usually about half of the ambient font size.  
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Frequently, things that are quantized also have a minimum size that 
depends upon the situation.

Quantizing makes the structures grow in steps, sort of like “snap to grid” 
in drawing programs, which leads to better alignment of similar-sized 
structures.  Without quantization, structures grow more smoothly but 
will not align as easily.

See also Change Frame, Fence Adjustments, and Integral 
Adjustments.

quick reference To print a list of keystroke commands to use as a quick reference, choose 
Options➧Editing➧Keystroke Defintions… and click the button  Print 
Keystroke Assignments… .

Quit menu 
command

The Quit command on the File menu quits the Expressionist application 
(or probably whatever other program you are in).  All files are closed 
first, as though Close were applied to all of them, so you will be asked 
whether you want to save them each in turn before you exit.

quotient See fraction.

Raise This command, when applied to a selection that is a covariant tensor 
index, raises the index to be contravariant.  When applied to a selection 
that is a tree node child that is in the floor, it raises the child to the 
mezzanine.

Raise is available on a few pop-up palettes which also contain structures 
which may need to be raised (trees and tensors).  Its keystroke 
equivalent is Å˜.

real
Re z

Just use “Re” (without italics).  Some people use ℜ to represent this, so 
the keystroke ÅÇßM was redefined to insert the ℜ character from the 
Symbol font.

reciprocal Some people write 1/x, others write x–1.  See fraction and power.

rectangle
❏ 

To find out more about the gray rectangles in an expression window, see 

guide mode, .

You can surround your equation with a rectangle—see frame.

There is no real rectangle symbol in Symbol or Times New Roman font.  
Wingdings font has a few square-like symbols.  See also quad.

Some fonts use a hollow rectangle  character for missing characters in 
its fonts.  Do not use this “illegal character” symbol; it does not print on 
many printers.
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remainder See modulus.

resolution The resolution that equations are rendered with has an important 
influence over the way they will look when printed.  Measured in dpi 
(dots per inch, or pixels per inch), the resolution determines how fine the 
details of the picture can be drawn.  Because the process of getting an 
equation onto a printed page is complex, there are some rather 
unintuitive phenomenon involved.

Most people are familiar with the effect of resolution on bitmapped 
images.

People tend to be less familiar, though, with the effect of resolution on 
object-oriented graphics, usually thinking that because it is object 
oriented, it has infinite resolution and drawing is always perfect.  This is 
partially true.  For instance, when a character is drawn in object-oriented 
graphics, and the character drawing command eventually makes its way 
to a high resolution printing device, the printing device draws the 
character at its native resolution, achieving the best possible results for 
that device.

The position of that character, however, is still determined by 
coordinates which are in a coordinate system which has a resolution, and 
this resolution still has an effect upon the picture, although the effect is 
more subtle.  Its most visible manifestations are in the sizes of small 
structures that are drawn without help from a font system, such as simple 
lines and dots, especially when the font size is small.

As you can see, lines that try to be thin cannot go thinner than a single 
pixel in the set resolution.  In addition, the proportions of the whole 
equation are slightly different in lower resolutions because Expressionist 
must take the resolution into account when it is drawing such structures.  
(If an element is forced to a larger size to because of low resolution, 
proportions within the whole equation are changed to make room.)  Lines 
thinner than one pixel are invisible.  Elements separated by less than one 
pixel are touching.

  
72 dpi 1– x

2

1– x
2

  
150dpi

1 – x 2

1 – x 2

  300 dpi
1 – x 2

1 – x 2
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One would think that the solution is to simply use really high resolution, 
say, 1000dpi,  all the time.  This can cause problems in other situations.  
For instance, if you were drawing very small structures such that lines 

came out thinner than  inch thick (admittedly a very thin line), they 
would completely disappear on a 300dpi printer.  In fact, lines thinner 
than your screen resolution might now show up on your screen.

The best solution is to draw your equation in a resolution equal to the 
native resolution of the printer (or other target graphics device).  In fact, 
when your printer draws individual character glyphs from their outline 
descriptions, it must take the resolution into account using font “hints.”  
Unfortunately there is not a TrueType or PostScript for equations so 
Expressionist  itself needs to know the printer’s native resolution so it 
can apply its equation hints.

The second best solution is to use a resolution that is half or one third or 
one quarter of your printer’s native resolution.

You should not use a resolution that is not an integer fraction of the 
correct value because that can lead to problems.  For instance, assume 
your printer is 400dpi (with 2.5 milli-inch pixels) but you set 
Expressionist’’s resolution to 300dpi (with 3.33 milli-inch pixels).  
Expressionist  tries to draw a line that, ideally, would be 5.2 milli-inches 
wide.  Because it is targeting 3.33 milli-inch pixels, though, it rounds this 
up to 6.67 milli-inches wide.  When this gets to the printer driver, this 
line must be drawn using 2.5 milli-inch-sized pixels.  You would think 
that it would simply round this width up to 7.5 milli-inches wide, but in 
fact it rounds the coordinates of each side of the line individually, so that 
sometimes the line will come out 5 milli-inches wide and sometimes it 
will come out 7.5 milli-inches wide depending upon where the line 
happens to fall.  (This is similar to effects that you get when you stretch 
a bitmap by an odd amount.)  If you get uneven line thicknesses, chances 
are there is a resolution mismatch, as illustrated by the following:

Return The ¥ key is the same as œ; they are just labelled differently on different 
keyboards.  If this manual refers to the Return key, it means the same as 
Enter.

 
1 600th1 600th
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In another context, a return is computer slang for a carriage return/line 
break.  (E.g., if you see the usage “put a return in your text” it means to 
insert a carriage return with the œ or ¥ key.)

Right Angle See perpendicular.

right justification In strings and matrices, where there may be several items grouped 
together with different widths, specifying this means to make sure that 
the right sides of all items line up along the right side of the available 
space.

This is an an
example of

right justification.

Roman alphabet Roman letters are the ones we normally use for English and most 
Western European languages.  They evolved from the characters used in 
Latin by the Romans during the Roman Empire.  See also Greek, 
Hebrew, Cyrillic, German.

root
 

A root is a composite that symbolizes the mathematical operation of 
taking a number to a fraction of a power.  The denominator of the fraction 
is found in the upper left corner of the root, above the check mark.  If 
there is no number there, it is assumed to be 2, and the root is a square 

root.  To make a root, click  (or press ÇR), type the contents inside, 
press †, type the root power (or nothing for a square root), then Ÿ.

Root 
Adjustments

This command on the Options➧Adjustments submenu brings up a 
dialog that allows you to change characteristics of roots.  With it, you 

 43
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can change how the root is drawn and the general proportions of the 
composite.

The root exponent size determines how large the root exponent is.  

  Obviously, this has no effect on square roots.

The root symbol thickness affects the relative line thickness of the root 
symbol itself.  The thickness is also proportional to ambient font size.  
You should choose a line thickness that looks right for the default font 
you are using.  The bar thickness should be the same as the horizontal 
strokes of letters, or the thickness of – and + signs, or perhaps slightly 
thicker.

The Root Flange on Right will add a flange on the right side at the end of 
the top bar, as some people draw when they make roots by hand.  

row vectors
 

Row vectors are simply matrices that have one row.

rubber 
parentheses, etc.

“Rubber” parentheses, brackets, braces, et cetera are really composites 
known as fences.  Most composites in Expressionist  are “rubber” in that 
they stretch to accommodate their contents.

  x3 x3 x
3

  x+ 1

  0 y – by
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Ruler A ruler on a string controls formatting of that string so that the string 
behaves more like a paragraph in a word processor than a string in 
Expressionist.  Normally, there is only one ruler in an expression, 
attached to the main string in an expression window, but there are many 
ways in which additional rulers can be created.

To see the rulers that control your expression, turn on Ruler mode.  The 
ruler runs along the length of the string, measuring distance and 
presenting various controls over formatting such as tab stops.  
Independent rulers show measured gradations, tab stops and the right 
margin.  Lockstep rulers are invisible.

The ruler itself can be in a variety of units of measure; you can change 

this with the Units command on the Options menu.

The most visible effect of a ruler is that it does word wrapping.  If you 
keep typing into a string with a ruler, eventually the words will wrap 
around into a paragraph similar to a word processor.  Wrapping will 
happen among and between words and composites; words and 
composites themselves are never broken up.  Strings without rulers never 
wrap around and can become arbitrarily long.

Word wrapping will happen on the first equation element that extends 
past the right margin.  The right margin is marked by a square “handle” 
on the right side of a ruler.  If you can not see the handle, scroll the 
window.  To change the width of the ruler, you can drag the right margin 
marker to a new location.  If the marker is not visible because there isn’t 
enough text in the string yet, you can click at the right side of the ruler 
and drag that to a new location.

Along the length are displayed tab stops.  There are five different 
possible kinds of tab stops, represented by four different kinds of icons.  
When you see these icons along the ruler itself, they are tab stops in 
effect.  In addition, there are four example icons on the bottom of the left 
side of every ruler.  You can make new tab stops by clicking down on 
any of these icons and dragging to the approproate place on the ruler.  
You can move existing tab stops by clicking on an existing tab stop and 
moving it.

Further along on the bottom of the ruler are three icons, for left, center 
and right justification of the ruler.  You can click on these icons to change 
whether lines that are shorter than the margin width will be right justified 
or left justified or centered between the left side and the right margin.
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Ruler mode A mode where all rulers are visible.  You can turn Ruler mode on and 
off just like Guide and Magnify modes.  Click on the icon or use the 
keystrokes ÅÇßR or ª to toggle Ruler mode on and off.  Ruler mode and 
Guide mode are mutually exclusive; turning either one on turns the other 
off, although you can have both of them off at the same time.

sans serif font A sans serif font is one that is plain and has no serifs, like this.

Sans serif fonts are best for titles and labels, because they make a forceful 
impact.  Serif fonts generally make for more readable copy than sans 
serif fonts. 

This manual uses a serif font (New Century Schoolbook) for copy and a 
sans serif font (Optima) for headlines.

Save As 
EPS…            
menu command

This command on the File menu saves the current expression in an 
encapsulated PostScript file, with a name and location you specify.  The 
characteristics of this file are determined by the resolution setting in the 
Picture Format dialog.

Save As… menu 
command

This command on the File menu saves the current expression with a 
name and location you specify.  See expression file.

Save As 
Metafile…   menu 
command

This command on the File menu saves the current expression in a 
Windows Metafile format file, with a name and location you specify.

Save menu 
command

The Save item on the File menu saves the current expression.  If the 
expression is untitled, you are first asked for a name and location, like the 
Save As commmand.

screen fonts Screen fonts are special bitmapped fonts displayed on the screen which 
do not have outline font equivalents.

script To get script characters, you can use a script font, or you can try some of 
the italic versions of serif fonts.  The Park Avenue Adobe PostScript 
font is a nice script font.  Adobe Mathematical Pi #2 contains script 
letters and special characters such as script ell.

script ell , + The pseduocharacter ✌ is on the main palette.  Better versions are 
available in fonts such as Adobe Mathematical Pi #2.
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second partial  
derivative

 

See partial derivative.  It is basically the same thing with superscripts.  

There is a macro available on the  pop-up palette.

Select All  
Use the icon shown or press ÇA to invoke this command, which selects 
the entire expression displayed in the expression window, regardless of 
the current selection.

before

after

Select First 
Use the icon shown or press Ó or  to invoke this command, which  
selects only the first element within the current selection.  If the current 
selection is a multiple selection, Select First selects the first 
subexpression of each selection.

You can learn which element of a composite will be selected by Select 
First by looking at the composite’s palette button.  The “a” element is the 
first selected.  For example:

before after

Contrast this command with Select In.

Select In  
Use the icon shown or press ÇE or º to invoke this command, which  
makes multiple individual selections (if appropriate) from the current 
selection.

For example, if you select a matrix or a part of a matrix and choose   
Select In, you end up selecting each element individually.

It is most useful for entering matrix cells and indices.  For example:

   ∂2 y
∂x2
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before after

If the current selection is multiple, the result is all subexpressions in an 
even larger multiple selection.

Contrast this command with Select First.

Select Next

 

 

Use the icon shown or press ÇN or † to invoke this command, which 
selects the next element of the currently selected composite.

Select Next moves the selection around to similar strings on the same 
level, allowing you to type into each. For instance, if you have selected 
a subscript in a subscript/superscript composite, Select Next moves 
you to the superscript.  Select Next again gets you to the body.  A third 
invocation of this command selects the subscript again.

(If you have more components turned on than shown here, Select Next 

cycles through all of them.)  See also Escape.

If you have selected a matrix cell, Select Next selects the next cell in the 
row.  At the end of a row, it starts the next row at the beginning.  If you 
continually Select Next, it selects each matrix element in that matrix 
until it gets to the bottom right element, when it starts over again with the 
top left.

If the current selection is multiple, each one is treated individually.

You can learn a composite’s Select Next ordering just by looking at its 
palette button.  The “a” element is the first selected.  The “b” element is 
selected next, followed by the “c” element at the following Select Next.

Select Out Use the icon shown or press ßŸ or ⁄ to invoke this command, which   
selects the string or composite outside the current selection.  For         
example:
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before after again

Selecting To select subexpressions in your expression window, you can either click 
the mouse and drag, or you can use certain keystrokes.  See clicking and 
dragging for more information on what selections you can make with the 
mouse, or look through the Guided Tour chapter.

Tab moves the selection around in composites; it works the way it does 
in a dialog box.  Escape allows the selection to leave the current 
composite.

Holding down Shift modifies how the Escape key works:  it makes it 
Select Out.

The arrow keys move the cursor or selection around.  Holding down 
Shift with them selects things that would normally have been passed by.

See also multiple selections.

serif

 

A serif is one of those little cross strokes on the end of letter symbols in 
serif fonts.  Times New Roman font has serifs.  Arial font does not.

serif font A serif font is a font that has serifs.  Fonts without serifs are called sans 
serif fonts.  Serif fonts generally make for more readable copy than sans 
serif fonts.

This manual uses a serif font (New Century Schoolbook) for copy and a 
sans serif font (Optima) for headlines.

set of functions The script capital F character  is ß6 in Adobe Mathematical Pi #2.  
You may try F  in other script fonts.

set theory 
symbols

Many set operation symbols and macros are available from the ∪ pop-up 
palette.

sets {a, b, c} Enclose the items in braces.  Separate them with commas.  See also null 
set.

shadow frame See change frame.

Shift key ß
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The ß key on your keyboard is a modifier key that changes the effects of 
keystrokes and mouse clicks.  Most people are familiar with it as a way 
to get capital letters and the symbols above the digits, but there are many 
other things it can do.  See also Alt key, Control key, selecting, shift-
click, and tweak.

Shift-clicking Makes multiple selections.

shrink 

–
To shrink something, select it and click on the – palette button, or type 
Å9.  If you use it four times, the size will halve.  See also Enlarge, font 
commands, and size.

Do not confuse shrink with the magnifying glass, , which simply 
magnifies the display so you can see it better, without actually changing 
the expression or the way it prints.

size

aaaaaaa
Character sizes are measured from the descent to the ascent, in points.  
Character sizes in Expressionist can be any size from 1 to 127 points.  By 
default, they are one of the following sizes:

6 7 9 10 12 14 18 20 24

28 36 40 48 56 72 80 96 112 127

If you select a piece of any expression and click on the + palette button, 
every character selected enlarges by one step.  Similarly, the – palette 
button shrinks the current selection by one step.  Every character is 
adjusted individually, so the overall proportions of the expression remain 
the same (unless you shrink or enlarge too much, see below).

Notice that four steps usually means a factor of two.  Each step is pretty 
small.  Usually, you will want to click on + and – two or four times in a 
row to achieve your desired results.

When you go too large or too small, Expressionist stops enlarging or 
shrinking the characters; they stay at the maximum or minimum sizes.  If 
this happens, relative size information is lost.

The set of sizes is determined by the Default Font and Character Size 
Steps options.  The defaults are listed above.  The only strict rule is that 
four steps equals a factor of two.

slashed
fraction

See fraction.

space Use the ˙ bar or press ÅßS or ÅßT to make a thin space for finer 
adjustments.
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spacing Expressionist has many options and adjustments to control spacing.   
Spacing adjustments are available for marks, subscripts, and 
superscripts.  Various quantization options are available for fences, 
frames, and integrals.

To add space vertically to something, add blank lines in a matrix.  For 
instance, add space to the top by selecting a caret at the beginning of a 
string, and press œ.  Add space at the bottom by selecting a caret at the 
end of the string and pressing œ.

To add space horizontally, use the ˙ key to insert one or more spaces.  A 
thin space (ÅßS or ÅßT) can be used for fine spacing adjustments.

Space characters and thin spaces are shown as dots in Guide mode.

The Picture Border option adds space around equations to avoid 
clipping problems.

square To enter a square character into your expression, see quad and 
rectangle.  See also frame.

square root To take the square root of something in Expressionist, do this:  select it 

with the mouse, and click on , or type ÇR.  See also root.

string A string, in Expressionist, is a horizontal sequence of characters or 
composites.  It can be edited by the normal rules of clicking and typing 
text (see clicking, selecting, typing).

When guide mode  is on, you can see an outline of each string.  
When ruler mode is on, you can see the rulers for those strings which 
have them.  See also string selection and change string.

string selection A string selection, in Expressionist, is a selection analogous to a 
selection in a word processor.  A horizontal selection of characters and/
or composites are selected.  Each selected element is highlighted:

If you click between two elements, the selection becomes a blinking 

caret, just like in a word processor.  If you click exactly in the middle of 
a character, though, Expressionist selects that character for you as if you 
dragged over it.  This can be very handy if your expression has lots of 
independent characters that you move around a lot.

  x 2 – 1
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When you have a string selection, whatever you do applies to that 
selection.  If you make a FontSizeStyle change, you will change the font, 
size and style of everything in the selection.  

If you Paste or start typing, what you Paste or type replaces the 
selection.  (A blinking caret, of course, has nothing to replace in it, so 
whatever you Paste or type is simply inserted.)

If you click on an icon button on the palette that generates a composite, 
what you selected becomes the first element of the new composite.

You may have no more than one multiple selection per string.

style
m m m m  

“Styles” are minor changes to fonts to create a different look.  The styles 
available with Expressionist and Windows fonts are bold, italic, 
underline, and vertical squeeze.  To change the style of text, click the 
FontSizeStyle box, , click on the appropriate 

check boxes, and press œ.  In addition, there are buttons to change to bold 
and italic, and back to plain style, on the palette.  Also, you can use ÇP 
for Plain, ÇB for Bold, and ÇI for Italic.

Note that the personal computer concept of “style” is an 
oversimplification of the typographer’s stylistic variations between 
typefaces in a font family.  Typographers generally sculpt different 
versions of their fonts with variation names like bold, italic, demi, 
oblique, light (opposite of bold), ultra light, narrow, et cetera.  Some of 
these are available depending upon the fonts you are using.

For instance, when you italicize a character, it sometimes merely gets 
drawn at a slant on the screen.  In optimal situations, italic characters 
have their own custom-sculpted font for the new style, which looks 
vastly better.

subexpression A subexpression is any part of an expression.  You can select a 
subexpression in Expressionist  by clicking and dragging the mouse 
over it.

subscripts To get a subscript, select what you want to have a subscript attached to, 

click on , type what you want in the subscript, then press Escape.  If 
you are addicted to the keyboard, ÇL will attach a subscript to the last 
thing typed.  See also tensor and subscript/ superscript composite.

  Times New Roman 12 iv

  A0



Encyclopedia

215

subscript/ 
superscript 
composite

This is what you get when you click on superscript , or subscript 

, or  subscript/superscript , or any keystroke combination that 

yields a similar structure (excluding tensors).  Even the summation and 
pi product macros are variations of this composite.

A subscript/superscript composite is a complicated thing.  It consists of 
a “base” (the U in the picture at left) with many optional parts attached 
to it:

Prescripts:  

Underscripts and Overscripts:  

Subscripts and Superscripts:  

Afterscript:  

Each of them is optional and can be used independently of the others.  
For instance, a subscript is made with only the “subscript and 
superscript” part, and the superscript is left blank.

A summation is made with an underscript/overscript and an afterscript, 
with a ∑ in the base.  The afterscript becomes the “summand.”  When a 
subscript/superscript composite has an afterscript, the base is drawn 
larger in the anticipation of a summation or similar expression.

To turn on and off each part, select the whole structure and change.  
subexpressions will be resized automatically if they are moved around, 
just as though you were cutting and pasting them.

The font, size, math axis, etc. of the subscript/superscript composite is 
taken from the first element, which is the afterscript, if present, or the 
base otherwise.

See also change subscript/superscript.

Subscripts, 
Superscripts, & 
Summation 
adjustments

This command on the Options➧Adjustments submenu brings up a 
dialog that allows you to change characteristics of Subscript/ 
Superscript composites and Tensor composites.  Since summations 

 He2
3
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2
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and subscripts and superscripts are all made from Subscript/
Superscript composites, this dialog also controls them, too.

The Subscript and Superscript relative sizes control how much smaller 
subscripts and superscripts are than the afterscript or, if there is no 
afterscript, the base.  It also controls the sizes of overscripts, underscripts 
and prescripts, and the sizes of subscripts and superscripts for tensors.  
Normally, two to four sizes smaller is best.

The Sigma and Pi Product character relative sizes controls the size of the 
base relative to that of the afterscript, if there is an afterscript.  (If there 
is no afterscript, the base is normal size.)

The separation and height of both the superscripts and subscripts is 
controlled by the four popup menus on the right.  For instance, if you 
think that superscripts are too close to the base, increase the superscript 
separation.  If you think that subscripts are too high, decrease the 
subscript height.  The height settings also affect the heights of prescripts 
and the indices for tensors.  The separation settings also affect the 
separation for the first index of tensors.

subset
⊃   ⊄ ⊂ ⊆ ∈

Many set operation symbols and macros are available from the » pop-up 
palette.

subtraction Subtraction is the inverse of addition.  Type a minus sign.

such that
:

To get a “such that” symbol, just use a ß; colon.
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sum A sum is the result of adding two numbers together.  See summation and 
addition.

summation A summation is for adding lots of similar things together.  For instance, 
the example shown to the left is for adding the numbers from 1 to 100.

To make a summation, use the  macro button on the palette.  This 

inserts a macro consisting of the subscript/superscript composite 
changed to have an overscript, underscript, and afterscript.  You can use 
the subscript, superscript , & summation adjustments to set the 
relative size of the sigma.

superscripts Superscripts are things written smaller and slightly above the normal line 
of writing, like this.  They usually come after something that they apply to, 

just like subscripts.  To make a superscript, click on  , type in what 
you want up there, then Escape.  Or if you prefer the keyboard, ÇH will 
put a superscript on whatever preceded the blinking caret when you 
typed it.  See also subscript/superscript composite.

Super Untweak
To remove all  tweaking within a selection, choose  from the  
pop-up palette.  (You can also Super Untweak a tweaked selection by 
pressing Çß¿ or Çß˜.)

Also see Untweak, which is a more precise tool.

support See the page entitled Support near the end of this manual.

Symbol font
Σψµβολ

Symbol font is one of the original four PostScript fonts, available on all 
PostScript output devices.  It is a TrueType font included with Windows 
3.1  As its name implies, it is a font full of mathematical symbols and 
Greek letters.  The Greek letters are in place of the normal alphabetic 
characters; most of the more interesting mathematical symbols are 
accessible using the palette or the Insert Something command.  See 
Appendix A for a listing of the symbols and characters in Symbol font.

T palette button Changes the selection to the Times New Roman font.

tab key
†

The † key does a Select Next, but you can use the Keystroke Definitions 
dialog to configure Tab to move the cursor to the next tab stop, as 
determined by the ruler.  Expressionist is normally set to use ß† to move 
to a tab stop.  (See tabs and tab stops.)

tabs

   nΣ
n = 1

100

  B2
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Special pseudocharacters that cause text in a string with a ruler to align 
at tab stops.

To insert a tab, do one of the following:

• Type the keystroke ß†

• Use Insert Something and choose the character three rows above the 9

The † key does not insert a tab because it is defined to do the Select Next 
command.  You can redefine this any way you want with the Keystroke 
Definitions dialog.

When tab stops are not in effect, such as when they are in a string without 
a ruler or in a string with center or right justification, tabs simply act like 
wide spaces.

tab stops Icons on rulers that control the formatting of the text inside when there 
are tabs in it.

There are five kinds of tab stops:

• left justified, represented by the  icon

• center justified, represented by the  icon

• right justified, represented by the  icon

• decimal point justified, represented by the  icon

• equal sign justified, represented by the  icon

They work similar to the way they work in word processors.

You can see the tab stops on a ruler by turning on Ruler mode.  You can 
move them around by simply clicking and dragging.  You can make new 
ones by clicking and dragging from the example icons on the left side of 
the ruler.  You can remove them by dragging them away from the ruler.

technical 
support

See the page entitled Support near the end of this manual.
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tensor 
composite

A tensor composite is what you should use to represent a tensor with 
raised and lowered indices.  To make one of these in Expressionist, click 

on .  (Do not confuse it with , which gives you a subscript/ 
superscript composite.)   Select Next (press †)and fill in the blanks.

The editing commands Lower, Raise, New Field, and Delete can be 
used on tensor indices.

See also change tensor.

tera
Τ

This prefix means multiply by 1012.

TEX Pronounced “tek”, this is one of the most well-known mathematical 
typesetting markup languages.  For more information on how to use 
Expressionist with TEX, see the Copying as Text and Working with 
TEX sections.

text To make text, just type it in.  Returns inserted in text will split a string 
into a matrix of two strings (one on top of the other), so it works as much 
as possible like a word processor.

Pressing Enter in the middle of one of the strings will break that string 
into more strings.  Backspace at the beginning of a string in a matrix will 
join it with the one above.

The outer-most string in an equation usually has a ruler and so it will 
automatically word wrap.  It is left-justified by default.  Strings inside 
expressions usually have no ruler.  You can Change this.  To change 
characteristics of a paragraph, turn on Ruler mode.  To make a string 
align along its baseline instead of its math axis, select the entire string 
and change.

If Expressionist  recognizes a function name as you type with the Auto 
Spacing option on, it separates it with spaces.  (E.g., “Stanley went to the 
exposition ” becomes “S tan ley went to the exp osition”.)  If you do not 
want functions separated like this, delete the surrounding spaces.

there exists
∃

This Symbol font character is available on the ∀ pop-up palette.

therefore
∴

This Symbol font character is available on the ∀ pop-up palette

 Γµ
νκ

 numberof deductionswith
greaterthan 50% certainty
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theta
θ Θ ϑ

This Greek letter is usually available only in full Greek fonts.  θ is on the 
a pop-up palette.  Θ and ϑ are on the ∆ pop-up palette.  The keystrokes 
ÅÇQ and ÅÇßQ were redefined to insert the θ and Θ characters from the 
Symbol font.  The alternate ϑ form is ÅÇßJ.

thin space Thin space is useful for “fine-tuning” the horizontal space in your 
expressions.  A thin space is about one quarter of the size of a regular 
space created by the space bar.  You can insert one with ÅßS, ÅßT, or 
the palette button.  (See below for its location on the palette.)

The arrow pointer on the palette’s thin space button

The thin space icon is 
blank.

The arrow pointer on the Insert Something dialog’s thin space button

See also space.

This Character See Insert Character for information on this button on the Insert 
Something dialog.

This Composite
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See Insert Composite for information on this button on the Insert 
Something dialog.

This Macro See Insert Macro for information on this button on the Insert 
Something dialog.

tilde
To put a tilde mark on top of anything select it and click on , or press 
Çßª.  See also Change mark.

To make a tilde on its own, just type it in from the keyboard.

Times font Times font is a PostScript font.  It’s a very common font which got its 
name from the London Times, which originally contracted for its design 
in the 1930’s.  It was designed by Stanley Morison and Victor Lardent in 
1931.  This sentence is in Times font.  Imitations come under names like 
Times New Roman or New York.

Times New 
Roman font

Times New Roman is an imitation of the Times font.  It is a TrueType 
font supplied with Windows 3.1.

Top & Bottom 
fences

Fences have an option whereby they can be changed to be on top and on 
the bottom instead of left and right.  See change fence for more details.

Top Justification In strings and matrices, where there may be several items grouped 
together with different heights, specifying this means to make sure that 
the tops of all items line up along the top of the available space.

 

math axis justified matrix top justified matrix

Translation 
Browser

This command on the Options➧Copying submenu brings up a dialog 
that allows you to modify the current Copy As Text translation table.  
For information on how to use this dialog, see the Copying as Text 
section of this manual.

Translation Table This command on the Options➧Copying submenu brings up a dialog 
that allows you to choose which Copy As Text translation table to use. 
This table will be used if you do a Copy with the Copy as Text setting 
chosen.  Also, you can modify this table by choosing Translation 
Browser from the Options➧Copying submenu.

  a
b

y1 x 2   a
b

y1 x 2
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transparent 
background

This special background color option on the Edit➧Background submenu 
is useful for pasting equations into draw programs or presentation 
programs with colored backgrounds.

Transparent background on grey White background on grey

transposet To represent the transpose of matrix, use a small, lower case letter t as a 
superscript.

tree node A tree node is a composite that allows you to draw “org chart” style 
hierarchy diagrams.  You can create a tree node by clicking on one of the 
tree palette buttons.

Each instance of a tree node has a parent string and one or more child 
strings.  Each child string can hold anything a normal Expressionist 
string can hold, including another tree node for the next level of the 
hierarchy.

The editing commands Lower, Raise, New Field, and Delete can be 
used on tree children.

See also change tree.

TrueType A font technology developed by Apple and Microsoft and utilized by 
Apple’s System 7 and Microsoft’s Windows 3.1.  It uses outline 
descriptions of characters to provide sharp, accurate, good-looking 
renderings on the screen and high-quality printed characters on non-
PostScript printers.

truncate See floor, ceiling.

The tweak function is a way to adjust parts of your expressions.  With it, 
you can take any character, string, composite or complete 
subexpression, and move it tiny amounts up, down, left or right.

f(x) f(x)

  Latin

Ital . Span .

  =

sin
–

90 x

cos
x

 tweak
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First, select the subexpression you want to tweak.  Then, hold down the 
Ç key and move the cursor over the subexpression to be tweaked.  Now, 
click down on your expression.  Your selection will be surrounded by 
concentric rectangles.

If you drag the cursor around, the rectangles will move.  And if you look 
closely, your selection will move a tiny amount, too.  In fact, your 
selection will move exactly 1/16 as much as the mouse moves.  You can 
examine the result by letting go of the mouse.

You can also tweak by holding down the Ç key and pressing the arrow 

keys (¯˘¿˜), or by choosing the tweak buttons on the  pop-up palette.  
Each press moves the selected expression one pixel.  See also Untweak 
and Super Untweak.

typing When you press keys in Expressionist, the characters usually get inserted 
in the current font, size and style (as shown in the FontSizeStyle box).

Expressionist allows you to completely redefine the keyboard with the 
Keystroke Definitions dialog.  By default, normal keys (including those 
with Shift) insert normal characters as in a word processor.  With the 
Control and Alt key, most letter keys insert Greek letters.  With the 
Control key, various editing commands are invoked.

Delete clears the selection.  Backspace clears the selection and/or 
backspaces as in a word processor.  Enter breaks up the line you are 
typing into matrix rows.

Tab, Escape, and the Arrow keys (¯˘¿˜) all move or change the 
selection.  For more information on them, see selecting.

You can do almost anything that you need to edit equations through the 
keyboard.  For an example of how to type in a complicated equation 
entirely from the keyboard, see the Antenna example in the Tutorial 
Equations section of this manual.

underba 
Make an overbar and Change this mark.

Underline style You can underline characters by selecting them, and then clicking on 
the FontSizeStyle box .  Set Underline to 

ON, then press œ.

 x

  TimesNewRoman 12 iv
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Underscripts/ 
Overscripts

A subscript/superscript composite is a complicated thing.  It has many 
optional parts to it.  One part is the underscript and overscript, which is 
used to make summations, among other things.  To turn on and off the 
underscript and overscript, select the whole composite and Change.

See also Change subscript/superscript, subscript/superscript 
composite.

Undo The Undo command (also on the Edit menu, or press ÇZ or Åø) will 
undo the most recent change (or changes) to the current expression.  In 
some cases, it may undo more than one of the recent changes you have 
made.  Using it again will redo whatever was undone.

union
∪

This Symbol font character is available on the ∪ pop-up palette.

units To make different units, just type them in as text.   Do not use italics.  To 

represent the Greek letter mu, µ, which means “micro” or , use 
ÅÇM.

Units menu 
command

This command on the Options➧Copying submenu brings up a dialog 
that allows you to change the units with which Rulers are displayed.  
You have a choice among metric, English and common typesetting units.

Unmark 
This is a special editing command that is very handy for removing marks 
or other composites from around subexpressions.  It got its name 
originally because it was a mark removing command.  For instance, if 

you had , you could remove the vector on top by selecting the H and 
clicking on Unmark.  Since then it has been improved to be capable of 
removing all sorts of composites on multiple selections      
simultaneously.

 
A
c

b

 
1 1,000,000th1 1,000,000th

 H
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For instance, if you have the expression  and you select the 2 and 
choose Unmark, the result will simply be the 2.  If instead you select the 
3, the result will be 3.  If you shift click to select both the 2 and the 3, the 
result will be 23.  In general, the result of an Unmark is just what you 
selected, having been extracted from the composites they were a part of, 
and replacing those composites, which are deleted.

Unmark can remove multiple levels of composites simultaneously.  For 
instance, if you have the expression

and you select the x2 and the dx by shift-clicking, then choose Unmark, 
the result will be x2dx , with the integral, fraction and root all being 
eliminated by the Unmark command.  If instead, you had selected the x2 
and the x  in the numerator of the fraction, only the root and the fraction 
would have been eliminated and the integral would have been left intact.  
To remove that, you could simply click on Unmark again.

Untweak To remove a specific tweaking within a specific selection, choose  

from the  pop-up palette.  You can also hold down Ç and ß and click 

on the tweaked selection, or press any of the arrow keys ¯˘¿˜.  (You can 
also Untweak a tweaked selection by pressing Çß¯ or Çß˘.)

Also see Super Untweak, which is easier to use because it is less picky 
about the tweaking within the selection.

upsilon
υ Υ ϒ

This Greek letter is usually available only in full Greek fonts.  u is on the 
a pop-up palette and ϒ is on the ∠ pop-up palette.  The keystrokes ÅÇU 
and ÅÇßU insert the υ and ϒ characters from the Symbol font.

variable A quantity included abstractly in an equation.

Scalar variables should be italicized.  Vector variables should be in 
boldface, or they should have a vector mark at the top, or should have 
subscripts.  Tensor variables should be in a sans serif font, probably 
Arial or Helv, unless they have a dyad or subscripts or superscripts.  
Use only one mechanism at a time to represent the property of being a 
vector or tensor, for example:  .

 23

  x
1 – x 2

dx
0

1

    A ≡ A ≡ Ai
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vector mark To create a vector mark (with an arrow above the character), select your 
character and type Çß¢ .  See also Change mark.

vector matrix A vector matrix is a matrix where one of the dimensions is 1.  Also 
known as a column matrix.

vertical fraction To make a vertical fraction, select what you want to be in the numerator, 
and click on .  A fraction will be created, and the denominator will be 

selected so that you can type in what should go down there.  You can also 
type ÇF.  See also diagonal fraction and division.

Vertical Squeeze This style variation causes a change in the proportions of characters and 
words.  With this on, Expressionist  actually takes into account where 
the ink falls for a particular character, instead of just the normal character 
cell.  In addition, the extra width of italic characters will more correctly 
be accounted for.

With Vertical Squeeze Without Vertical Squeeze

In general, you should keep Vertical Squeeze on unless it causes uneven 
alignment problems.  Even if it does, it is probably better to fix such 
problems with Magic Alignment rather than turning off Vertical 
Squeeze.

wedge
^

See caret.

Wingdings Wingdings is a TrueType font containing a variety of dingbats (that is 
type-talk for bizarre symbols).

Word, Microsoft For details on how to use Expressionist  with a word processor, see the 
Working with Expressionist  section.  For details on how to use 
Expressionist  with Microsoft Word in particular, see the section’s 
Companion Applications chapter.

word processing For details on how to use Expressionist  with a word processor, see the 
Working with Expressionist section.  For details on how to use 

 A

  0
q

– pq

  a + b
c + d

  x 2 X 2 x X   x2 X2 x X
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Expressionist  with a specific word processor, see the section’s 
Companion Applications chapter.

words Words are sequences of characters that all share the same:

• font • size • style • color • tweaking

• state of being alphabetic ( in other words, “123abc” is two words)

You can select a word by simply double clicking on it.  You can select 
any sequence of characters within a word.  You can select an entire word 
along with other elements.  You can not, however, select a part of a word 
along with neighboring elements; you will end up including the whole 
word.

x-height The height above the baseline of lower case letters that do not have 
ascenders.  For example, b, d, f, h, and k  all have ascenders, but a, c, s, 
g, m, and n  only reach as high as the x-height.  See also math axis.

xi
 ξ Ξ

This Greek letter is usually available only in full Greek fonts.  ξ is on the 
a pop-up palette and Ξ is on the ∆ pop-up palette.  The keystrokes ÅÇX 
and ÅÇßX insert the ξ and Ξ characters, respectively, from the Symbol 
font.

zeta
ζ Ζ

This Greek letter is usually available only in full Greek fonts.  ζ is on the 
α pop-up palette.  The keystroke ÅÇZ inserts the ζ character from the 
Symbol font.

baseline

ascent

Age
descent

x-height
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APPENDIX A:

Selected Fonts & Characters

This Appendix lists several fonts and all printable characters within 
them, arranged in a 16×16 grid the way they appear in the Insert 
Something dialog.  (See the Encyclopedia for more information.)  Use it 
to locate specific symbols which may not appear on Expressionist’s 
palette.

The six Mathematical Pi fonts are from Adobe Systems.  (They are 

Mathematical    
Pi 1

included in a single font package.)

Mathematical Pi 
2

 

?
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Mathematical    
Pi 3

Mathematical    
Pi 4

Mathematical    
Pi 5

 

?

 

?

 

?
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Mathematical    
Pi 6

Symbol

 

?

 ! ∀ # ∃ % & ∋ ( ) ∗ + , − . /
0 1 2 3 4 5 6 7 8 9 : ; < = > ?
≅ Α Β Χ ∆ Ε Φ Γ Η Ι ϑ Κ Λ Μ Ν Ο
Π Θ Ρ Σ Τ Υ ς Ω Ξ Ψ Ζ [ ∴ ] ⊥ _

 α β χ δ ε φ γ η ι ϕ κ λ µ ν ο
π θ ρ σ τ υ ϖ ω ξ ψ ζ { | } ∼

ϒ ′ ≤ ⁄ ∞ ƒ ♣ ♦ ♥ ♠ ↔ ← ↑ → ↓
° ± ″ ≥ × ∝ ∂ • ÷ ≠ ≡ ≈ …   ↵

ℵ ℑ ℜ ℘ ⊗ ⊕ ∅ ∩ ∪ ⊃ ⊇ ⊄ ⊂ ⊆ ∈ ∉
∠ ∇    ∏ √ ⋅ ¬ ∧ ∨ ⇔ ⇐ ⇑ ⇒ ⇓
◊ 〈    ∑          

〉 ∫ ⌠  ⌡         
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Times New 
Roman
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APPENDIX B : Greek 
Letters 

The following is a list of letters in the Greek alphabet, in Greek alphabetical 
order.  The table lists the keystrokes you can type to insert the Symbol font 
characters.

Lower Upper
Upper Lower Name Pronunciation Keystroke Keystroke

Α α alpha al-fa ÅÇA n/a
Β β beta bay-ta ÅÇB n/a
Γ γ gamma gam-ma ÅÇG ÅÇßG
∆ δ delta del-ta ÅÇD ÅÇßD
Ε ε epsilon ep-sil-on ÅÇE n/a
Ζ ζ zeta zay-ta ÅÇZ n/a
Η η eta ay-ta ÅÇH n/a
Θ ϑ θ theta thay-ta ÅÇQ ÅÇßQ
 Ι ι iota eye-oh-ta ÅÇI n/a
Κ κ kappa cap-pa ÅÇK n/a
Λ λ lambda lam-da ÅÇL ÅÇßL
Μ µ mu mew ÅÇM n/a
Ν ν nu new ÅÇN n/a
Ξ ξ xi zye ÅÇX ÅÇßX
Ο ο omicron ow-mik-ron ÅÇO n/a
Π π pi pie ÅÇP ÅÇßP
Ρ ρ rho row ÅÇR n/a
Σ σ sigma sig-ma ÅÇS ÅÇßS
Τ τ tau taow ÅÇT n/a
ϒΥ υ upsilon up-sil-on ÅÇU ÅÇßU
Φ φ ϕ phi fye ÅÇF ÅÇßF
Χ χ chi chye ÅÇC n/a
Ψ ψ psi sigh ÅÇY ÅÇßY
Ω ωϖ omega ow-may-ga ÅÇW ÅÇßW

For the upper case Greek letters with keystrokes listed as not available 
(n/a), just use the Roman equivalents, which look the same.

The optional theta, ϑ, is ÅÇßJ.  The optional phi, ϕ, is ÅÇJ. The optional 
omega, ϖ, is ÅÇV.
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APPENDIX C:                     
MATH SYMBOLS

The following is a sampling of mathematical symbols and their names.   
For more details, look them up in the Encyclopedia section.  In many 
cases, an example of use is given rather than simply presenting the 
symbol alone.

∞ infinity • dot
– minus ≠ not equal
± plus-or-minus 57° degrees
~ proportional to || parallel
… ellipsis : such that
. point ≥ greater than or equal to
< less than , comma
/ divided by ÷ divided by
≈ approx. equal to ∫ integral
¬ not ∂x/∂y partial derivative
† cross { } braces
[  ] brackets (  ) parentheses
〈   〉 angle bracket 17! factorial
≅ approx. equal to α  α floor, ceiling
∃ there Exists ∀ for All
⊥ perpendicular ∠ angle
* star y′ prime
↑ ← → arrows ⇓ ⇒ ⇑ arrows
∨   ∪ union, or ∧   ∩ and
⊃   ⊂ subset (proper)     ⊆ subset
⊄ is not subset ∈ member of
∉ is not a member of ∅ empty set
∇ del, gradient ℵ aleph
≡ defined as ∝ proportional to
× times, cross product ∴ therefore
∀ Planck’s constant , script ell
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APPENDIX D:  COMPOSITES

Expressionist includes these basic composites:  Fence, Mark, Script, 
Tensor, Fraction, Root, Long Division, Overstrike, Frame, Integral, 
Tree, and Matrix.  This appendix lists the composites and the Change and 
Adjustment options available for them.

Look up the composite names in the Encyclopedia section for additional 
information.
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Fences Buttons available from the Insert Something dialog are:

Examples Parentheses , Curly braces , Angle brackets , Absolute , 

Double bars , Square brackets , Reverse square brackets , 

Hollow square brackets , Floor , Ceiling , Curly top brace , 

Changes and Curly bottom brace .

 a  a  a  a

 a  a  a

 a  a  a a

a
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Adjustments
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Fractions Buttons available from the Insert Something dialog are:

Examples Vertical , Diagonal 

Changes

Adjustments

a
b a

b
a

b
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Frames Buttons available from the Insert Something dialog are:

Examples

Changes

Adjustments None

  Solve the following equations.
Show all work.

 dA = areaof the region.
region
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Integrals Buttons available from the Insert Something dialog are:

Examples

Changes Maximum number of signs is eight.  The “for In-Line equation” option 
shortens the sign so the equation better fits in a line of text.

   Pv
−

0

∞

   ctgnx

∆ dx    x − t
−1

1
   cos2θ

r = 1

r = 5    

θ = 0

θ = 2π

r= 0

r= R

z=0

z=h

    F ⋅ d x
γ

  dx dy
E
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Adjustments The interspace is the space between the integrand and the sign.
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Long Division                       The only button available from the Insert Something dialog is:

Examples Long Division

Changes None

Adjustments None

 
108423

47

92
164
161

3
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Marks Buttons available from the Insert Something dialog are:

Examples Dot , Double dot , Triple dot , Vector , Back vector , Dyadic 

vector , Bar , Double bar , Tilde , Circumflex , Arc 

Changes

Adjustments ]

a a a a a

a a a a a a
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Matrices Buttons available from the Insert Something dialog are:

Examples

Changes

Adjustments None

  a b

c d

  z1 a 11 a 12 a 13
z2 a 21 a 22 a 23
z3 a 32 a 32 a 33

   T 0 ,0 ,1 = −1 , 4

= −1
4

 1 , 1 1 , 2 1 , 3

2 , 1 2 , 2 2 , 3

3 , 1 3 , 2 3 , 3
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Overstrikes The only button available from the Insert Something dialog is:

Examples Overstrike , tweaked overstrike 

Changes None

Adjustments None

OX λ–
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Roots Buttons available from the Insert Something dialog are:

Note the only difference is one button inserts the structure with the “b” 
box blank.

Examples
Root , Square root 

Changes None

Adjustments

 a
b

 a
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Scripts Buttons available from the Insert Something dialog are:

Note the only differences between the structures inserted by these 
buttons are the blank boxes; they all use the same composite with 
subscripts and superscripts.  Also note the afterscript should be used only 
with forms such as the summation below.

Examples

Changes

Adjustments

 x 2
 x2  x2

2
   xnΣ

n = 0

∞
   xnΣn = 0

∞

  U92
238  Γγ

αβ
 eα

(1)
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Tensors The only Tensor button available from the Insert Something dialog is:

Examples

Changes The maximum number of indices is fourteen;maximum contravariants is 
seven.  You can avoid the change dialog and add indices with New Field, 
Delete indices, and Raise or Lower them.  See Encyclopedia entries. 

Adjustments Though a separate composite, the Tensor uses the subscript and 
superscript adjustments for relative sizes and separation.

  Gµ
ν; µ   Rλ

µ
ν

κ
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Trees Buttons available from the Insert Something dialog are:

Examples

Changes The maximum number of children is fourteen.  You can avoid the change 
dialog and add children with New Field, remove children with Delete or 
Backspace, and Raise or Lower them.  (See Encyclopedia entries.)

Adjustments None

 A
B C

D E
 ab c d

 a b
c

d

e
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REFERENCES

CRC Handbook of Chemistry and Physics, (revised yearly).  The CRC 
Press, Inc.  Look up “Mathematical” for some information on equation 
typesetting.

Style Manual, Third Edition, 1978.  American Institute of Physics.  Lots 
of advise in general on technical document preparation.  Meant as a style 
guide for Physics journal articles.

Mathematics into Type, Revised Edition, 1979.  American Mathematical 
Society.  A document with intent similar to the AIP Style Manual, this 
book has more information in some areas, and less in others.
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SUGGESTION FORM

Photocopy this form and use it to report incompatibilities, bugs, 
inaccuracies in the documentation, or to just suggest a feature you would 
like to see added in a future version.  We thank you in advance for your 
help in making Expressionist a better product.

You must be a registered user to receive technical support.

                                

_________________________      EW-________________________

Name   Serial number (last 9 digits)

           

__________________________     ___________________________                                   

AddressPhone or Fax number(s)

_______________________________    _______________________

City, State, and Zip or Postal CodeCountry 

This happens (check all that apply):

qIn the applicationqIn the documentationqOn the printout

qwhile using it with (other application program & version #):

_______________________________________________________

Computer make and model:

_______________________________________________________

Processor/co-processor:  ______________Windows version:  ______

Display driver:  ______________RAM memory: ___________

(minimum 2Mb required)

Description of problem or suggestion (please describe the problem in as 
much detail as possible on a separate page if necessary.  What goes 
wrong?  What steps did you take to make the bug appear?  Did the bug 
appear just once, or repeatedly?):

_______________________________________________________
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_______________________________________________________

_______________________________________________________

_______________________________________________________

_______________________________________________________

_______________________________________________________

Send to:  Waterloo Maple Inc., 450 Phillip Street, Waterloo, ON N2L 5J2
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A

About Expressionist 131
absolute value 131
addition 131
adjustment options 141
Adobe Type Manager 131
afterscript 131
Aldus 79
all, for 132
all, select see Select All
alpha 132
Alphabetics 132
Alt key 28, 40
AMS 132
AMSTEX 132
and 132
angle 132
angle brackets 132
application 133
approximately equal to 133
area 133
array 133
arrow keys 30, 63, 133
arrow symbol 133
ascender 134
ascent 134
astrological symbols 141
Auto Spacing 65, 141
auto-align 75

B

B palette button 32, 141
background 39, 134
backselect 65, 66
backspace key 134
bar 141

baseline 135
becomes 135
beginner 135
beta 135
binomial coefficient 135
bold style 32, 135
bottom justification 135
boundary of a set 136
box 135
bra’s 135
braces 136
brackets 136
bra-kets 135
bug 136
built-up fraction 136
button 136

C

caret 38, 136
CAT 136
CAT file 141
ceiling 137
center-justified 76
centi 137
Change 59, 140
Change Character 138
Change Fence 60, 138
Change Font 145
Change Fraction 139
Change Frame 139
Change Mark 141
Change Matrix 142
Change String 141
Change Subscript/Superscript 144
Change Tensor 145
Change the Font… 145
Change Tree Node 146
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character 31
character size steps 148
charge 149
chi 149
circumflex 149
Clear command 149
clipboard 150
close box 150
Close menu command 150
Color Buttons 150
column 63, 151
combinatorial 151
composite 151
congruent to 151
conjugate 151
contour integral 151
contravariant indices 151
Control key 28, 40, 151
Copy 43, 71, 152
Copy as 152
Copy as Text 152
Copying 152
covariant indices 153
cross 154
cross product 153
Ctrl key see Control key
cube root 153
current expression 153
current selection 153
cursive l see script ell
cursor 47, 153
Customer Support 154
Cut 43, 154
Cutting and Pasting 36
Cyrillic characters 154

D

D palette button 32
Default Font 11, 154
default font 32
defined as 154
degrees 155
del 155
Delete key 155
delta 155
derivative 155
descender 155
descent 75, 155
desktop publishing 78
determinant 155
diagonal fraction 155
diamond 156
differential 156
dimension of vector space 156
dimensions 156
directional derivative 156
disk 6
distance between points 156
division 156
Do Something Else 157
dot 157
dot dot 157
dot dot dot 157
dot product 157
double clicking 157
double-clicking 31
dragging 30, 41, 157, 158
dyadic vector 158

E

e 158
Eigenvectors 61
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ell see script ell
ellipsis 158
empty set 158
Encyclopedia 130
Enlarge 33, 159
Enter key 159
epsilon 159
eqn 159
equation 159
equation number 159
equivalent 159
Escape key 159
escape levels 65, 66
eta 159
evaluate at 160
examples 160
exists, there 160
exponent 160
expression 160
expression file 160
expression window 29, 160

F

factorial 160
femto 160
Fence 160
Fence Adjustments 160
fence composite 60
file 162
File menu 162
Find & Replace 162
font 163
Font buttons 30
Font Commands 57, 163
FontSizeStyle box 31, 40, 54, 165
FontSizeStyle dialog 165
for all 167

fraction 36, 167
Fraction Adjustments 167
frame 168
French brackets 168
FSS box see FontSizeStyle box
functions 168
Functions List 168

G

gamma 169
German letters 169
giga 169
Gothic font 169
gradient 169
greater than 169
greater than or equal to 170
Greek letters 40, 47

typing 40
guide box 37
Guide mode 38, 170

H

hat 170
Hebrew 170
Help 171
Helvetica 171
hyphen 171

I

I palette button 33, 171
icon, application 171
icon, button 171
imaginary 171
Independent Ruler 171
infinity 55, 171
in-line equations 75
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Insert Composite 171, 172
Insert Index 173
Insert Macro 173
Insert Something 55, 173
Installation 174
integral 174
Integral Adjustments 174
intersection 174
inverse 175
iota 175
is 175
Italic style 175
italic style 33

J

justification 175

K

ket 176
keyboard shortcuts 55
Keystroke Definitions 176
Keystrokes 130
keystrokes 28, 177

tutorial 59, 65, 66, 67
kilo 177

L

lambda 177
lambda-bar 177
Laplacian operator 178
LATEX 178
left justification 178
less than 178
less than or 178
limit macro

tutorial 55

Lockstep Ruler 178
long division 179
loop integral 180
loop l (ell) 179
Lotus 80
Lower 180

M

macro 55
Macro Definitions 180
macros 180
Magic Alignment 66, 182
Magnify mode 34, 39, 182
main palette 183
margin 77
mark 183
Mark Adjustments 184
markup language 185
math axis 75
Math Axis, The 185
Mathematical Pi 185
matrices 185
Matrix

tutorial 49
matrix 185
matrix selection 185
mega 186
Metafile 78
micro 186
Microsoft Word 80, 186
milli 187
Minimum Size 187
minus-or-plus 187
modulus 187
moving equations 187
mu 187
much greater than 187
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much less 187
Multiple Aligned Lines 67
multiple integrals 188
multiple selection 31, 53
Multiple Selections 188
multiplication 188

N

nabla 188
nano 188
nesting 65, 66
New Field 63, 188
New Line 63, 188
New menu command 189
node, tree 189
Non-Functions 189
Nonlinear 66
not 189
not equals 189
nu 189
null set 189
numbering equations 189

O

Object Linking and Embedding 73
OLE 73, 78
omega 189
omega palette button 189
omicron 189
Open File 190
Options 190
Origin Cell 190
Other Preferences 190
outline fonts 191
outline letters 191
overbar 191

overscripts 191
Overstrike 191

P

P palette button 191
page layout 78
Page Setup… menu command 191
PageMaker 191
paint programs 192
palette 36, 192
Palette Buttons 193
palette buttons

– 33
+ 33
B 32
D 32
I 33
P 33
T 32
W 32

palette window 29
Paragraphs 194
parallel 194
parentheses 195
partial derivative 195
Paste 43, 72, 195
perpendicular 195
phi 195
pi product 196
pico 196
Picture 197
Picture Rotation 198
pictures 78
pixel 198
Plain style 198
Planck’s constant 198
plus 198
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plus-or-minus 199
point 199
Pop-up palette 199
pop-up palette 47
position vector 200
PostScript 200
PostScript font 200
power 200
preferences 200
preferences directory 200
prefix 200
prescripts 200
prime mark 200
Print Expression… menu command

201
Printer Default 12
printer fonts 201
product 201
proportional to 201
Pseudocharacters 201
psi 201

Q

quad 201
Quantization 202
quick reference 202
Quit menu command 202
quotient 202

R

Raise 65, 202
real 202
reciprocal 202
rectangle 202
Return 204
right justification 205

right-justified 76
Roman alphabet 205
root 205
Root Adjustments 205
row 63
row vectors 206
rubber parentheses, etc. 206
Ruler 207
Ruler mode 39, 76, 208

S

sans serif font 208
Save As EPS… menu command 208
Save As Metafile… menu command

208
Save As… menu command 208
Save menu command 208
scalar variables 33
screen fonts 208
script 208
script ell 208
second partial derivative 209
Select All 71, 209
Select First 52, 209
Select In 50, 209
Select Next 52, 209
Select Out 49, 210
selecting 210
selection tools 49
serial number 11
serif font 211
set of 211
set theory symbols 211
sets 211
shadow frame 211
Shift key 211
Shift-click 212
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Shift-drag 53
shortcuts

double-clicking 31
escape 47
keystrokes 59
selecting words 31
selection tools 49

Shrink 34
shrink 212
Sideways Tree 66
size 212
Sizing buttons 33
slashed fraction 212
space 212
spacing 213
Special Symbols 40
square 213
square root 213
stretch 74
string 29, 38, 213
string selection 213
style 214
Style buttons 32
subexpression 214
subscript 37, 214
subscript/superscript composite 37,

215
Subscripts, Superscripts, & Summa-

tion adjustments 215
subset 216
subtraction 216
such that 217
sum 217
summation 217
superscript 37, 217
support 217
Symbol font 32, 40, 217

System Requirements 6

T

T palette button 32, 217
tab key 217
tab stop 76
tab stops 218
tabs 217
technical support 218
tensor composite 219
tera 219
TEX 219
text 219
there exists 219
therefore 219
theta 220
thin space 220
tilde 221
Times font 221
Times New Roman font 221
Top Justification 221
Translation Browser 221
Translation Table 221
transparent background 222
transpose 222
tree 65
tree node 222
Triple Integral 66
truncate 222
Tutorials

Guided Tour 28
tweak 222
typing 28, 130, 222

U

underbar 223
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Underline style 223
Underscripts/ Overscripts 224
Undo 28, 43, 224
union 224
units 224
Units menu command 224
Unmark 224
Untweak 224
upsilon 225

V

variable 225
vector mark 226
vector matrix 226
vector quantities 32
vertical fraction 226
Vertical Squeeze 226
Viewing Modes 38

W

wedge 226
word processing 226
word processor 71, 78
Word, Microsoft 226
WordPerfect 81
words 227
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